### Contents

**Send Us Your Comments**

**Preface**

1. **Introduction to the Oracle Application Management Pack for Oracle E-Business Suite**
   - Overview .................................................................................................................................. 1-1

2. **Installing and Upgrading the Oracle Application Management Pack for Oracle E-Business Suite**
   - Introduction ................................................................................................................................. 2-1
   - Supported Versions ...................................................................................................................... 2-2
   - Prerequisites ............................................................................................................................... 2-2
   - Downloading the Plug-in ............................................................................................................ 2-2
   - Deploying the Plug-in .................................................................................................................. 2-2
   - Installing a Management Agent ................................................................................................. 2-3
   - Discovering Targets .................................................................................................................... 2-3
   - Metrics Collected by the Plug-in ............................................................................................... 2-3
   - Upgrading the Plug-in .................................................................................................................. 2-3
   - Undeploying the Plug-in ............................................................................................................. 2-6

3. **Getting Started with the Oracle Application Management Pack for Oracle E-Business Suite**
   - Getting Started ......................................................................................................................... 3-1
   - Oracle E-Business Suite Management Page .............................................................................. 3-2
4 Discovering Oracle E-Business Suite with Cloud Control

Preparatory Steps for Discovery ................................................................. 4-1
Using the Discovery Wizard ............................................................... 4-2
Additional Features of Discovery ......................................................... 4-7
Command-Line Discovery for Oracle E-Business Suite Systems ............... 4-12
Rediscovering an Oracle E-Business Suite instance ............................. 4-17
Deleting an Oracle E-Business Suite Instance ..................................... 4-18

5 Setting Credentials

Overview of Credentials .................................................................. 5-1
    Preferred Credentials .................................................................. 5-1
    Named Credentials .................................................................... 5-2
Preferred Credentials for Oracle E-Business Suite Application Login ......... 5-2
Preferred Credentials for Oracle E-Business Suite Database Login .......... 5-4
Preferred Credentials for Oracle E-Business Suite Node ......................... 5-7
Preferred Credentials for Oracle WebLogic Server .............................. 5-11
Preferred Credentials for Host .......................................................... 5-13
Setting Credentials if the Oracle E-Business Suite instance features online patching ........................................................................ 5-13
Known Limitations ........................................................................ 5-13

6 Preferences

Setting Preferences ........................................................................ 6-1

7 Security

Privileges and Roles for Managing Oracle E-Business Suite ................. 7-1
Change Management Privileges ..................................................... 7-5
Specific Privileges for Features .......................................................... 7-6

8 Monitoring Oracle E-Business Suite

Navigation and Overview ............................................................... 8-2
Home Page of an Oracle E-Business Suite System ............................ 8-5
Configuration of Oracle E-Business Suite .......................................... 8-14
Incidents for an Oracle E-Business Suite Target ................................. 8-17
Compliance Standards for Oracle E-Business Suite ............................ 8-18
Monitoring Online Patching to Detect Cutover .................................. 8-20
Monitoring Current Activity ........................................................... 8-21
Monitoring User Sessions ............................................................... 8-22
Monitoring JVM Usage ................................................................... 8-25
9 Monitoring Settings

Settings to Monitor Oracle E-Business Suite................................................................................. 9-1

10 Diagnosing Issues

Diagnosing Issues using Pack Diagnostics.................................................................................. 10-1
Diagnostic Tests for Cloning........................................................................................................... 10-3
Diagnostic Tests for Patch Manager............................................................................................... 10-10
Diagnostic Tests for Customization Manager................................................................................ 10-12
Diagnostic Tests for User Monitoring............................................................................................ 10-15

11 Cloning an Oracle E-Business Suite System

Cloning an Oracle E-Business Suite System.................................................................................. 11-1
Running a Single Node to Single Node or Multi Node to Single Node Cloning Procedure for Release 11i and 12.1.x........................................................................................................... 11-9
Running Scale-Up and Scale-Down Multi-Node Cloning Procedures........................................... 11-21
Adding Custom Steps to a Smart Clone Deployment Procedure.................................................. 11-48

12 Introduction to Change Management

Introduction........................................................................................................................................... 12-1
Change Approval Framework and Change Management Privileges........................................... 12-2
Preferred Credentials for Change Management............................................................................. 12-3
Notifications Setup ......................................................................................................................... 12-3
13 Patch Manager
Introduction........................................................................................................... 13-1
Patch Manager Home.......................................................................................... 13-2
Creating a Patch Run (Release 12.1 and Earlier)............................................ 13-14
Copying a Patch Run for Release 12.1 and Earlier.......................................... 13-20
Creating Patch Deployment Procedures for Oracle E-Business Suite Release 12.2......................................................... 13-21
Extending Patch Manager Deployment.......................................................... 13-29
Logging, Health Checks, and Troubleshooting.................................................. 13-30

14 Customization Manager
Introduction........................................................................................................... 14-2
Major Features and Definitions.......................................................................... 14-3
Applications Standards Validation..................................................................... 14-4
Working with User-Defined Customization Standards.................................... 14-5
Adding a User-Defined Customization Standard............................................ 14-6
Oracle-Compliant Source Header....................................................................... 14-8
Uploading Existing Custom Patches.................................................................. 14-11
Automatic File Driver File Generation and Update......................................... 14-11
Customization Manager Main Page................................................................... 14-13
File Source Mapping.......................................................................................... 14-15
Example of a File Source Mapping with Parameters....................................... 14-19
E-Business Suite Mapping.................................................................................. 14-21
Creating a Package.............................................................................................. 14-23
Updating a Package............................................................................................ 14-31
Saving a Package................................................................................................. 14-33
Searching for a Package..................................................................................... 14-33
Viewing Package Details.................................................................................... 14-34
Package Reports.................................................................................................. 14-41
Creating a Report................................................................................................. 14-42
Viewing a Report................................................................................................. 14-45
Searching for a Report....................................................................................... 14-47
Releasing and Sharing a Package....................................................................... 14-47
Maintaining the File Metadata Repository....................................................... 14-48
Managing Custom Applications......................................................................... 14-50

A Target Types
Target Types.......................................................................................................... A-1
B Pre-validation for Discovery
   Prevalidation Checks for Discovery.............................................................................................. B-1

C Supported File Types in Customization Manager
   Supported File Types..................................................................................................................... C-1
   Recommended Locations for Common File Types........................................................................... C-12
   Execution Sequence of SQL File Types......................................................................................... C-14

D Customization Manager Coding Standards
   Customization Manager Coding Standards for Files................................................................. D-1
   Customization Manager Coding Standards for Database Objects.............................................. D-11

E Validation of Custom Applications: Examples
   Validation of Custom Applications: Examples............................................................................. E-1

F Known Product Limitations
   Known Product Limitations............................................................................................................ F-1

Index
Send Us Your Comments

Part No. E51704-01

Oracle welcomes customers' comments and suggestions on the quality and usefulness of this document. Your feedback is important, and helps us to best meet your needs as a user of our products. For example:

• Are the implementation steps correct and complete?
• Did you understand the context of the procedures?
• Did you find any errors in the information?
• Does the structure of the information help you with your tasks?
• Do you need different information or graphics? If so, where, and in what format?
• Are the examples correct? Do you need more examples?

If you find any errors or have any other suggestions for improvement, then please tell us your name, the name of the company who has licensed our products, the title and part number of the documentation and the chapter, section, and page number (if available).

Note: Before sending us your comments, you might like to check that you have the latest version of the document and if any concerns are already addressed. To do this, access the new Oracle E-Business Suite Release Online Documentation CD available on My Oracle Support and www.oracle.com. It contains the most current Documentation Library plus all documents revised or released recently.

Send your comments to us using the electronic mail address: appsdoc_us@oracle.com

Please give your name, address, electronic mail address, and telephone number (optional).

If you need assistance with Oracle software, then please contact your support representative or Oracle Support Services.

If you require training or instruction in using Oracle software, then please contact your Oracle local office and inquire about our Oracle University offerings. A list of Oracle offices is available on our Web site at www.oracle.com.
Preface

Intended Audience


This book is intended for database administrators and system administrators who are responsible for performing the tasks associated with maintaining an Oracle E-Business Suite system using the Oracle Application Management Pack for Oracle E-Business Suite.

See Related Information Sources on page xii for more Oracle E-Business Suite product information.

Documentation Accessibility

For information about Oracle’s commitment to accessibility, visit the Oracle Accessibility Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers have access to electronic support through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.

Structure

1 Introduction to the Oracle Application Management Pack for Oracle E-Business Suite
2 Installing and Upgrading the Oracle Application Management Pack for Oracle E-Business Suite
3 Getting Started with the Oracle Application Management Pack for Oracle E-Business Suite
4 Discovering Oracle E-Business Suite with Cloud Control
Related Information Sources

Oracle E-Business Suite System Administrator's Guide Documentation Set


Oracle Enterprise Manager Cloud Control Introduction

This manual introduces Oracle Enterprise Manager. It provides a brief overview of the system architecture and describes the key features of the product. The manual also details new features in this release.

Oracle Enterprise Manager Cloud Control Basic Installation Guide

This guide enables you to begin the installation of a new Enterprise Manager system.

Oracle Enterprise Manager Cloud Control Advanced Installation and Configuration Guide

Oracle Enterprise Manager Cloud Control Advanced Installation and Configuration Guide is an extension to Oracle Enterprise Manager Cloud Control Basic Installation Guide. While the Oracle Enterprise Manager Cloud Control Basic Installation Guide covers basic installation
procedures that help you get started with Enterprise Manager Cloud Control, the *Oracle Enterprise Manager Cloud Control Advanced Installation and Configuration Guide* covers advanced installation procedures that help you install and configure the Enterprise Manager Cloud Control components in more complex environments.

**Oracle Enterprise Manager Cloud Control Upgrade Guide**

This guide describes how you can upgrade an existing Enterprise Manager 10g Grid Control Release 5 (10.2.0.5.0) or Enterprise Manager 11g Grid Control Release 1 (11.1.0.1.0) to Enterprise Manager Cloud Control.

**Oracle Enterprise Manager Cloud Control Administrator’s Guide**

This guide describes how to set up a Private Cloud, manage and deploy virtualization targets with Oracle Enterprise Manager 12c.

**Oracle Enterprise Manager Cloud Administration Guide**

This guide describes how to set up a Private Cloud, manage and deploy virtualization targets with Oracle Enterprise Manager 12c.

**Oracle Enterprise Manager Lifecycle Management Administrator’s Guide**

The Lifecycle Management Guide introduces you to the lifecycle management solutions offered by Oracle Enterprise Manager Cloud Control (Cloud Control), and describes in detail how you can use the discovery, provisioning, patching, and configuration and compliance management features to manage your data center.

---

**Do Not Use Database Tools to Modify Oracle E-Business Suite Data**

Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data Browser, database triggers, or any other tool to modify Oracle E-Business Suite data unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and maintain information in an Oracle database. But if you use Oracle tools such as SQL*Plus to modify Oracle E-Business Suite data, you risk destroying the integrity of your data and you lose the ability to audit changes to your data.

Because Oracle E-Business Suite tables are interrelated, any change you make using an Oracle E-Business Suite form can update many tables at once. But when you modify Oracle E-Business Suite data using anything other than Oracle E-Business Suite, you may change a row in one table without making corresponding changes in related tables. If your tables get out of synchronization with each other, you risk retrieving erroneous information and you risk unpredictable results throughout Oracle E-Business Suite.

When you use Oracle E-Business Suite to modify your data, Oracle E-Business Suite automatically checks that your changes are valid. Oracle E-Business Suite also keeps track of who changes information. If you enter information into database tables using database tools, you may store invalid information. You also lose the ability to track who has changed your information because SQL*Plus and other database tools do not keep a record of changes.
Introduction to the Oracle Application Management Pack for Oracle E-Business Suite

This chapter covers the following topics:

- Overview

Overview

The Oracle Application Management Pack for Oracle E-Business Suite extends Oracle Enterprise Manager 12c Cloud Control to help monitor and manage Oracle E-Business Suite systems more effectively. The pack integrates Oracle Applications Manager with Cloud Control to provide a consolidated, end-to-end Oracle E-Business Suite management solution. The pack can be used to manage both Oracle E-Business Suite Release 11i systems and Release 12 systems.

This document describes the features and usage of this new pack for Cloud Control.

Oracle Enterprise Manager Cloud Control provides a complete view of your enterprise so that you can manage all of your Oracle E-Business Suite systems from a single console. This pack provides new pages within Cloud Control that help you to monitor the performance, availability and configuration changes of your Oracle E-Business Suite system and also help you to provision your Oracle E-Business Suite applications. You can take advantage of advanced Cloud Control features such as the provisioning framework.
The Oracle Application Management Pack for Oracle E-Business Suite provides advanced features to monitor and manage Oracle E-Business Suite Release 12 systems (Releases 12.0.x, 12.1.x, and 12.2.x) as well as Release 11i systems that meet a standard interoperability patch level. These advanced features include Oracle E-Business Suite provisioning, Application Service Level Management, extended performance metrics, and links from Cloud Control to Oracle Applications Manager.


Information about the Oracle Application Management Pack for Oracle E-Business Suite Deployment

To find out information about the deployment of Oracle Application Management Pack for Oracle E-Business Suite on your system, navigate to Setup menu > Extensibility > Plug-ins. Under the Applications section, click on the Oracle E-Business Suite plug-in.
Installing and Upgrading the Oracle Application Management Pack for Oracle E-Business Suite

This chapter covers the following topics:

• Introduction
• Supported Versions
• Prerequisites
• Downloading the Plug-in
• Deploying the Plug-in
• Installing a Management Agent
• Discovering Targets
• Metrics Collected by the Plug-in
• Upgrading the Plug-in
• Undeploying the Plug-in

Introduction

The Oracle Application Management Pack for Oracle E-Business Suite extends Oracle Enterprise Manager 12c Cloud Control to help monitor and manage Oracle E-Business Suite systems more effectively. This plug-in integrates Oracle Applications Manager with Cloud Control to provide a consolidated, end-to-end Oracle E-Business Suite management solution. The plug-in can be used to manage both Oracle E-Business Suite Release 11i systems and Release 12 systems.
Supported Versions

For a list of supported versions, see the document "Getting Started with Oracle Application Management Pack for Oracle E-Business Suite, Release 12.1.0.3.0", My Oracle Support Knowledge Document 1623105.1.

Prerequisites

For a list of prerequisites, see the document "Getting Started with Oracle Application Management Pack for Oracle E-Business Suite, Release 12.1.0.3.0", My Oracle Support Knowledge Document 1623105.1.

Additional Instructions

Ensure that the following system requirement has been met:

- OS/User Group Requirement: It is recommended that the Oracle E-Business Suite OS user and the Enterprise Manager Agent OS user is the same. If they are different, then they must belong to the same OS group.

Downloading the Plug-in

You can download plug-ins in online or offline mode. Online mode refers to an environment where you have Internet connectivity, and can download the plug-in directly through Enterprise Manager from My Oracle Support. Offline mode refers to an environment where you do not have Internet connectivity, or where the plug-in is not available from My Oracle Support.

See the Managing Plug-ins chapter in the Oracle Enterprise Manager Cloud Control Administrator’s Guide for details on downloading the plug-in in either mode:

http://docs.oracle.com/cd/E24628_01/doc.121/e24473/plugin_mngr.htm#CJGBEAHJ

The following details of the Oracle E-Business Suite plug-in can be used for searching in the Self Update feature of the Enterprise Manager console:

Plug-in Name: Oracle E-Business Suite
Description: Enterprise Manager for Oracle E-Business Suite consists of System Management and Change Management Feature Sets
Version: 12.1.0.3.0

Deploying the Plug-in

You can deploy the plug-in to an Oracle Management Service instance using the Enterprise Manager Cloud Control console, or using the EM Command Line Interface (EMCLI). While the console enables you to deploy one plug-in at a time, the command
line interface mode enables you to deploy multiple plug-ins at a time, thus saving plug-in deployment time and downtime, if applicable.

See the Managing Plug-ins chapter in the Oracle Enterprise Manager Cloud Control Administrator’s Guide for instructions on deploying the plug-in:

http://docs.oracle.com/cd/E24628_01/doc.121/e24473/plugin_mngr.htm#CJGCDHFG

**Installing a Management Agent**

A Management Agent must be present on all hosts containing targets that will be monitored/managed by the plug-in.

This step is required only if a Management Agent is not already present on a host containing targets to be managed.

See the Installing Oracle Management Agents chapter in the Oracle Enterprise Manager Cloud Control Basic Installation Guide for instructions on deploying a Management Agent to a host machine:

http://docs.oracle.com/cd/E24628_01/install.121/e22624/install_agent.htm

**Discovering Targets**

After the plug-in is deployed, targets that will be managed/monitored by the plug-in must be “discovered” by Enterprise Manager.

For information on discovery, see the chapter Discovering Oracle E-Business Suite with Cloud Control, page 4-1.

**Metrics Collected by the Plug-in**


**Upgrading the Plug-in**

The Self Update feature allows you to expand Enterprise Manager’s capabilities by updating Enterprise Manager components whenever new or updated features become available. Updated plug-ins are made available via the Enterprise Manager Store, an external site that is periodically checked by Enterprise Manager Cloud Control to obtain information about updates ready for download. See the Updating Cloud Control chapter in the Oracle Enterprise Manager Cloud Control Administrator’s Guide for steps to update the plug-in:

http://docs.oracle.com/cd/E24628_01/doc.121/e24473/self_update.htm

Note that if you had installed the plug-in on an agent without a discovered Oracle E-Business Suite target, the plug-in will not be upgraded on that agent. For example,
say in Release 3.1 you had installed the plug-in on an agent exclusively for performing check-in and check-out from source control for Customization Manager. There is no Oracle E-Business Suite target that is being monitored by this agent. During an upgrade to Release 12.1.0.3.0, this agent will not be upgraded to this latest release. You will have to upgrade this agent manually from the Oracle Management Service user interface.

**Important:** If you are upgrading your Oracle Enterprise Manager installation from Release 11g to 12c Release 4 (PS 3), and have Oracle E-Business Suite Release 12.1.3 targets, you must run the following script for successful discovery of these targets:

```sql
$PLUGIN_HOME/sql/ebs/12.1.0.3.0/amp/disc/ebs_svc_test_enable.sql
commit;
```

Note that this script does not perform the commit. You must do it explicitly.

The above script is available in the plug-in home on the OMS.

---

**Considerations for Cloning and Upgrades**

Only Smart Clone procedures are supported in this release. As a prerequisite to running a Smart Clone procedure, the target Oracle E-Business Suite database must be cloned and discovered in the Enterprise Manager.

Clone transaction data created in previous releases will not be usable in this release. After you upgrade from an earlier release, the old cloning transactions will not be available.

**Considerations for Patch Manager and Upgrades**

Before upgrading from a prior release, you should ensure that all patching runs have completed or are in a state in which they are no longer being used. After the upgrade to Release 12.1.0.3.0, these old patch runs will no longer be visible in Patch Manager. For example, say you have a patch run in a "Pending Approval" or "Approved" state in Release 4.0. After you upgrade, you will not be able to use this patch run.

**Considerations for Upgrading from Release 3.1 or 4.0**

Note the following considerations and limitations for upgrades.

**Deleting an Instance**

If you are deleting an Oracle E-Business Suite instance after an upgrade, Oracle recommends you delete the retired targets associated with the instance. Delete these retired targets manually from the All Targets page before running discovery again later. The target types are:
• Oracle E-Business Suite System

• Oracle Applications Infrastructure Service

**Note:** You must delete these manually in the current release. In a future release this deletion will be handled automatically.

Oracle also recommends that you delete the report associated with Oracle Applications Infrastructure Service. To do this, perform the following steps:

1. From the Enterprise menu, select Reports/Information Publisher Reports.

2. Search using the search term Target Type "Oracle Applications Infrastructure Service".

3. From under Oracle Applications Dashboards/Oracle Applications Service Dashboards, select <Oracle E-Business Suite instance name>-Oracle Applications Infrastructure Service Dashboard and click the **Delete** button.

**Properties in amp.properties file replaced by Preferences**

The amp.properties file is obsolete with this release of the Oracle Application Management Pack for Oracle E-Business Suite.

The following properties are obsolete:

- `ebs_acp_packAccessEnabled`
- `enableRoleBasedSecurity`
- `enableApproval_CM`
- `enableApproval_AZ`
- `enableApproval_PM`
- `targetLevelPrivilegeForApproval`

The following properties must be set manually in the Preferences page after the upgrade:

- `stageDir` (Stage Directory) - This property/preference is used by Customization Manager and specifies the OMS stage directory for package creation.

- `ampCloneApplTopParallelThreads` (Number of threads to be used while zipping, transferring, and unzipping the files under APPL_TOP of Apps Tier)

- `ampCloneToolsParallelThreads` (Number of threads to be used while zipping,
transferring, and unzipping the files under Tools home of Apps Tier)

- ampCloneWebParallelThreads (Number of threads to be used while zipping, transferring, and unzipping the files under Web home of Apps Tier)

- ampCloneCommonTopParallelThreads (Number of threads to be used while zipping, transferring, and unzipping the files under COMMON_TOP of Apps Tier)

- um_dashboard_no_of_rows (Number of Rows in tables of User Monitoring)

- um_session_sampling_interval (Sampling Interval for User Monitoring)

- omsPatchStageDir (OMS Patch Stage Directory Location)

- MOSEnabled/metalinkEnabled (Connect to My Oracle Support for Patches)

Security using Enterprise Manager Privileges and Roles
Oracle Application Management Pack for Oracle E-Business Suite now uses the native Enterprise Manager privileges and roles. As noted above, the amp.properties file is obsolete, so its security-related properties are no longer used. See Privileges and Roles for Managing Oracle E-Business Suite, page 7-1 for more information on managing security.

Undeploying the Plug-in
See the Managing Plug-ins chapter in the Oracle Enterprise Manager Cloud Control Administrator’s Guide for steps to undeploy the plug-in:

http://docs.oracle.com/cd/E24628_01/doc.121/e24473/plugin_mngr.htm#CJGEF
ADI
Getting Started with the Oracle Application Management Pack for Oracle E-Business Suite

This chapter covers the following topics:

• Getting Started
• Oracle E-Business Suite Management Page

Getting Started

Once the management pack, or plug-in, has successful deployed on the OMS, you can go to the landing page (called the Oracle E-Business Suite Management page henceforth) of the plug-in by selecting Oracle E-Business Suite from the Targets menu.
Oracle E-Business Suite Management Page

The Oracle E-Business Suite Management page gives you a bird’s eye view of all the Oracle E-Business Suite instances that are being monitored. This view includes status, incidents, compliance, and so on. The page has the following sections:

Status of Oracle E-Business Suite Targets

This section shows the status summary of Oracle E-Business Suite targets being monitored. The pie charts show how many are up, down, or in unknown status.

Incidents and Problems

This section has the summary of incidents reported from all the Oracle E-Business Suite targets being monitored. The incidents are grouped based on category and severity.

Oracle E-Business Suite Instances

This section lists the Oracle E-Business Suite instances that are already discovered. The status column tells you if the instance is up or down. You can perform the following actions:

- Go to the home page of an Oracle E-Business Suite instance by clicking on the name of the instance.
• Discover a new Oracle E-Business Suite instance by clicking Add.

• Delete an Oracle E-Business Suite instance which is already discovered by clicking Delete.

• Configure how an Oracle E-Business Suite instance is being monitored by clicking Configure.

   **Tip:** Use the Detach button to view the table in a separate page. This feature is useful if your table has more rows than can be shown in the default display.

---

**Compliance Summary**

This section lists the compliance standards that are shipped by the Oracle E-Business Suite plug-in along with the evaluations performed and violations reported. The Average Compliance score is an indication on how much compliant all the Oracle E-Business Suite instances are to each specific standard.

Oracle Enterprise Manager Compliance Management provides the ability to evaluate the compliance of targets and systems as they relate to business best practices for configuration, security, and storage. This is accomplished by defining, customizing, and managing compliance frameworks, compliance standards, and compliance standard rules. In addition, Compliance Management provides advice of how to change configuration to bring your targets and systems into compliance. Oracle Application Management Pack for Oracle E-Business Suite includes the Oracle E-Business Suite Framework for use with Compliance Management. For more information on Compliance Management, refer to the *Oracle Enterprise Manager Lifecycle Management Administrator’s Guide*.

---

**Least Compliant Targets**

This section lists the Oracle E-Business Suite targets that are least compliant across all standards. The default Target Type shown is Host. The Average Compliance score is an indicator of how compliant the specific Oracle E-Business Suite instances are to standards.

---

**Navigating from the Oracle E-Business Suite Management Page**

You can navigate to the following pages from the Oracle E-Business Suite Management page through the Administer menu.

• Change Management

• Preferences
• Discovery Wizard
• Pack Diagnostics
• Cloning
Discovering Oracle E-Business Suite with Cloud Control

This chapter covers the following topics:

- Preparatory Steps for Discovery
- Using the Discovery Wizard
- Additional Features of Discovery
- Command-Line Discovery for Oracle E-Business Suite Systems
- Rediscovering an Oracle E-Business Suite instance
- Deleting an Oracle E-Business Suite Instance

Preparatory Steps for Discovery

Privileges needed to do discovery

To discover an Oracle E-Business Suite instance, a user must have the Add any Target target type privilege.

Prerequisites to do discovery

- The Oracle E-Business Suite database must be discovered in Enterprise Manager Cloud Control.
- The hosts on which the Oracle E-Business Suite is deployed must be discovered in Enterprise Manager Cloud Control.
- AutoConfig must be enabled and updated on all nodes in order for Oracle E-Business Suite systems to be properly recognized by Oracle Application Management Pack for Oracle E-Business Suite. Refer to the applicable
documentation:

- My Oracle Support Knowledge Document 165195.1, "Using AutoConfig to Manage System Configurations with Oracle Applications 11i"


**Note:** For an AutoConfig-enabled Release 11i instance, running AutoConfig on the database tier adds the following lines to sqlnet.ora automatically:

```
tcp.validnode_checking = yes
tcp.invited_nodes=(11i_HOST)
```

In this case, database discovery or application discovery through Oracle Enterprise Manager will fail because the Oracle E-Business Suite instance database tier listener will reject any connection requests other than from itself. To prevent this failure, add the Oracle Enterprise Manager Cloud Control server to sqlnet_ifile.ora as listed below and bounce the database listener before discovery via Oracle Enterprise Manager.

```
tcp.invited_nodes=(11i_HOST, EMGC_HOST)
```

### Using the Discovery Wizard

Adding an Oracle E-Business Suite database:
The database should be discovered before you add the database using the Discovery Wizard. Refer to the Oracle Enterprise Manager Cloud Control Administrator’s Guide for information on discovering the Oracle E-Business Suite database.

1. From the Administer menu, navigate to the Discovery Wizard.

2. Click on the Add Databases button.

4. Once added, the database target shows up in the Discovery Wizard. You can now proceed to discover the Oracle E-Business Suite instance.

**Prevalidating Discovery:**

Prevalidation allows you to analyze the Oracle E-Business Suite instance and Enterprise Manager Cloud Control to ensure successful discovery. Validation checks include verifying the following:

- Context files
- Context variables
- Agent installation
- OS user privileges

For more information on these checks, see: Prevalidation Checks for Discovery, page B-1.

1. To prevalidate discovery, go to the Discovery Wizard.
2. Select the Oracle E-Business Suite database target and click on **Prevalidate**.

![Oracle E-Business Suite Management](image)

3. Enter the monitoring schema credentials for the database.

4. Click **Prevalidate Discovery**.

   **Note:** The Normal Host preferred credential needs to be set prior to this step. See the Credentials chapter for more information.

5. A job will be submitted to prevalidate the discovery.

   The Diagnostics Status column in the Discovery Wizard shows the status of prevalidation as a link. You can drill down to get the details. A detailed report will be generated that can be used to resolve any issues. Only one Oracle E-Business Suite instance can be prevalidated at a time.

**Discovering Oracle E-Business Suite Release 11i, 12.0, or 12.1:**

1. Navigate to the Discovery Wizard.

2. Select the Oracle E-Business Suite database target and click on **Discover**.

3. Enter the monitoring schema credentials for the database.
4. Click **Start Discovery**.

5. A job will be submitted to do the discovery. The Diagnostics Status column in the Discovery Wizard will show the status of discovery as a link. You can drill down to get the details.

**Discovering Oracle E-Business Suite Release 12.2:**
1. Set the Normal Host preferred credential where the WebLogic Administration Server is running. Refer to the Credentials chapter for more information on setting this credential.

2. Navigate to the Discovery Wizard.

3. Select the Oracle E-Business Suite database target and click on **Discover**.

4. Enter the monitoring schema credentials for the database.

5. Enter the username and password for the WebLogic Administration Server.

6. Click **Start Discovery**.

7. A job will be submitted to do the discovery. The Diagnostics Status column in the Discovery Wizard will show the status of discovery as a link. You can drill down to get the details.
Note: Both run and patch edition targets will be discovered but only run edition targets will be shown in the UI. Patch edition targets will be blacked out immediately after discovery to prevent false incidents from being raised.

Additional Features of Discovery

Discovering multiple Oracle E-Business Suite targets

The Discovery Wizard allows you to discovery multiple Oracle E-Business Suite targets. Select all the needed Oracle E-Business Suite database instances and click on Discover. You must enter the Monitoring Schema username and password for all of them in the next page. For Release 12.2 targets, you must also enter the WebLogic Admin username and password.

Discovering Oracle E-Business Suite as EM_MONITOR user (Recommended)

Oracle E-Business Suite can be discovered and monitored using an EM_MONITOR user which has read-only access to Oracle E-Business Suite tables required for monitoring. By default the EM_MONITOR user is locked so a user would have to unlock it explicitly to use it.

Connect to the database through SQL*Plus as the SYSTEM user and issue the command:
alter user em_monitor account unlock;

Connect to the database through SQL*Plus as the em_monitor user and change the password:
splus em_monitor/lizard;

Discovering Oracle E-Business Suite by assigning EM_OAM_MONITOR_ROLE to database user (such as DBSNMP)

Oracle E-Business Suite can be discovered and monitored using any database user, provided the user has been granted the EM_OAM_MONITOR_ROLE. This role is been provided with read-only access to Oracle E-Business Suite tables required for monitoring.

Troubleshooting discovery

If anything goes wrong with the discovery, you must check the discovery log to troubleshoot. It is available at:
$<MIDDLEWARE_HOME>/oms/sysman/log/ebsDiscovery_<DBSID>_oracle_database.log
Restrictions for discovery

- If you are using Oracle's E-Business Suite Online Patching feature and you have an active patching cycle in progress, you must wait until it completes before attempting to discover an Oracle E-Business Suite instance.

- You cannot discover two Oracle E-Business Suite instances with the same name.

Customizing discovery

It is possible to customize the discovery. You can exclude the discovery of certain targets and services. To customize the discovery of an Oracle E-Business Suite instance, click on the link available in the Configure column in the Discovery Wizard. You will be prompted to enter the monitoring schema credentials for the database.

Customization at the instance level

The following table explains the different options available for you.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Applicable Oracle E-Business Suite Releases</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Group Name</td>
<td>All targets discovered for this instance will be grouped under this group. This group will be added to Group: Customer Group Name.</td>
<td>All Releases</td>
</tr>
<tr>
<td>Customer Instance Group Name</td>
<td>If the Customer Instance Group Name is provided, then all the targets discovered for this instance and the Customer Instance Group Name will be added to this group.</td>
<td>All Releases</td>
</tr>
<tr>
<td>Discover Discoverer</td>
<td>Disable/Enable discovery of the Discoverer component.</td>
<td>Release 11i only</td>
</tr>
<tr>
<td>Discover Workflow Service</td>
<td>Disable/Enable discovery of the Oracle Workflow components.</td>
<td>All Releases</td>
</tr>
<tr>
<td>Discover Workflow Service</td>
<td>Disable/Enable creation of the Oracle Workflow service. If you do not discover workflow targets, then the workflow service will not be discovered.</td>
<td>Release 12 and Above</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
<td>Applicable Oracle E-Business Suite Releases</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------------------------------------</td>
</tr>
<tr>
<td>Discover Forms Service</td>
<td>Disable/Enable creation of the Oracle Forms service.</td>
<td>Release 12 and above</td>
</tr>
<tr>
<td>Discover SSA Service</td>
<td>Disable/Enable creation of the Self-Service Applications (SSA) Service.</td>
<td>Release 12 and above</td>
</tr>
<tr>
<td>Discover Patching Information</td>
<td>Disable/Enable discovery of the Patching Information Object. This target is essential for any Oracle E-Business Suite patching application and should be enabled if any patching applications are used with this instance.</td>
<td>Release 12 and above</td>
</tr>
<tr>
<td>Discover Custom Objects</td>
<td>Disable/Enable discovery of custom objects configuration.</td>
<td>Release 12 and above</td>
</tr>
<tr>
<td>Delete Removed Targets</td>
<td>Whether to delete an Oracle E-Business Suite member target from OMS which was originally discovered and later detached from the Oracle E-Business Suite target hierarchy with a rediscovery.</td>
<td>All Releases</td>
</tr>
</tbody>
</table>

For example, say you have discovered an Oracle E-Business Suite instance with five nodes. Later you customize the discovery and exclude two nodes. When you perform rediscovery, the two excluded nodes become orphan nodes. If this option is set to Yes, then the orphan targets will be deleted during rediscovery.
Excluding nodes from getting discovered

The Configure Discovery page lists all the nodes. You can exclude a node from being discovered. Uncheck the check box corresponding to the node in the Enable column. At least one applications node must be selected for successful discovery. Discovery can happen even if you do not select any database node.

For Oracle E-Business Suite Release 12.2, you cannot exclude a node if the WebLogic Administration Server is running on that node.

Customization at the node level

You can also configure the targets that get discovered in each node. Click on the Configure column corresponding to each node.
Customization at apps node level

You can exclude Forms and the Apps JVM from being discovered in Release 12.

Mapping an Aliased Host

A host which is uniquely identified by an IP Address can have different alias names in the network. It is possible that the Oracle E-Business Suite context file has one host name while it has been discovered in Cloud Control with a different alias name. In such a situation, you must map the host name available in the context file to the corresponding host name with which it has been discovered. This can be done by configuring the discovery for each node. The section Map Aliased Host serves this purpose. Select the radio button Select overriding hostname. A list of values is shown from which you can select the appropriate host which can be mapped to the host in which this node is running. This feature is restricted to discovery and monitoring only.
Resetting the customization

From the Configure Discovery page you can reset your customization to default or you can reset it to the last configuration with which discovery was done successfully.

Command-Line Discovery for Oracle E-Business Suite Systems

The Oracle Application Management Pack for Oracle E-Business Suite provides a command-line interface for the batch discovery of multiple Oracle E-Business Suite systems. Command-line discovery is executed using the script ebsdiscovery.sh which is located under $PLUGIN_HOME/scripts/cli.

Prerequisites

The operating system user who runs command-line discovery must have the full permissions on the OMS ORACLE_HOME. Before running command-line discovery, set the following environment variables:

- **ORACLE_HOME**: This environment variable must be set to OMS Home.

- **JAVA_HOME**: This environment variable must be set to a valid JDK directory. The OMS ORACLE_HOME ships with one under $ORACLE_HOME/jdk. Once the OMS ORACLE_HOME is set, JAVA_HOME may be set simply by reference to the ORACLE_HOME variable:

  ```bash
  export JAVA_HOME=$ORACLE_HOME/jdk
  ```

- **PLUGIN_HOME**: This environment variable must point to the folder returned by the query "select plugin_home from GC$CURRENT_DEPLOYED_PLUGIN where plugin_id='oracle.apps.ebs' and destination_type='OMS'".

Before running discovery for multiple instances, it is highly recommended that you first try discovering a single Oracle E-Business Suite system.
Discovery

The ebsdiscovery.sh script can be run with the following parameters:

- **inputfile=<ebslist>**
  
  This option, when passed to the ebsdiscovery.sh script, will allow for the use of an input file which may contain details for the discovery of several Release 11i or Release 12 Oracle E-Business Suite systems (Oracle Applications environments). See: The ebsList.txt file, page 4-13 for more information.

  How this option works: Information will be taken from the file specified as `<ebslist>` and submitted as separate Enterprise Manager jobs for discovering each Oracle E-Business Suite system described in the file. If this “inputfile” option is not provided, then the default value is ebsList.txt. Please see ebsList.txt under $OMS_HOME/sysman/admin/scripts/ebs/cli/amp/disc/ for a sample input file.

  **Important:** If you are running the ebsdiscovery.sh script against a multi-node OMS installation, you must ensure that the input file is accessible from all OMS hosts.

- **omscred=<oms credentials file>**
  
  OMS Credentials will be taken from this file. This file is machine-generated and should not be edited. If this file does not exist, the ebsdiscovery.sh script will create it after prompting for the necessary input values. If this “omscred” option is not provided, then the default value is omscred.conf.

- **logdir=<log directory>**
  
  This option determines the location where the log files will be written.

An example of running the command is:

```
./ebsdiscovery.sh inputfile=ebsList.txt omscred=omscred.conf logdir=/tmp
```

After the discovery job is started, you can view its status on the Oracle Management Server. From the Oracle Enterprise Manager console, navigate to Enterprise (menu) > Job > Activity. The status of the job is shown in the Status field. Click on the job name link to drill down to details on the discovered Oracle E-Business Suite instance.

**The ebsList.txt file**

The ebsList.txt file contains parameters and values for the discovery process.
The ebsList.txt file

The format for the ebsList.txt file is:

```
DBTARGET=>[
  DISCOVER_FORMS=> Y;
  DISCOVER/forms/service=> Y;
  DISCOVER_WORKFLOW=> Y;
  DISCOVER/workflow/service=> Y;
  DISCOVER_SEA=> Y;
  DISCOVER_MWA=> N;
  DISCOVER_JFF=> N;
  DISCOVER_CUSTOM_OBJECTS=> Y;
  DISCOVER_PATCHING=> Y;
  ADD_CUSTOMER_GROUP=> Y;
  CUSTOMER_LIST_GRP_NAME=> IDC;
  CUSTOMER_GRP_NAME=> IDC12VIS04;
  APPS_USER=> apps;
  APPS_PASSWD=> apps;
  APPS_MONITORING_USER=> apps;
  APPS_MONITORING_PASSWORD=> apps;
]
```

Extra parameters can be provided as <key>=<value> pairs delimited by a semi-colon (;).

For ENCRYPTED_PASSWORD=<encrypted apps password>, the encrypted password will be used to decrypt the password on successive usage of the ebsList.txt file. To override the old password, change the input and add APPS_PASSWORD key value pair again with the new, changed password.

**ebsList.txt Parameters**

The following table describes the ebsList.txt parameters and their valid values.
<table>
<thead>
<tr>
<th>Key</th>
<th>Supported Release</th>
<th>Valid Values</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB_TARGET</td>
<td>All</td>
<td>DB Target Name</td>
<td>Database Target name of the Apps you want to discover</td>
<td>N/A</td>
</tr>
<tr>
<td>DB_TYPE</td>
<td>All</td>
<td>oracle_database or rac_database</td>
<td>Database type</td>
<td>oracle_database</td>
</tr>
<tr>
<td>APPS_USER</td>
<td>All</td>
<td>Apps username</td>
<td>This will be replaced by ENCRYPTED_APPS_PASSWD</td>
<td>apps</td>
</tr>
<tr>
<td>APPS_PASSWD</td>
<td>All</td>
<td>Apps password</td>
<td>This will be replaced by ENCRYPTED_APPS_MONITORING_PASSWD</td>
<td>apps</td>
</tr>
<tr>
<td>APPS_MONITORING_USER</td>
<td>12.0 or higher</td>
<td>Apps Monitoring username</td>
<td>This is used for out-of-box service monitoring</td>
<td></td>
</tr>
<tr>
<td>APPS_MONITORING_PASSWD</td>
<td>12.0 or higher</td>
<td>Apps Monitoring password</td>
<td>This will be replaced by ENCRYPTED_APPS_MONITORING_PASSWD</td>
<td></td>
</tr>
<tr>
<td>DISCOVER_WORKFLOW</td>
<td>All</td>
<td>Y or N</td>
<td>Whether to Discover Workflow targets</td>
<td>Y</td>
</tr>
<tr>
<td>DISCOVER_WORKFLOW_SERVICE</td>
<td>12.0 or higher</td>
<td>Y or N</td>
<td>Whether to Discover Workflow Service if DISCOVER_WORKFLOW is Y</td>
<td>Y</td>
</tr>
<tr>
<td>DISCOVER_FORMS</td>
<td>12.0 or higher</td>
<td>Y or N</td>
<td>Whether to Discover Forms or not</td>
<td>Y</td>
</tr>
<tr>
<td>Key</td>
<td>Supported Release</td>
<td>Valid Values</td>
<td>Description</td>
<td>Default</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------</td>
<td>--------------</td>
<td>------------------------------------------------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>DISCOVER_FOR_MS_SERVICE</td>
<td>12.0 or higher</td>
<td>Y or N</td>
<td>Whether to Discover Forms Service if DISCOVER_FOR M is Y</td>
<td>Y</td>
</tr>
<tr>
<td>DISCOVER_SSA</td>
<td>12.0 or higher</td>
<td>Y or N</td>
<td>Whether to discover SSA Service or not</td>
<td>Y</td>
</tr>
<tr>
<td>DISCOVER_CUSTOM_OBJECTS</td>
<td>12.0 or higher</td>
<td>Y or N</td>
<td>Whether to Discover Custom Objects or not</td>
<td>Y</td>
</tr>
<tr>
<td>DISCOVER_PATCHING</td>
<td>12.0 or higher</td>
<td>Y or N</td>
<td>Whether to discover Patching Configuration target</td>
<td>Y</td>
</tr>
<tr>
<td>PROTOCOL</td>
<td>11i</td>
<td>http or https</td>
<td>Whether to have http or https</td>
<td>http</td>
</tr>
<tr>
<td>SRVLT_URL_FROM_CTXFILE</td>
<td>11i</td>
<td>Y or N</td>
<td>Whether to take Servlet URL from Context file or Not. If this value is N, Value for Servlet url will be “/servlet/oracle.forms.servlet.ListenerServlet”</td>
<td>Y</td>
</tr>
<tr>
<td>ADD_CUSTOMER_GROUP</td>
<td>12.0 or higher</td>
<td>Y or N</td>
<td>Shall Add Customer Group</td>
<td>N</td>
</tr>
<tr>
<td>CUSTOMER_INSTANCE_GRP_NAME</td>
<td>12.0 or higher</td>
<td>Text</td>
<td>Customer Instance Group Name</td>
<td>N/A</td>
</tr>
<tr>
<td>CUSTOMER_GROUP_NAME</td>
<td>12.0 or higher</td>
<td>Text</td>
<td>Customer Group Name</td>
<td>N/A</td>
</tr>
<tr>
<td>Key</td>
<td>Supported Release</td>
<td>Valid Values</td>
<td>Description</td>
<td>Default</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------------</td>
<td>--------------</td>
<td>-------------</td>
<td>---------</td>
</tr>
<tr>
<td>DELETE_REMOVED_TARGETS</td>
<td>All</td>
<td>Y or N</td>
<td>Whether or not to delete removed targets. Default is N</td>
<td>N</td>
</tr>
<tr>
<td>DISCOVER_DISCOVERER</td>
<td>11i</td>
<td>Y or N</td>
<td>Whether or not to discover discoverer</td>
<td>Y</td>
</tr>
<tr>
<td>FORMS_SRVLT_PROTOCOL</td>
<td>11i</td>
<td>http or https</td>
<td>Whether to have http or https for forms servlet mode</td>
<td>http</td>
</tr>
<tr>
<td>DISCOVER_JVM_USAGE</td>
<td>12.0 or higher</td>
<td>Y or N</td>
<td>Whether or not to discover JVM usage target</td>
<td>A</td>
</tr>
<tr>
<td>WLSADMIN_USER</td>
<td>12.2 or higher</td>
<td>Username of the WLS admin</td>
<td>N/A</td>
<td></td>
</tr>
<tr>
<td>WLSADMIN_PWD</td>
<td>12.2 or higher</td>
<td>Password for the WLS admin user</td>
<td>N/A</td>
<td></td>
</tr>
</tbody>
</table>

**Customer Groups Created by Discovery**

Groups are an optional feature in Enterprise Manager that allows the logical organization of targets in accordance to user preference. Command line discovery allows the definition of target groups and placement of Oracle E-Business Suite systems in these groups at time of discovery. Groups can also be created using the normal discovery process available in the management console, as well as after discovery.

To view these groups, navigate within the Enterprise Manager console to Targets (menu) > Groups.

**Rediscovering an Oracle E-Business Suite instance**

If the Oracle E-Business Suite configuration has changed after discovery, then you must rediscover the Oracle E-Business Suite instance so that such changes are reflected in Enterprise Manager. Examples of changes to the configuration are:

- A new node has been added
A service, such as a concurrent processing service, has been enabled in a node

The steps for rediscovery are the same:

1. Navigate to the Discovery Wizard.
2. Select the Oracle E-Business Suite database.
3. Click Discover.

Deleting an Oracle E-Business Suite Instance

If you no longer want to monitor and manage a Oracle E-Business Suite instance, you can delete it. The steps are:

2. Select the Oracle E-Business Suite instance from the section Oracle E-Business Suite instances.
3. Click Delete.

By default, the system deletes application server targets (like the HTTP server, OC4J, and so on) when deleting the parent Oracle E-Business Suite target. If you do not want all the application server targets deleted, change the preference. For information on updating preferences, see: Setting Preferences, page 6-1.
This chapter covers the following topics:

- Overview of Credentials
- Preferred Credentials for Oracle E-Business Suite Application Login
- Preferred Credentials for Oracle E-Business Suite Database Login
- Preferred Credentials for Oracle E-Business Suite Node
- Preferred Credentials for Oracle WebLogic Server
- Preferred Credentials for Host
- Setting Credentials if the Oracle E-Business Suite instance features online patching
- Known Limitations

**Overview of Credentials**

The Enterprise Manager credential subsystem enables Enterprise Manager administrators to store credentials, in a secure manner, as preferences or operation credentials. The credentials can then be used to perform different system management activities, such as real-time monitoring, patching, provisioning, and other target administrative operations.

**Preferred Credentials**

Preferred credentials are used to simplify access to managed targets by storing target login credentials in the Management Repository. With preferred credentials set, users can carry out administrative operations using the job system without being prompted to log in to the target. Preferred credentials are set on a per user basis, thus ensuring the security of the managed enterprise environment.

**Default Preferred Credentials**

Default preferred credentials can be set for a particular target type and will be available
Target Preferred Credentials

Target credentials are preferred credentials set for a particular target.

Named Credentials

To set a preferred credential you must first create a named credential. Credentials are stored within Enterprise Manager as “named” entities. Administrators can define and store credentials within Enterprise Manager and refer to the credential by a credential name.

If only the senior DBAs have knowledge of higher privileged credential like `sys` credentials for a database, they can store these credentials in named credential and share the name with the junior administrators. Junior administrators can perform their jobs using the named credentials without knowing what the actual credentials are.

If the administrators have the same credentials for targets, they can create one named credential containing those credentials and share the name with appropriate personnel. This simplifies credential maintenance (changing passwords, for example) by eliminating the need to several copies of named credentials containing the same credentials.

Preferred Credentials for Oracle E-Business Suite Application Login

Create named credential for Oracle E-Business Suite Application Login:

1. Navigate to Setup menu > Security > Named Credentials and click on the Create button.

2. Provide an appropriate name and description.

3. Select Oracle E-Business Suite from Authenticating Target Type dropdown list.

4. Select E-Business Suite Applications Login Credential from the credentials type dropdown list.

5. Select scope..
   • If you choose Global this named credential will be applicable for all Oracle E-Business Suite targets.
   • If you choose Target:
     • Select Oracle E-Business Suite as the target type;
- Select the Oracle E-Business Suite for which this named credential is applicable.

6. Enter the applications login user name and password in credential properties;

7. You can test and save the credentials.

Set Preferred Credential for Oracle E-Business Suite Application Login:
1. Navigate to Setup menu > Security > Preferred Credentials.
3. Click on Manage Preferred Credentials.

Set Default Preferred Credentials for Oracle E-Business Suite Application Login:
If you want to set a preferred credential for Oracle E-Business Suite Application Login
which is applicable for all Oracle E-Business Suite targets, go to Default Preferred Credentials section.

1. Select **AppsUserCredSet** as the Credential Set.

2. Click on Set.

3. Choose the named credentials. Only those named credentials with scope as global will appear in the list.

4. You can test and save the credentials.

**Set Target Preferred Credentials for Oracle E-Business Suite Application Login:**

If you want to set a preferred credential for Oracle E-Business Suite Application Login applicable only to a specific Oracle E-Business Suite target go to Target Preferred Credential section.

1. Select the Oracle E-Business Suite instance.

2. Select **AppsUserCredSet** as Credential Set.

3. Click on Set.

4. Choose the named credentials.

5. You can test and save the credentials.

**Preferred Credentials for Oracle E-Business Suite Database Login**

Preferred credentials for database login are needed if you are using Customization Manager or Patch Manager. You must set the preferred credentials for the APPS, APPLSYS, and SYSTEM schemas.

**Create named credential for Oracle E-Business Suite Database Login:**

1. Navigate to Setup menu > Security > Named Credentials and click on the **Create** button.

2. Provide an appropriate name and description.

3. Select **Oracle E-Business Suite** from Authenticating Target Type dropdown list.

4. Select **E-Business Database Credentials** from the credentials type dropdown list.

5. Select scope.
• If you choose Global this named credential will be applicable for all Oracle E-Business Suite targets.

• If you choose Target:
  • Select Oracle E-Business Suite as the target type.
  • Select the Oracle E-Business Suite for which this named credential is applicable.

6. Enter the schema name and password in credential properties.

7. You can test and save the credentials.

**Note:** You must create three named credentials here: one for the APPS schema, one for the APPLSYS schema, and one for the SYSTEM schema.
Set preferred credential for Oracle E-Business Suite Database Login:
1. Navigate to Setup menu > Security > Preferred Credentials.
3. Click on Manage Preferred Credentials.

Credential Sets for Oracle E-Business Suite Database Login:

<table>
<thead>
<tr>
<th>Name</th>
<th>Schema</th>
</tr>
</thead>
<tbody>
<tr>
<td>AppsDBCredsSet</td>
<td>To access the APPS schema</td>
</tr>
<tr>
<td>Name</td>
<td>Schema</td>
</tr>
<tr>
<td>---------------------------</td>
<td>--------------------------------------------</td>
</tr>
<tr>
<td>AppsSysDBCredsSet</td>
<td>To access the SYSTEM schema</td>
</tr>
<tr>
<td>ApplsysDBCredsSet</td>
<td>To access the APPLSYS schema</td>
</tr>
</tbody>
</table>

**Set Default Preferred Credentials for Oracle E-Business Suite Database Login:**

If you want to set a preferred credential for Oracle E-Business Suite Application Database which is applicable for all Oracle E-Business Suite targets, go to Default Preferred Credentials section.

1. Select the Credential Set for the corresponding schema.
2. Click on Set.
3. Choose the named credentials and Save. Only those named credentials with scope as global will appear in the list.

**Set Target Preferred Credentials for Oracle E-Business Suite Database Login:**

If you want to set a preferred credential for Oracle E-Business Suite Database Login applicable only to a specific Oracle E-Business Suite target go to Target Preferred Credential section.

1. Select the Oracle E-Business Suite instance.
2. Select Credential Set for the corresponding schema.
3. Click on Set.
4. Choose the named credentials.
5. You can test and save the credentials.

**Preferred Credentials for Oracle E-Business Suite Node**

Preferred credentials for nodes are needed if you are using Customization Manager or Patch Manager. You must set them for both the applications node and database node.
Create named credentials for Oracle E-Business Suite Node using Host Credentials:

1. Navigate to Setup menu > Security > Named Credentials and click the Create button.

2. Provide an appropriate name and description.

3. Select Host from Authenticating Target Type dropdown list.

4. Select Host Credentials from the credentials type dropdown list.

5. Select scope.
   - If you choose Global this named credential will be applicable for all Oracle E-Business Suite Nodes.
   - If you choose Target:
     - Select Oracle E-Business Suite Node as the target type.
     - Select the Oracle E-Business Suite Node for which this named credential is applicable.

6. Enter the user name and password in credential properties.

7. You can test and save the credentials.
Create named credential for Oracle E-Business Suite Node using SSH Key Credentials:

1. Provide an appropriate name and description.

2. Select Host from Authenticating Target Type dropdown list.

3. Select SSH Key Credentials from the credentials type dropdown list.

4. Select scope.
   - If you choose Global this named credential will be applicable for all Oracle E-Business Suite Nodes.
   - If you choose Target:
     - Select Oracle E-Business Suite Node as the target type.
     - Select the Oracle E-Business Suite Node for which this named credential is applicable.

5. Enter the user name and upload private and public keys.
6. You can test and save the credentials.

Set preferred credential for Oracle E-Business Suite Node:
1. Navigate to Setup menu > Security > Preferred Credentials.
3. Click on Manage Preferred Credentials.

Set Default Preferred Credentials for Oracle E-Business Suite Node:
If you want to set a preferred credential for Oracle E-Business Suite Node which is applicable for all Oracle E-Business Suite nodes go to Default Preferred Credentials section.
1. Select OS Credentials as Credential Set.
2. Click on Set.
3. Choose the named credentials. Only those named credentials with scope as Global will appear in the list.

4. You can test and save the credentials.

**Set Target Preferred Credentials for Oracle E-Business Suite Node:**
If you want to set a preferred credential for Oracle E-Business Suite Node applicable only to a specific Oracle E-Business Suite Node, go to the Target Preferred Credential section.


2. Select **OS Credentials** for Credential Set.

3. Click on Set.

4. Choose the named credentials.

5. You can test and save the credentials.

**Preferred Credentials for Oracle WebLogic Server**
A preferred credential for Oracle WebLogic Server is needed if you are using Patch Manager. You must set it for the Admin server.

In addition, the WebLogic Administrator credentials must be set before you register a custom application on the patch edition in Oracle E-Business Suite Release 12.2.

**Create named credential for Oracle WebLogic Server:**
1. Navigate to Setup menu > Security > Named Credentials and click on the **Create** button.

2. Provide an appropriate name and description.

3. Select **Oracle WebLogic Server** from Authenticating Target Type dropdown list.

4. Select **Oracle WebLogic Credentials** from the credentials type dropdown list.

5. Select scope.
   - If you choose Global, then this named credential will be applicable for all WLS Servers.
   - If you choose Target:
     - Select **Oracle WebLogic Server** as the target type.
• Select the Oracle WebLogic Admin Server for which this named credential is applicable.

6. Enter the user name and password in credential properties.

7. You can test and save the credentials.

Set preferred credential for Oracle WebLogic Server:
1. Navigate to Setup menu > Security > Preferred Credentials.
2. Select Oracle WebLogic Server.
3. Click on Manage Preferred Credentials.

Set Default Preferred Credentials for Oracle WebLogic Server:
If you want to set a preferred credential for Oracle WebLogic Server which is applicable for all Oracle E-Business Suite instances, go to Default Preferred Credentials section.
1. Select Oracle WebLogic Administration Credentials for Credential Set.
2. Click on Set.
3. Choose the named credentials. Only those named credentials with scope as Global will appear in the list.

4. You can test and save the credentials.

Set Target Preferred Credentials for Oracle WebLogic Server:
If you want to set a preferred credential for Oracle WebLogic Server of a specific Oracle E-Business Suite target go to Target Preferred Credential section.
2. Select **Oracle WebLogic Administration Credentials** as Credential Set.
3. Click on Set.
4. Choose the named credentials.
5. You can test and save the credentials.

Preferred Credentials for Host
Host Preferred credentials must be set for the host from where files will be checked out by Customization Manager. The same host which is referenced in file source mapping. You must set the **Normal Username** and **Normal Password** for the host. Navigate to Setup menu > Security > Preferred Credentials. On the Preferred Credentials page, select Host and click Manage Preferred Credentials. On the Host Preferred Credentials page, set the operating system credentials of the host.

Setting Credentials if the Oracle E-Business Suite instance features online patching
If the Oracle E-Business Suite instance features online patching, credentials must be set for targets in both Run and Patch file system.

Known Limitations
In Patch Manager while trying to deploy a patch, verification of credentials will fail if you set up the SSH Key Credentials. You will still be able to proceed and deploy the patch.

Pack diagnostics tests which check whether the preferred credential is set or not will fail if you have set up SSH Keys Credentials.
This chapter covers the following topics:

- Setting Preferences

Setting Preferences

Use Preferences in Enterprise Manager to configure some of the features in Oracle Application Management Pack for Oracle E-Business Suite.

Navigate to the Preferences page from the Oracle E-Business Suite Management page through the Administer menu.
The following preferences can be set:

**For Patch Manager**
- Enforce Patch Promotion Policies
- Default Blackout Minutes in Patch Manager
- Default Blackout Hours in Patch Manager
- Target Patch Directory Location
- Connect to My Oracle Support for Patches (MOSEnabled)
- OMS Patch Stage Directory Location (required)
  
  This preference specifies the patch stage directory location. This preference is used
in conjunction with the preference "MOSEnabled". If "MOS Enabled" is unchecked, then Patch Manager will use the "OMS Patch Stage Directory Location" in searching for patches.

- Default Hotpatch in Patch Manager
- Target Stage Directory Location

For Discovery and Monitoring
- Maximum Number of Email Addresses for User (required)
- Sampling Interval for User Monitoring (required)
- Delete Application Server targets while deleting EBS Target - By default, the system deletes application server targets (like the HTTP server, OC4J, and so on) when deleting the parent Oracle E-Business Suite target. If you do not want all the application server targets deleted, deselect this check box.
- Number of Rows in Tables of User Monitoring (required)

For Customization Manager
- Stage Directory (required)
  This preference specifies the OMS stage directory for package creation.

For Cloning
- Number of threads to be used to zip, transfer, and unzip files under APPL_TOP of Apps Tier. (Maximum value is 16)
- Number of threads to be used to zip, transfer, and unzip files under COMMON_TOP of Apps Tier. (Maximum value is 4)
- Number of threads to be used to zip, transfer, and unzip files under Web home of Apps Tier. (Maximum value is 4)
- Number of threads to be used to zip, transfer, and unzip files under Tools home of Apps Tier. (Maximum value is 8)

For Upgrades from Release 3.1 or 4.0: Properties in amp.properties file replaced by Preferences

The amp.properties file used in Release 3.1 and 4.0 is obsolete in this release of the Oracle Application Management Pack for Oracle E-Business Suite. Therefore, please note that the following properties are obsolete. They were used in the security model in the previous release; in the current release, the management pack uses the native Enterprise Manager Privileges feature.
- ebs_acp_packAccessEnabled
• enableRoleBasedSecurity
• enableApproval_CM
• enableApproval_AZ
• enableApproval_PM
• targetLevelPrivilegeForApproval

The following properties must be set manually in the Preferences page after the upgrade. The property name is given with the name under Preferences in parentheses ()..

• stageDir (Stage Directory)

• ampCloneAppTopParallelThreads (Number of threads to be used to zip, transfer, and unzip files under APPL_TOP of Apps Tier)

• ampCloneToolsParallelThreads (Number of threads to be used to zip, transfer, and unzip files under Tools home of Apps Tier)

• ampCloneWebParallelThreads (Number of threads to be used to zip, transfer, and unzip files under Web home of Apps Tier)

• ampCloneCommonTopParallelThreads (Number of threads to be used to zip, transfer, and unzip files under COMMON_TOP of Apps Tier)

• um_dashboard_no_of_rows (Number of Rows in tables of User Monitoring)

• um_session_sampling_interval (Sampling Interval for User Monitoring)

• omsPatchStageDir (OMS Patch Stage Directory Location)

• MOSEnabled/metalinkEnabled (Connect to My Oracle Support for Patches)
This chapter covers the following topics:

- Privileges and Roles for Managing Oracle E-Business Suite
- Change Management Privileges
- Specific Privileges for Features

**Privileges and Roles for Managing Oracle E-Business Suite**

Oracle Application Management Pack for Oracle E-Business Suite uses the native Enterprise Manager functionality of privileges and roles for security.

**Note:** In Releases 3.1 and 4.0, security was managed through the amp.properties file and disabled by default. In this release, the amp.properties file is no longer used, and security through privileges and roles is enabled by default.

User privileges provide a basic level of security in Enterprise Manager. They are designed to control user access to data and to limit the kinds of SQL statements that users can execute. When creating a user, you grant privileges to enable the user to connect to the database, to run queries and make updates, to create schema objects, and more.

A role is a collection of Enterprise Manager resource privileges, or target privileges, or both, which you can grant to administrators or to other roles. Resource privileges allow a user to perform operations which are not dependent on a specific target type. Target privileges allow an administrator to perform operations on a target. This management pack includes target-instance level privileges, which are for a particular target instance, and target-type level privileges, which are for all target instances of that type. An example of a resource privilege is the "Edit Global Preferences" resource privilege, which enables a user to edit global preferences for Oracle Application Management Pack for Oracle E-Business Suite. An example of a target-instance level privilege is the "Start and Stop Services" which enables a user to start and stop services using the
Administration Menu for a given instance.

Privileges and roles are managed through the functions available from Setup menu > Security in the Cloud Control console. For more information, see the Oracle Enterprise Manager Cloud Control Administrator’s Guide.

Ready-to-use privileges shipped with the management pack are listed in the tables below. Please note the following in regard to privileges:

- The user SYSMAN has all the listed privileges by default.
- The use of privileges on a system is enabled by default, which means that a user will not be able to perform an action unless the appropriate privilege(s) are granted to that user.
- All target privileges are given against the target "Oracle E-Business Suite".
- Each privilege listed in the tables below does not include any other privilege. For example, the "Approve release package request" privilege does not include the privilege "Create release package request".

For privileges used by the features in Change Management (Patch Manager and Customization Manager), see the section Change Management Approval Framework and Privileges, page 12-2.

The following table lists ready-to-use resource privileges in Oracle Application Management Pack for Oracle E-Business Suite:

### Privileges applicable to all targets

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create release package request</td>
<td>To create a request to release a package</td>
</tr>
<tr>
<td>Approve release package request</td>
<td>To approve the release of a package</td>
</tr>
<tr>
<td>Edit global preferences</td>
<td>To edit global preferences of the Oracle Application Management Pack for Oracle E-Business Suite</td>
</tr>
</tbody>
</table>

The following table lists ready-to-use target instance level privileges. With these privileges, a user can perform the specified action against only the given target.
### Target Privileges

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create splice request</td>
<td>• To create a request to register a new custom application</td>
</tr>
<tr>
<td></td>
<td>• To create a request to validate an existing custom application</td>
</tr>
<tr>
<td></td>
<td>• To create a request to auto-correct an existing invalid custom application</td>
</tr>
<tr>
<td>Approve splice request</td>
<td>• To approve a request to splice an application</td>
</tr>
<tr>
<td></td>
<td>• To hide and unhide custom applications</td>
</tr>
<tr>
<td>Create Patch Manager request</td>
<td>To create a Patch Manager request</td>
</tr>
<tr>
<td>Approve Patch Manager request</td>
<td>To approve a Patch Manager request</td>
</tr>
<tr>
<td>Start and Stop Services</td>
<td>To start and stop services using the Administration Dashboard</td>
</tr>
</tbody>
</table>

The following table lists ready-to-use target type level privileges. With these privileges, a user can perform the described action against any eligible target.

### Target Type Level Privileges

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create splice request</td>
<td>• To create a request to register a new custom application</td>
</tr>
<tr>
<td></td>
<td>• To create a request to validate an existing custom application</td>
</tr>
<tr>
<td></td>
<td>• To create a request to auto-correct an existing invalid custom application</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approve splice request</td>
<td>• To approve a request to splice an application</td>
</tr>
<tr>
<td></td>
<td>• To hide and unhide custom applications</td>
</tr>
<tr>
<td>Create Patch Manager request</td>
<td>To create a Patch Manager request</td>
</tr>
<tr>
<td>Approve Patch Manager request</td>
<td>To approve a Patch Manager request</td>
</tr>
<tr>
<td>Start and Stop Services</td>
<td>To start and stop services using the Administration Dashboard</td>
</tr>
</tbody>
</table>

The following table lists ready-to-use roles:

### Roles

<table>
<thead>
<tr>
<th>Code</th>
<th>Name</th>
<th>Included Privileges</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EBS_SUPER_USER</td>
<td>Oracle E-Business Suite Super User</td>
<td>All target type privileges, all resource privileges, and CREATE_TARGET</td>
<td>Role with unrestricted access to all management activities for Oracle E-Business Suite</td>
</tr>
<tr>
<td>Code</td>
<td>Name</td>
<td>Included Privileges</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------</td>
<td>-------------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------</td>
</tr>
<tr>
<td>EBS_ACP_SUPER_USER</td>
<td>Change Management Super User</td>
<td>• Resource privilege &quot;Approve release package request&quot;</td>
<td>Role with privileges to create as well as approve all Change Management requests.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Target type level privilege &quot;Approve splice request&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Target type level privilege &quot;Approve Patch Manager request&quot;</td>
<td></td>
</tr>
</tbody>
</table>

### Change Management Privileges

Change Management for Oracle E-Business Suite provides a centralized view to monitor and orchestrate changes (both functional and technical) across multiple Oracle E-Business Suite systems. Change Management offers the capabilities to manage changes introduced by customizations, patches and functional setups during implementation or maintenance activities. For more information, see: Introduction to Change Management, page 12-1.

The Change Approval Framework helps ensure that all changes done using any of the products in Change Management go through a change approval mechanism. This change control mechanism entails one level of approval for any change that results in a configuration or code change of an Oracle E-Business Suite instance. The Change Approval Framework uses privileges and roles to enforce the approval process.

### Required Privileges and Roles

The seeded "Change Management Super User" role (code EBS_ACP_SUPER_USER) has privileges to submit and approve all Change Management requests.

For more information on these privileges, see: Privileges and Roles for Managing Oracle E-Business Suite, page 7-1.

A user must have the "Operator any Target" privilege in order to submit a patch run in
Patch Manager or create a package in Customization Manager. This privilege is described as:

- **Name** - Operator any Target
- **Description** - Ability to perform administrative operations on all managed targets
- **Included Privileges** - View any Target
- **Applicable Target Types** - All Target Types

In addition to the above Target Type privilege, a user must have the "Job System" resource privilege, as described below:

- **Name** - Job System
- **Description** - Job is a schedulable unit of work that administrator defines to automate the commonly run tasks
- **Privilege Grants Applicable to all Resources** - Create

Note: You must also assign Resource Type Privilege of "Create" to the user using the "Manage Privilege Grants" feature, available from Setup menu > Security > Administrators. For more information on managing privilege grants, see the Enterprise Manager Cloud Control documentation.

**Specific Privileges for Features**

The default roles EBS_SUPER_USER, EBS_ACP_SUPER_USER provide privileges on all targets. If these roles are provided to a particular user, there is no need of providing any specific privileges to that user. If you want to provide specific privileges to a user, follow the instructions in this section, which describes specific privileges for Cloning, Patch Manager, and Customization Manager.

There are two types of required privileges: Target Privileges and Resource Privileges.

**Target Privileges**

1. **Common Privileges**
   - **Module**: Customization Manager/Patch Manager
     - **View any Target**
     - **Execute Command Anywhere**
     - **Execute Command as any Agent**
• Module: Cloning
  • View any Target
  • Execute Command Anywhere
  • Execute Command as any Agent
  • Operator any Target
  • Add any Target

2. Application Change Management (ACMP) Specific Privileges
• Module: Customization Manager
  • Requestor: Create splice request
  • Approver: Approve splice request
  • Super User: Both

• Module: Patch Manager
  • Requestor: Create Patch Manager request
  • Approver: Approve Patch Manager request
  • Super User: Both

All above privileges can be provided either as “Common to All Targets” or “Specific to Target” by adding a target at the bottom of the Target Privilege screen and editing the target-specific privilege.

Note: The following privileges are not present as part of Target Specific Privileges but they are included under “Operator”:
• View Any Target
• Execute Command Anywhere
• Execute Command as any Agent
• Operator any Target
Resource Privileges

To grant Resource Privileges, click Edit for each Resource Privilege and select the sub-privileges.

1. Common Privileges
   - Module: ALL
     - Job System
     - Deployment Procedure
     - Oracle E-Business Suite Plug-in

2. ACMP-Specific Privileges
   There is only one ACMP-specific privilege based on user role.
   - Module: Customization Manager
     - Oracle E-Business Suite Plug-in
   - Requestor: Create release package request
   - Approver: Approve release package request
   - Super User: All

All above privileges can be provided either "Common to All Targets" or "Specific to Target" by adding a target in Resource Privilege page and selecting the applicable targets.
Monitoring Oracle E-Business Suite

This chapter covers the following topics:

• Navigation and Overview
• Home Page of an Oracle E-Business Suite System
• Configuration of Oracle E-Business Suite
• Incidents for an Oracle E-Business Suite Target
• Compliance Standards for Oracle E-Business Suite
• Monitoring Online Patching to Detect Cutover
• Monitoring Current Activity
• Monitoring User Sessions
• Monitoring JVM Usage
• Monitoring Templates for Oracle E-Business Suite
• Enabling Service Tests and Beacons Link
• Configuring Monitoring of HTTPS/SSL Targets
• Drilling Down to Oracle Applications Manager
• Concurrent Processing Dashboard
• Oracle E-Business Suite Summary on the Exalogic Dashboard
• End To End Performance Monitoring with RUEI and JVMD
• Setting up End to End Monitoring
• Analyzing a Performance Issue
• Drilling down from RUEI to AMP
• Custom Metrics
• Custom Compliance Rules
• Administration of Oracle E-Business Suite
Navigation and Overview

Once discovered, an Oracle E-Business Suite instance will appear in the Oracle E-Business Suite Instances section in the Oracle E-Business Suite Management page. You can click on the name of the instance to go to the home page of that instance.

Oracle E-Business Suite System

Oracle E-Business Suite is discovered as a system. The members of the system include all the nodes and the targets that run on each node. To see the members select Members/Show All from the target menu.

Topology of the Oracle E-Business Suite

The Configuration Topology Viewer provides a visual layout of Oracle E-Business Suite with its child targets. To access the Configuration Topology Viewer, select Members/Topology from the target menu.
Upon service failure, the potential causes of failure, as identified by root cause analysis, are highlighted in the topology view. You can view dependent relationships between services and systems from the Topology tab.

Using the viewer, you can:

- Determine the source of a target's health problems
- Analyze the impact of a target on other targets
- Determine the system's structure by viewing the members of a system and their interrelationships

**Metrics**

Once discovered, metrics are collected for Oracle E-Business Suite System as well as its individual members. To see the metrics collected for any target, select **Monitoring > All Metrics** from the Target menu.

Setting Thresholds for Metrics

Metrics collected can be compared to predefined values to check if they are exceeding a critical threshold or a warning threshold. Incidents are generated once the threshold is exceeded. To see the thresholds defined for metrics of any target, select Monitoring/Metric and Collection Settings from the Target menu. Here you can set the Critical/Warning thresholds used to generate incidents. You can also change the collection schedule of the metrics here.

For more information on incidents, see: Incidents for an Oracle E-Business Suite Target, page 8-17.
Home Page of an Oracle E-Business Suite System

General Section
The general section gives the following basic details of the Oracle E-Business Suite instance.

Configured Components
The count of member targets that fall into the status categories of Up, Down, or Other. You can drill down on a status category to view the targets that currently fall into that category.

System Name
The name of the Oracle E-Business Suite instance.

Version
The version of the Oracle E-Business Suite instance.
Products Installed
The number of products installed in the Oracle E-Business Suite system. You can drill down into Oracle Applications Manager to see the details.

New Internal System Alerts
The number of new System Alerts generated in the Oracle E-Business Suite instance. You can drill down on this number to view the details in Oracle Applications Manager. Note that these System Alerts originate from the alerting infrastructure of Oracle E-Business Suite. These are complementary to the Oracle Enterprise Manager incidents.

Patches Applied
The number of patches applied to the system in the last 24 hours. You can drill down to view the patches in Oracle Applications Manager.

Site Level Profile Options Changed
The number of site level profile options that have changed on the system in the last 24 hours. You can drill down to view the site level profile options in Oracle Applications Manager.

Context Files Edited
The number of AutoConfig context files that was changed on the system in the last 24 hours. You can drill down to view the context files in Oracle Applications Manager.

Monitoring Host
The host of the agent which is monitoring the Oracle E-Business Suite system. This will be the host where the database is running.

Note: The New Internal System Alerts, Patches Applied, Site Level Profile Options Changed, and Context Files Edited metrics are based on information periodically summarized in the Oracle E-Business Suite database by the Oracle Applications Manager Dashboard Collection concurrent program. This program is controlled through the Preferences global link in Oracle Applications Manager. If this program has been disabled in the Oracle E-Business Suite system for any reason, then these metrics will not be updated.

Availability Status Charts
This section has three charts:
• Status of the Configured Components.
Monitoring Oracle E-Business Suite

- Historic information about the status of the Oracle E-Business Suite instance. You can choose day, week, or month.

- Status of the services.

**Services**

Oracle E-Business Suite and its member targets provide four major services to its customers. They are:

- Concurrent processing
- Forms
- Self-service pages
- Workflow

All these services are registered with Cloud Control once the successful discovery of the Oracle E-Business Suite target is completed. The services section in the home page of the Oracle E-Business Suite instance has the details of services. Each service has a set of critical components without which the service cannot be provided. The following table lists the critical component of each service.

**Critical Components of Services**

<table>
<thead>
<tr>
<th>Service</th>
<th>Critical components</th>
</tr>
</thead>
</table>
| Concurrent Processing    | • Internal Concurrent Manager  
                          | • Concurrent Manager  
                          | • Database  
                          | • Apps Listener  |
Service Critical components

Workflow Service
- Concurrent Processing Service
- Oracle Workflow Background Engine
- Oracle Workflow Agent Listener
- Oracle Workflow Notification Mailer

Forms Applications Service
- Forms server (OC4J/WLS)
- HTTP Server
- Database

Self Service Applications Service
- OACORE Server (OC4J/WLS)
- HTTP Server
- Database

**Performance of Services**

The metrics collected from a service’s critical components are used to evaluate the performance of each service. The following table lists the performance metrics for each service.

**Performance Metrics for Services**

<table>
<thead>
<tr>
<th>Service</th>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Concurrent Processing Service</td>
<td>Concurrent Requests Success Rate</td>
<td>Successfully completed requests per hour</td>
</tr>
<tr>
<td>Concurrent Processing Service</td>
<td>Concurrent Requests Error Rate</td>
<td>Failed requests per hour</td>
</tr>
<tr>
<td>Service</td>
<td>Metric</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Forms Service</td>
<td>Forms Response Time</td>
<td>Average response time of forms in milliseconds</td>
</tr>
<tr>
<td></td>
<td>Forms Requests per Second</td>
<td>Average of number of requests processed by the Forms server per second</td>
</tr>
<tr>
<td>Forms Service</td>
<td>HTTP Server Request Throughput</td>
<td>Average of number of requests processed by the HTTP server per second</td>
</tr>
<tr>
<td>Workflow Service</td>
<td>Pending Agent Listener Events</td>
<td>Count of pending agent listener events</td>
</tr>
<tr>
<td>Workflow Service</td>
<td>Pending Mailer Notification Events</td>
<td>Count of pending mailer notification events</td>
</tr>
<tr>
<td>Workflow Service</td>
<td>Pending Mailer Notifications</td>
<td>Count of pending mailer notifications</td>
</tr>
<tr>
<td>Self Service Applications</td>
<td>OACore requests per second</td>
<td>Average of number of requests processed by the oacore server per second</td>
</tr>
<tr>
<td>Self Service Applications</td>
<td>HTTP Server Request Throughput</td>
<td>Average of number of requests processed by the HTTP server per second</td>
</tr>
</tbody>
</table>

**Usage by Services**

The metrics collected from a service's critical components are used to evaluate the resources used by each service. The following table lists the usage metrics for each service.

**Usage Metrics for Services**

<table>
<thead>
<tr>
<th>Service</th>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Concurrent Processing Service</td>
<td>Running Requests per Hour</td>
<td>Number of requests running per hour</td>
</tr>
<tr>
<td>Service</td>
<td>Metric</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>------------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Concurrent Processing Service</td>
<td>Active Service Processes</td>
<td>Number of active services running per hour</td>
</tr>
<tr>
<td>Forms Service</td>
<td>Forms server CPU usage</td>
<td>Percentage of CPU used by the Forms server</td>
</tr>
<tr>
<td>Forms Service</td>
<td>HTTP server CPU usage</td>
<td>Percentage of CPU used by the HTTP server</td>
</tr>
<tr>
<td>Forms Service (Socket Mode)</td>
<td>Total Memory Utilization</td>
<td>Percentage of the total memory used by the Forms process</td>
</tr>
<tr>
<td>Forms Service (Socket Mode)</td>
<td>Total CPU Utilization</td>
<td>Percentage of CPU used by the Forms process</td>
</tr>
<tr>
<td>Forms Service (Socket Mode)</td>
<td>Number of Forms Processes</td>
<td>Total number of Forms processes that are running</td>
</tr>
<tr>
<td>Workflow Service</td>
<td>Background Engine Deferred Items</td>
<td>Number of items deferred by the background engine yet to be processed</td>
</tr>
<tr>
<td>Self Service Applications Service</td>
<td>OACore CPU usage</td>
<td>Percentage of CPU used by the oacore server</td>
</tr>
<tr>
<td>Self Service Applications Service</td>
<td>HTTP server CPU usage</td>
<td>Percentage of CPU used by the HTTP server</td>
</tr>
</tbody>
</table>

**Charts for services**

You can see charts based on the above performance and usage metrics. Go to the home page of each service and click on the tab **Charts**.
Incidents for Services

You can set thresholds for tracking the performance and usage of services. Incidents are generated once the metrics exceeds the threshold. To set the threshold, go to the home page of the service and click on the tab Monitoring Configuration. Click on the link Performance Metrics or Usage Metrics. You can set the warning and critical threshold for performance and usage metrics in the respective pages.

The services section in the Oracle E-Business Suite home page shows the details described in the following table:
### Service Status Information on the Home Page

<table>
<thead>
<tr>
<th>Status</th>
<th>Whether the status is up or down</th>
</tr>
</thead>
<tbody>
<tr>
<td>System</td>
<td>The Oracle E-Business Suite system whose members are providing this service.</td>
</tr>
<tr>
<td>Performance Incidents</td>
<td>Number of performance incidents which are Critical or Warning. You can drill down from here to get the details of the incident.</td>
</tr>
<tr>
<td>Usage Incidents</td>
<td>Number of performance incidents which are Critical or Warning. You can drill down from here to get the details of the incident.</td>
</tr>
<tr>
<td>Key Components Status</td>
<td>The status of the key components. The service will be down if any of the key components is down. You can drill down from here.</td>
</tr>
<tr>
<td>Key Components Incidents</td>
<td>Incidents (Critical and Warning) raised against key components of the service. You can drill down from here.</td>
</tr>
</tbody>
</table>

### Services Dashboard

Extending the service dashboard feature provided by Cloud Control, Oracle E-Business Suite also has a service dashboard which provides a brief summary of all service-related information. You can access it by selecting Service Level Reports > Oracle Application Services from the target menu.
Targets Running on Nodes

This section shows the targets running on each node in which the Oracle E-Business Suite is deployed. The data is shown in a hierarchical way with the host as the topmost parent. The nodes running on that host appear as the immediate children. The individual targets running on each node will appear as the child of each node. If the Oracle E-Business Suite instance features Online Patching, only run edition targets will be shown.

<table>
<thead>
<tr>
<th>Node Name</th>
<th>Target Type</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Nodes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>nws.oracle.com</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ebs1123-Infrastructure</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ebs1123-nws-Database Context</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ebs1123</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ebs1123-Workflow Background Engine</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ebs1123-Infrastructure ebs1123_nws-Appl_TOP Context</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ebs1123-Internal Concurrent Manager</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ebs1123-Oracle Workflow Agent Listener</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ebs1123-Oracle Workflow Notification Mailing</td>
<td></td>
<td></td>
</tr>
<tr>
<td>forms</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cacore</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HTTP_Server</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Tip:** Use the **Detach** button to view the table in a separate page. This feature is useful if your table has more rows than can be shown in the
default display.

**Configuration of Oracle E-Business Suite**

You can get the details of how the Oracle E-Business Suite instance is configured by looking at the configuration metrics collected for the Oracle E-Business Suite target. Select Configuration > Last Collected from the target menu.

---

**Configuration of all members**

To see the configuration of each member target of Oracle E-Business Suite you would have to go to the home page of each target and follow the navigation path mentioned above. As this would be inconvenient, the **Configuration of all members** page simplifies this task. You will get a link to see configuration of all members in one place. Select Configuration of all members from the Oracle E-Business Suite target menu.
Here you can see the links to see the last collected configuration of all member targets grouped as nodes, host, services etc. You can search for any context variable by clicking the **Search Context Variable** button. You can also search for patches applied and patch set information.

### Comparing Configurations

Comparing configurations is very important while managing Oracle E-Business Suite targets. Benefits include:

- You can find out why two Oracle E-Business Suite instances with the same configuration is exhibiting different behavior.

- You can investigate the same Oracle E-Business Suite instance showing different behavior on two different occasions.

- You can use an Oracle E-Business Suite instance as golden copy to benchmark other instances.

You can compare the configuration of one Oracle E-Business Suite instance with another or the configuration of the same Oracle E-Business Suite instance collected at different times. The same applies to any member target of Oracle E-Business Suite as well. To compare configurations select Configuration > Compare from the target menu.
Configuration Comparison Templates

In Enterprise Manager, a comparison template is an exemplar for fine-tuning a comparison of like configurations. A template is associated with a specific target type, which determines the configuration item types, items, and properties to be compared. A set of default templates ships out of box to support certain target types. A template enables you to establish specific settings to take into account when comparing configurations of the given target type; for example, which property differences to ignore, and which property differences trigger an alert. For more information on comparison templates, see the Oracle Enterprise Manager Lifecycle Management Administrator’s Guide.

The Oracle E-Business Suite plug-in includes a set of comparison templates for the following target types:

- Oracle E-Business Suite
- Oracle E-Business Suite Node
- Oracle Concurrent Manager
• Oracle E-Business Suite Custom Objects
• Oracle E-Business Suite Patch Information
• Oracle E-Business Suite Workflow

These templates will be available once the Oracle E-Business Suite plug-in is deployed. You can use these templates to compare the configurations of similar target types without creating new comparison templates.

You can use these templates as-is, or as a guideline. For example, you might decide that an existing comparison template, with just a few changes, can meet your requirements. Perhaps a shipped template ignores property differences that you are concerned about. In this case, you can use the "Create Like" feature to make the adjustments to the existing template and save the new template under a different name.

**Using a configuration comparison template**

Click on Enterprise > Configuration > Compare.

In the Search region, select one of the above target types in the Target Type List. Click on the Search button.

Select the configuration against which other configurations will be compared. Click Next.

Click Add Configuration to select a single or multiple configurations to compare with the first. Click Next.

Select the template with the same name as the target type. In the same page you can view the template settings and member settings of the comparison template.

Click Submit.

Check the comparison result. The comparison report should adhere to the selected template rules. That is, if there are any ignored members or properties present from comparison, the same properties/members should not be present in the result report.

**Creating a copy of an existing comparison template**

Click on Enterprise > Configuration > Comparison Templates. Select an existing template's row and click Create Like. Give the new template a name and edit the copy of the template.

**Incidents for an Oracle E-Business Suite Target**

Incidents will be raised if any member of the Oracle E-Business Suite system is down or if any metric exceeded its threshold. The incidents region in the Oracle E-Business Suite instance home page gives an overview of the incidents raised for that instance. You can get the number of incidents grouped by severity. In addition, you can filter incidents based on the type of the incident, such as availability, performance, security, and so on.
You can drill down to the details of each incident by clicking on the summary column which takes you to the Incident Manager. Here you can see more details of the event. You can also track and manage the incident from here.

**Compliance Standards for Oracle E-Business Suite**

Compliance evaluation generates a score for a target which indicates how much the target is compliant with the standard. Violation of a standard can be classified as critical, warning or minor warning.

The management pack includes a set of compliance standards for Oracle E-Business Suite security which will be associated to every Oracle E-Business Suite instance once it is discovered. Evaluation will happen periodically which will ensure that the Oracle E-Business Suite is configured in a secure way.

The following table lists details of the compliance standards shipped along with the compliance rules associated with them.

<table>
<thead>
<tr>
<th>Compliance Standard</th>
<th>Rules mapped to the standard</th>
<th>Severity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile Settings</td>
<td>Check if all critical profiles are set correctly.</td>
<td>Critical</td>
</tr>
<tr>
<td>Profile Settings</td>
<td>Check if other profiles are set correctly.</td>
<td>Warning</td>
</tr>
<tr>
<td>Profile Settings</td>
<td>Check if no profile is missing.</td>
<td>Critical</td>
</tr>
<tr>
<td>Change Default Passwords</td>
<td>Checks if any database user with a default password exists.</td>
<td>Critical</td>
</tr>
<tr>
<td>Change Default Passwords</td>
<td>Checks if any application user with a default password exists.</td>
<td>Critical</td>
</tr>
<tr>
<td>Secure APPLSYS PUB</td>
<td>Checks if there is any unwanted privilege in the APPLSYS PUB account.</td>
<td>Warning</td>
</tr>
<tr>
<td>Use Secure Flag on DBC File</td>
<td>Checks if server security is on.</td>
<td>Warning</td>
</tr>
<tr>
<td>Migrate to Password Hash</td>
<td>Checks if the setting for hashed passwords are on.</td>
<td>Warning</td>
</tr>
<tr>
<td>Enable Application Tier Secure Socket Layer (SSL)</td>
<td>Checks if Oracle E-Business Suite is configured for HTTPS.</td>
<td>Warning</td>
</tr>
<tr>
<td>Compliance Standard</td>
<td>Rules mapped to the standard</td>
<td>Severity</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------</td>
<td>----------</td>
</tr>
<tr>
<td>Turn on ModSecurity</td>
<td>Checks if mod security is on.</td>
<td>Warning</td>
</tr>
<tr>
<td>Encrypt Credit Card Data</td>
<td>Checks for the encryption of credit card data.</td>
<td>Warning</td>
</tr>
<tr>
<td>Encrypt Credit Card Data</td>
<td>Checks if supplemental credit card data is encrypted or not.</td>
<td>Warning</td>
</tr>
<tr>
<td>Encrypt Credit Card Data</td>
<td>Checks if enhanced hashing is on or not.</td>
<td>Warning</td>
</tr>
<tr>
<td>Database Configuration Standards</td>
<td>Checks if the parameter work area size policy is set to the default recommendation</td>
<td>Critical</td>
</tr>
<tr>
<td>Database Configuration Standards</td>
<td>Checks if the use of bitmap plans optimizer parameter is set to the default recommendation</td>
<td>Critical</td>
</tr>
<tr>
<td>Database Configuration Standards</td>
<td>Checks if NLS date default format is set for Oracle E-Business Suite</td>
<td>Critical</td>
</tr>
<tr>
<td>Database Configuration Standards</td>
<td>Checks if block size for Oracle E-Business Suite is 8K</td>
<td>Critical</td>
</tr>
<tr>
<td>Database Configuration Standards</td>
<td>Checks if the create columns semantics is using byte by default for Oracle E-Business Suite</td>
<td>Critical</td>
</tr>
<tr>
<td>Database Configuration Standards</td>
<td>Checks if the total size of the SGA is configured set to the default recommendation for Oracle E-Business Suite</td>
<td>Critical</td>
</tr>
<tr>
<td>Database Configuration Standards</td>
<td>Checks if version 7 dictionary accessibility support for Oracle E-Business Suite is set to False</td>
<td>Critical</td>
</tr>
<tr>
<td>Database Configuration Standards</td>
<td>Checks if the Cost Based Optimizer is set to FALSE for Oracle E-Business Suite</td>
<td>Critical</td>
</tr>
<tr>
<td>Database Configuration Standards</td>
<td>Checks if the treat LIKE predicate with bind as an equality predicate optimizer parameter is set to suggested value</td>
<td>Critical</td>
</tr>
<tr>
<td>Compliance Standard</td>
<td>Rules mapped to the standard</td>
<td>Severity</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-----------------------------------------------------------------------------------------------</td>
<td>----------</td>
</tr>
<tr>
<td>Database Configuration Standards</td>
<td>Checks if the index fast full scan configuration set to the default recommendation</td>
<td>Critical</td>
</tr>
<tr>
<td></td>
<td>Checks for cursor sharing mode in Oracle E-Business Suite</td>
<td>Critical</td>
</tr>
<tr>
<td></td>
<td>Checks if the system management undo parameter is set for Oracle E-Business Suite</td>
<td>Critical</td>
</tr>
<tr>
<td></td>
<td>Checks if the cost ratio for sort elimination optimizer parameter is set to suggested value</td>
<td>Critical</td>
</tr>
<tr>
<td></td>
<td>Checks if optimizer parameters used to turn off automatic statistics is set for Oracle E-Business Suite</td>
<td>Critical</td>
</tr>
<tr>
<td></td>
<td>Checks if the database system triggers has been enabled for Oracle E-Business Suite</td>
<td>Critical</td>
</tr>
<tr>
<td></td>
<td>Checks if the Real Application Clusters parameter is set to TRUE startup in cluster</td>
<td>Critical</td>
</tr>
</tbody>
</table>

The compliance standards region in the home page of the Oracle E-Business Suite instance has the details of the evaluations performed on that instance and how many violations are there. You can click on each standard which will give further details of evaluations per rule. Each standard comes with a recommendation on how to fix the violations for that standard.

**Note:** Compliance standards will not be set for Oracle E-Business Suite instances discovered using the previous releases of the management pack. You must rediscover an instance to attach compliance standards to it.

**Monitoring Online Patching to Detect Cutover**

If the Oracle E-Business Suite Target features online patching, false incidents will be raised for the patch edition targets being down or the whole Oracle E-Business Suite being down during cutover. To prevent this the system keeps checking the patching activities to see if any cutover is in progress. Corrective actions are triggered once it
detects a cutover. If there is any cutover in progress the whole Oracle E-Business Suite target will be blacked out. This is true if the patching is done either from Patch Manager or Oracle E-Business Suite console. Once the cutover is complete (success or failure) the corrective actions will end the blackout of the Oracle E-Business Suite target and black out the correct patch edition.

Important points to note

- The system should detect the cutover within 15 minutes but it may get delayed further depending on the load on the OMS and Agent.

- Blackout is an asynchronous activity. Incidents may be raised even before blackout comes into effect. It is safe to ignore those incidents.

- You will not be able to perform any management activities like cloning, package creation while the corrective actions are in progress.

- In case if the corrective actions fail to sync up the editions, you can manually do it. See the section Administration of Oracle E-Business Suite, page 8-92.

- If you upgraded the management pack from Release 12.1.0.2.0, you must rediscover your Oracle E-Business Suite Release 12.2 targets after your upgrade to attach the corrective actions.

Monitoring Current Activity

Activity metrics are collected for the Oracle E-Business Suite target. These metrics provide details of current activities going on the Oracle E-Business Suite instance. Select Monitoring/All Metrics from the target menu. Expand the metric named Activity. You can see the trends for service processes, concurrent processing, and Forms.
Monitoring User Sessions

When a user logs in to Oracle E-Business Suite, the system creates sessions in the database identified by a unique session ID, or SID. All of these user sessions are created using the APPS schema credential. Each database session is associated with an Oracle E-Business Suite application user. This feature enables linking the database session with the corresponding application user for monitoring and troubleshooting purposes. You will be able to pinpoint how the Oracle E-Business Suite user opened a database session and whether it is with a concurrent processing, Forms, or Self-Service application.

For information on diagnostic tests for this feature, see: Diagnostic Tests for User Monitoring, page 10-15.

Mandatory Settings

The following settings are mandatory:

Settings in the OMS

Set the preferred credentials of the "Oracle E-Business Suite" target type for the credential set AppsUserCredsSet. You must provide the Oracle E-Business Suite user login credentials.

For information on setting preferred credentials, see: Setting Oracle E-Business Suite Preferred Credentials, page 5-1.

Settings on the Oracle E-Business Suite

- For the above Oracle E-Business Suite user, assign "LCM_EM_CLIENT" responsibility.
- Form sessions can be monitored only when the site-level profile Sign-On:Audit
Level is set to 'FORM'. The internal name for this profile is 'SIGNONAUDIT:LEVEL'.

**Top Sessions**

This page will show four bar charts of database sessions triggered by APPS database user.

- Top waiting sessions: sessions waiting for a database event to trigger to proceed further.

- Top running SQL statements.

- Top CPU consuming sessions.

- Top memory intense sessions.

The level of detail shown in the bar graphs is controlled by properties set in the Preferences page. See: Setting Preferences, page 6-1.

- Sampling Interval for User Monitoring. By default it is 15 minutes and can be increased up to 60 minutes.

- Number of Rows in tables of User Monitoring.

You can drill down from the legend to see the details of the session. If the Oracle E-Business Suite user information is available, the Oracle E-Business Suite session details is shown with further drilling down available to the database session details. If the Oracle E-Business Suite user information is not available (that is, the database sessions was triggered by a background process and not by a user), you can drill down to the database session details directly.

To navigate to the Top Sessions page, select User Monitoring > Top Sessions from the target menu of the Oracle E-Business Suite target.
Searching for User Sessions

You can search for Oracle E-Business Suite user sessions using:

Database Session ID - Provide the database session ID and if a match is found with a concurrent program, form, or Oracle Application Framework page, the details will be shown with a drilldown facility to the database session details.

Oracle E-Business Suite user name - This search shows all the active concurrent programs, Forms, and Oracle Application Framework pages accessed by the user. It will also show the associated database session ID with drilldown capability.

To navigate to user sessions search, select User Monitoring > Search E-Business Suite User from the target menu of the Oracle E-Business Suite target.
Monitoring JVM Usage

Note: This feature is not supported for Oracle E-Business Suite Release 12.2 in this release. Starting from AMP 12.1.0.3.0, this feature is disabled by default. You must enable it by following the steps mentioned below.

You can monitor JVM usage parameters which are specific for Oracle E-Business Suite. You can review the following parameters for each of the oacore J2EE containers in which a given Oracle E-Business Suite instance is deployed.

- Application Module pool - Provides information about all active and leaked application modules.
- Locked AOLJ Connections - Provides information about all locked and leaked AOL/J connections utilized by applications.
- Cache Components - Provides information about the cache component utilization by Oracle Application Framework.
Setup Steps

For Release 12 systems, ensure that you have set up the monitoring configuration for each "oacore" OC4J target as follows:

1. In the section Targets Running on Nodes in the Oracle E-Business Suite instance home page, click on the "oacore" OC4J target. This will take you to the home page of the target.

2. On the home page of the oacore OC4J target, Select Target Setup > Monitoring Configuration in the target menu.

3. Enter the OC4J administrator username and password for the "oacore" OC4J in the "Username for Basic authorization" and the "Password for Basic authorization" fields, respectively.

   **Note:** The OC4J administrator username by default is "oc4jadmin" and is specified in the system-jazn-data.xml file under the $INST_TOP/ora/10.1.3/j2ee/oacore/config directory. The oc4jadmin password by default is set to a randomized value during installation and will need to be reset as in the following example:

   In the $INST_TOP/ora/10.1.3/j2ee/oacore/config/system-jazn-data.xml file, set the value of the "credentials" element for oc4jadmin user to your chosen password preceded by a ! character. For example:

   ```xml
   <user>
   <name>oc4jadmin</name>
   <display-name>OC4J Administrator</display-name>
   <description>OC4J Administrator</description>
   <credentials>!new password</credentials>
   </user>
   ``

   After saving system-jazn-data.xml, restart the oacore OC4J. This step encrypts the updated password in system-jazn-data.xml.

4. Click **OK** to save the information.

For both Release 11i and Release 12, ensure that the Application Server passwords are set as well, because Oracle Enterprise Manager expects these passwords to be set for metrics collection for the JVM targets.
Command to enable the metric collection

```bash
./emcli modify_collection_schedule -force
-targetType="oracle_apps_jvm"
-targetNames="<targetName1>,<targetName2>"
-collectionName="LockedAOLJConn"
-collectionStatus="Enabled" -preview=N -freqType="Minute"
-freqValue="1"
```

```bash
./emcli modify_collection_schedule -force
-targetType="oracle_apps_jvm"
-targetNames="<targetName1>,<targetName2>"
-collectionName="AMPoolCount"
-collectionStatus="Enabled" -preview=N -freqType="Minute"
-freqValue="1"
```

```bash
./emcli modify_collection_schedule -force
-targetType="oracle_apps_jvm"
-targetNames="<targetName1>,<targetName2>"
-collectionName="CachedObjects"
-collectionStatus="Enabled" -preview=N -freqType="Minute"
-freqValue="1"
```

Command to disable the metric collection

```bash
ecli modify_collection_schedule
-targetType="oracle_apps_jvm"
-targetNames="<targetName1>,<targetName2>"
-collectionName="LockedAOLJConn"
-collectionStatus="Disabled" -preview=N
ecli modify_collection_schedule
-targetType="oracle_apps_jvm"
-targetNames="<targetName1>,<targetName2>"
-collectionName="AMPoolCount"
-collectionStatus="Disabled" -preview=N
ecli modify_collection_schedule
-targetType="oracle_apps_jvm"
-targetNames="<targetName1>,<targetName2>"
-collectionName="CachedObjects"
-collectionStatus="Disabled" -preview=N
```

To find out the oracle_apps_jvm target names associated with an Oracle E-Business Suite instance, go to the All Targets page and search for `<ebs_instance_name>%oacore_jvm_1_apps`.

**Note:** It is important to set the oc4j admin username and password at the EBS as per the mandatory setups mentioned above. If you enable this metric without doing that, it can result in flooding of metric collection errors at the OMS repository.

### Monitoring Templates for Oracle E-Business Suite

Monitoring templates let you standardize monitoring settings across your Oracle E-Business Suite environments by allowing you to specify the monitoring settings once and apply those to your monitored targets. You can save, edit, and apply these templates across one or more targets. A monitoring template is specified for a particular target type and can only be applied to targets of the same type. For example, you can
define one monitoring template for Oracle E-Business Suite test instances and another monitoring template for Oracle E-Business Suite production instances. For more descriptions of Oracle Certified Templates and Oracle Provided Templates please see the latest Oracle Enterprise Manager Cloud Control Administrator’s Guide.

**Note:** Currently, Oracle delivered templates may not have many out-of-box metric values. However, you can set these metric values by observing the trend in your own environment over a period of time. You can view some of the trend information by examining Average value, Low value, and High value statistics for each metric that you are monitoring using the template.

**Managing Out-of-Box Monitoring Templates for AMP Targets**

Navigate to monitoring templates using the path Enterprise (menu) > Monitoring > Monitoring Templates.

Users must have the requisite privilege(s) to manage monitoring templates. The privilege(s) for the view/edit/create like/delete functions for managing out-of-box monitoring templates for AMP are the same as that for all out-of-box monitoring templates. See Oracle Enterprise Manager Cloud Control Administrator’s Guide for more information.
Viewing Out-of-Box Monitoring Templates

To view out-of-box monitoring templates, select "Display Oracle Certified Templates" and search for templates. All Oracle-certified templates are displayed.

Default Listing of the Monitoring Templates

Out-of-box monitoring templates are called 'Oracle Certified Templates', by default the 'Oracle Certified Templates' are not displayed.

Find Out-of-Box Monitoring Templates for Oracle Application Management Pack for Oracle E-Business Suite

Search for out-of-box monitoring templates for AMP targets by checking "Display Oracle Certified Templates" and selecting the AMP target type, or enter the Target Name search criteria. Currently, out-of-box monitoring templates is supported for following AMP targets:

- Oracle E-Business Suite
- Oracle Concurrent Manager
- Concurrent Processing Service
- Oracle Workflow Agent Listener
- Oracle Workflow Background Engine
- Oracle Workflow Notification Mailer
• Workflow Service
• Oracle Applications JVM Usage
• Self Service Application Service
• Forms Based Applications Service

Editing Out-of-Box Monitoring Templates

Editing an out-of-box monitoring template is not permitted in all Enterprise Manager versions. Please check Oracle Enterprise Manager Cloud Control Administrator’s Guide for more information.

In addition, the Edit option is enabled only if the user has the required privilege to edit an out-of-box monitoring template through Enterprise Manager. AMP templates follow the same restrictions as all out-of-box monitoring templates.

The Monitoring Templates home page lists all viewable templates. To display out-of-box templates, search using the criterion ‘Oracle Certified Templates’.

To edit a template:

1. From the Enterprise menu, select Monitoring, and then Monitoring Templates.
2. Choose the desired out-of-box monitoring template from the table.
3. Click Edit.
4. Once you have finished making changes, click OK.
Copying an Out-of-Box Monitoring Template

To create a template based on an existing template, select the template, go to Actions and select 'Create Like'.

Enter the inputs for 'General', 'Metric Thresholds', and 'Other Collected Items' and click OK.
Deleting an Out-of-Box Monitoring Templates

Out-of-box monitoring templates cannot be deleted.

Applying a Monitoring Template to an Oracle E-Business Suite Target

An out-of-box monitoring template can be applied to an AMP target based on the target type. To apply a template, you must have at least Manage Target Metrics target privileges on the destination target(s).

1. From the Enterprise menu, select Monitoring and then Monitoring Templates.

2. Select the desired template from the table.

3. Click Apply.

4. Select the desired apply options and the target(s) to which you want the templates applied. See Oracle Enterprise Manager Cloud Control Administrator’s Guide for more information.

5. Click OK.
Other Features of Monitoring Templates

All other features of out-of-box monitoring templates such as 'Compare Settings', 'View Past Apply Operations' are valid for out-of-box monitoring templates in AMP.

Defining or Modifying the Threshold Values in the Out-of-Box Monitoring Templates

Currently, the Oracle Application Management Pack for Oracle E-Business Suite supplies the out-of-box monitoring templates with default values. To define the threshold values in out-of-box monitoring templates, the following steps are involved:

1. Observe the trend of the metrics for the targets.
2. Determine the threshold values based on observation.
3. Modify the threshold values by editing the template.
4. Apply the modified template to the target.

To check the trend of the metrics for the target, navigate to [Target] > Monitoring > All Metrics. Select any metric, and check 'Metric Value History'. Change the 'View Data' period based on the time of analysis.
Enabling Service Tests and Beacons Link

Administrators can define service tests for Oracle E-Business Suite services, and can also define their own ATS transactions to determine the health of an application (for example, whether the application is rendering the correct pages and functional flows are intact). All Oracle E-Business Suite service targets support the Service Test Types of ATS and HTTPPING. For more information on service tests, service test types, beacons, and Oracle Application Test Suite (OATS), see the section "Configuring and Using Services" in the Oracle Enterprise Manager Cloud Control Administrator’s Guide.

Specifically, the following services have the 'Service Tests and Beacons' link enabled:

- oracle_apps_svc_cp (Concurrent Processing Service)
- oracle_apps_svc_ebs (Oracle Applications Service)
- oracle_apps_svc_forms (Forms Based Applications Service)
- oracle_apps_svc_ssa (Self Service Applications Service)
- oracle_apps_svc_wf (Workflow Service)

The basic steps to create such a test are as follows:

1. Navigate to the Service target home page.
2. Select the Service link.
3. Click on the Monitoring Configurations tab.
4. Select the "Service Tests and Beacons" link.
5. Select 'Test Type' as 'ATS Transaction' and click Add.
6. Enter an appropriate name.
7. Click the Upload button and select the OATS script zip file.

8. Add a Beacon to monitor the Service Test. The Enterprise Manager Management Beacon default is available.

9. Enable the Service Test.

10. Click OK.

Example - Creating an ATS transaction for a Concurrent Processing Service

1. Navigate to the an Oracle E-Business Suite instance home page. Under Services, click on a concurrent processing service’s name (link).

2. Click on the Monitoring Configurations tab in the Concurrent Processing Service page.

3. Select the "Service Tests and Beacons" link.
4. Select 'ATS Transaction' for the Test Type and click **Add**.

5. Enter an appropriate name for the test.

6. Upload the OATS script ZIP file from the Local Machine or Test Repository.
7. Add a Beacon to monitor the Service Test. The Enterprise Manager Management Beacon default is available.

8. Enable the Service Test.

9. Click OK.
Seeded ATS Test Transaction for Self Service Applications Service

A sample ATS test script is shipped out of the box for a login/logout test against Oracle E-Business Suite 12.1.X instances. This script will only work if the 12.1.X instance is not SSL configured. This ATS test transaction is configured during the discovery time of the 12.1.3 Oracle E-Business Suite instance against 'Self Service Applications Service'. An end user needs to enable the ATS transaction and edit it with a correct Oracle E-Business Suite username and password.

1. Click on the Monitoring Configuration tab from the Self Service Applications Service home page.

2. Click on the 'Service Tests and Beacons' link.
3. The default ATS service test is disabled. First mark the default beacon, 'EM Management Beacon' as 'Key Beacon' in the Beacons region. Then click on the **Enable** button for the Service Test.

4. Click on **Edit**.
5. Enter the Oracle E-Business Suite applications username and password under Variables, Sensitive Values. Click OK.
6. Again, click the **OK** button from the Service Tests and Beacons home page to ensure that the changes are saved.
7. You can verify service test as follows:

Click the **Verify Service Test** button in the Service Tests region.

Click the **Perform Test** button.
Execution results are displayed in the results table.

8. You need to mark this service as 'Key Service Test' so that it starts contributing to the availability.

Check the Key Service Test box and click the Change Key Tests button.
For more details see the chapter "Configuring and Using Services" in the Oracle Enterprise Manager Cloud Control Administrator’s Guide.

Configuring Monitoring of HTTPS/SSL Targets

To configure Cloud Control to monitor Oracle E-Business Suite middle tiers that are running in SSL, each Management Agent must be able to authenticate the middle tier's SSL certificate against its Certificate Authority (CA).

Assumed Prerequisites

The HTTP Server that ships with Oracle E-Business Suite is already configured and verified to be running in SSL mode.

Basic knowledge of SSL certificates and their configuration.

Obtaining the CA certificate(s)

1. In Microsoft Internet Explorer, connect to the HTTPS URL of the Web site you are attempting to monitor.

2. Double-click the lock icon at the bottom of the browser screen which indicates that you have connected to a secure Web site. The browser displays the Certificate dialog box, which describes the certificate used for this Web site. Other browsers offer a similar mechanism to view the certificate details of a Web site.
3. Click the Certificate Path tab and select the first entry in the list of certificates.
4. Click View Certificate to display a second Certificate dialog box.
5. Click the Details tab on the Certificate window.
6. Click Copy to File to display the Certificate Manager Export wizard.
7. In the Certificate Manager Export wizard, select Base64 encoded X.509 (.CER) as the format you want to export and save the certificate to a text file with an easily identifiable name, such as beacon_certificate.cer.
8. Open the certificate file using a text editor.

Add the Certificate to the Management Agent(s)
Each Management Agent that monitors an Oracle E-Business Suite middle-tier must have the CA certificate added to it as follows:
1. Locate the b64InternetCertificate.txt file in the following directory of Agent Home of the Beacon host: $AGENT_ORACLE_HOME/sysman/config (This file contains a list of Base64 Certificates).
2. Edit the b64InternetCertificate.txt file and add the contents of the certificate file you just exported to the end of the file, taking care to include all the Base64 text of the certificate including the BEGIN and END lines.
3. Repeat for each Management Agent.

Restart Each Management Agent
Each Management Agent should be restarted:
> $AGENT_ORACLE_HOME/bin/emctl stop agent
> $AGENT_ORACLE_HOME/bin/emctl start agent
Cloud Control may not immediately pick up the change. You may want to give it a few minutes for the agent to run a metrics collection and upload them to the Oracle Management Server (OMS). You can click on the Refresh icon in the upper right of the Oracle E-Business Suite home page (by the Page Refreshed time stamp) in the Cloud Control console to get updated information.

Importing an Oracle E-Business Suite SSL Certificate to the OMS
Oracle Application Management Pack for Oracle E-Business Suite invokes REST services deployed on Oracle E-Business Suite using java.net.HttpURLConnection. The User Monitoring and Diagnostics features use REST services. If the Oracle E-Business Suite instance is SSL-enabled, the SSL certificate must be exported from
Oracle E-Business Suite and imported to the trust keystore of the Oracle WebLogic Server (WLS) that runs the OMS. Below are the steps to do this action:

1. Find out the trust keystore of WebLogic Server.

2. Open the WebLogic Server Administration Console by using the following steps.
   1. Go to the All Targets page of Enterprise Manager Grid Control.
   2. Select the target type Oracle WebLogic Server.
   3. Select the WebLogic Server instance that runs the OMS.
   4. The target home page will contain the link to open the Administration Console.

3. From the Administration Console, select Servers.

4. Select the server that runs the OMS.

5. Click on the subtab Keystores under Configuration.

6. Look for the Java Standard Trust Keystore which points to the location of the keystore.

7. Run the command to import the certificate using the `keytool` utility. Use the JDK that comes with WebLogic Server.

   ```
   JDK_HOME/bin/keytool -importcert -alias oracle_ebs_<ebs instance name> -trustcacerts -file <location of EBS SSL certificate> -keystore <location of key store>
   ```

   Refer to the Java SE documentation on the command `keytool` for information on passwords.

8. Restart the OMS.

For more information on configuring identity and trust for WebLogic Server, see the Oracle Fusion Middleware manual *Securing Oracle WebLogic Server*.

**A Note on Oracle Forms 6i**

Even though your Oracle Forms configuration may be running in SSL, Cloud Control does not require any additional configuration to monitor Forms. The reason for this is that it uses a different method for determining the Forms Server status which does not require SSL communications with the server.

**Re-Configuring SSL for Oracle E-Business Suite**

If you have implemented SSL or deactivated SSL after the initial discovery of that Oracle E-Business Suite instance in Cloud Control, you will have to re-configure Cloud
Control to monitor the new URL with the new protocol. There are two ways to do this:

- The Easy Way: If you don't care about the metrics data that has been collected for the instance, you can simply remove the instance from Cloud Control and rediscover it.

- The Hard Way: If metrics history is important, then each HTTP Server Target has to be re-configured to point to the new URL, port, and protocol.

**Re-configuring Release 11i/ Apache Targets**

1. Select the Release 11i instance in the Oracle Applications targets tab.
2. Under Applications Nodes Status, expand the Context link that corresponds with your SSL middle tier.
3. Select the Apache target (description: "HTTP Server for Oracle Applications 11i").
4. From the Target menu, select Target Setup, then select Monitoring Configuration.
5. Edit the Protocol and Port as appropriate.
6. Click OK.

**Re-configuring Release 12 Application Servers**

1. Select the Release 12 instance in the Oracle Applications targets tab.
2. Under Applications Nodes Status, expand the Context link that corresponds with your SSL middle tier.
3. Select the target described as "Oracle Application Server".
4. Navigate to the Target menu (labeled "Application Server"), and select Change Application URL.
5. Edit the "URL to measure application response" as appropriate.
6. Click OK.

**References**

- My Oracle Support (formerly OracleMetaLink) Knowledge Document 123718.1 - A Guide to Understanding and Implementing SSL with Oracle Applications Release 11i
- My Oracle Support Knowledge Document 376700.1 - Enabling SSL in Oracle Applications Release 12
Drilling Down to Oracle Applications Manager

You can drill down to the Oracle Application Manager of each Oracle E-Business Suite instance from Oracle E-Business Suite plug-in. Select Oracle Applications Manager from the target menu.

You can go to the following sections and its subsections in Oracle Applications Manager:

- Database
- Concurrent Processing
- Forms
- Workflow
- Configurations of all hosts
- Configurations of all nodes
- Applications Usage
- Others

**Concurrent Processing Dashboard**

The Concurrent Processing Dashboard provides you with details in concurrent processing in your Oracle E-Business Suite system. The dashboard gives you a complete picture of concurrent processing on your system, both current activities as well as usage statistics.

To navigate to the Concurrent Processing Dashboard, select E-Business Dashboard > CP Dashboard from the target menu of the Oracle E-Business Suite target.

You can add a user-defined concurrent program as a target to the Oracle E-Business Suite composite target. You can then monitor related activities of the registered individual concurrent programs for your own specified thresholds.

You can also add a user-defined concurrent manager as a target to the Oracle E-Business Suite composite target. You can then monitor related activities of the registered individual concurrent managers for your own specified thresholds.
Overview Tab

The General region includes details on the status of the Concurrent Processing Service:

- **Status** - The status is linked to the Concurrent Processing Service home page.
- **Active Service Processes** - Number of active service processes.
- **User-defined Concurrent Program Targets** - Defining these targets is described in a later section.
- **Configured Concurrent Managers** - The number of configured concurrent managers.

The Hourly Completed Requests region shows a pie chart for requests by status (Successful, Warning, and Errored).

The Activity Summary graph illustrates active requests in the following statuses:

- **Pending Normal**
- **Pending Standby**
- **Running**

The Components region lists components of the Concurrent Processing service. The table shows the following for each component:

- **Name**
- **Type**
• Status
• Incidents
• Host

The Incidents region lists any incidents that were triggered recently, with the following information for each:
• Severity
• Metric
• Target Name
• Target Type
• Incident Triggered
• Last Value
• Last Checked

At the bottom of the dashboard are Related Links:
The first three links provide metrics on requests and processes:
• Hourly Completed Requests
• Processes and Requests per Concurrent Manager
• Active Concurrent Requests by Application

The last three links take you to Oracle Applications Manager pages for the Oracle E-Business Suite instance:
• Concurrent Request Runaways
• Concurrent Processing Reports
• Concurrent Processing Charts
The Concurrent Requests by Status region lists the number of requests for each status:

- Pending Normal
- Pending (Standby)
- Scheduled
- Inactive (No Manager)
- On Hold
- Running

Click on the number for a status to find out more about the metric trend.

The Hourly Completed Requests region lists statistics for requests that have completed in the past hour, including:

- Successful
- Warning
- Error
• Successful Requests Rate (%)
• Requests Warning Rate (%)
• Requests Error Rate (%)

Click on the number for each statistic to find out more details.

The Concurrent Managers by Requests lists all concurrent managers, in order of the number of requests it has in the specified status, either Running or Pending.

With "Running" selected, the following is shown for each concurrent manager:

• Service Name
• Service Short Name
• Application Name
• Status
• Running Requests
• Service Handle
• Service Target Processes
• Service Actual Processes

With "Pending" selected, the following is shown for each concurrent manager:

• Service Name
• Service Short Name
• Application Name
• Status
• Normal Pending Requests
• Standby Pending Requests
• Service Handle
• Service Target Processes
• Service Actual Processes

The Top Concurrent Requests region shows the top ten (10) requests for the specified status of Running, Pending, or Scheduled.
• Running - These are sorted by running time in descending order.
• Pending - These are sorted by running time in descending order.
• Scheduled - These are sorted by their scheduled start time.

The Top Applications region lists the top ten (10) applications for running requests or pending requests, as specified.
The Top Users region lists the top ten (10) users by number of running or pending requests, as specified.

**Usage Tab**

![Concurrent Processing Dashboard]

This tab provides a summary of how the concurrent programs and managers have been utilized over a period of time.

The top ten (10) concurrent requests for the following categories are listed:
• Number of executions - For this category, the total number of executions, the percentage (%) of successful executions, and the percentage (%) of errored executions are shown.
• Number of failed executions - The number of executions, percentage (%) of failed executions, and percentage (%) of errored executions are shown.
• Average run time in minutes - The number of executions, average running time (minutes), and total running time (minutes) are shown.
• Total run time in minutes - The top ten (10) programs with the highest maximum running time are shown. For each program listed, the number of executions, total running time (minutes) and percentage (%) of successful executions are shown.

<table>
<thead>
<tr>
<th>Top Applications</th>
<th>Top Users</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Apps</td>
<td>Number of Executions</td>
</tr>
<tr>
<td>Application Name</td>
<td>Application Short Name</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>Application Object Library</td>
<td>MON</td>
</tr>
<tr>
<td>Applications DEA</td>
<td>AD</td>
</tr>
<tr>
<td>Receivables</td>
<td>RC</td>
</tr>
<tr>
<td>Incentive Compensation</td>
<td>IC</td>
</tr>
<tr>
<td>Human Resources</td>
<td>HR</td>
</tr>
<tr>
<td>Service Contracts</td>
<td>SKS</td>
</tr>
<tr>
<td>Service</td>
<td>CS</td>
</tr>
<tr>
<td>Supplies</td>
<td>SQMP</td>
</tr>
<tr>
<td>Sales Foundation</td>
<td>AS</td>
</tr>
<tr>
<td>Sales</td>
<td>SBR</td>
</tr>
</tbody>
</table>

The top ten (10) applications for the following categories are listed:

• Number of Executions

• Number of Failed Executions

The top ten (10) users by total number of requests are also listed, in descending order of number of requests.
User-Defined Targets Tab

You can add concurrent managers and programs as targets to monitor. Use this tab to get details about these targets as well as add more custom targets.

Concurrent Programs

For custom concurrent program targets, the following columns are shown:

- Name
- Concurrent Program Short Name
- Incidents
- Host

Click on “Show” in the Details column to see the following metrics for the given concurrent program target. (More details can be seen from the Target home page > All Metrics):

- Number of Concurrent Requests by Status
- Number of Hourly Completed Requests
- Requests Completed with Error
- Long-Pending Requests
• Long-Running Requests

Use the Add button under Concurrent Programs to add a new program target.

**Concurrent Managers**

For concurrent manager targets, the following columns are shown:

• Name

• Concurrent Manager Short Name

• Incidents

• Host

Click on "Show" in the Details column to see the following for the given concurrent manager target:

• Active Processes

• Running Requests

• Pending Requests

Use the Add button under Concurrent Managers to add a new manager target.

**Adding a Concurrent Program Target**

You can add a concurrent program custom target so that the system will collect metrics on activity and usage for the concurrent program.

*Note:* You cannot add a custom concurrent program target using Internet Explorer 8. Please use a different version, or different browser such as Mozilla Firefox.

1. To add a concurrent program custom target, navigate to the Concurrent Processing Dashboard, User Defined Targets tab, and click Add under Concurrent Programs.
2. For your new target, define the following:

- **Target Name Prefix** - This value is determined by the system based on the instance name and cannot be updated.

- **Target Name** - Enter in a target name "suffix". The actual target name will be composed of the Target Name Prefix (above) and the value of this field.

- **Target Type** - The system automatically provides the value "Custom Oracle Concurrent Program".

- **Concurrent Program Short Name** - Use the LOV icon to search for and select the program short name. In searching for the program name you can search by concurrent program short name, concurrent program name, or application.

- **Monitoring Host**

For the Basic Properties region, values for the following should default in. These values are used as credentials by the target for metrics collection:

- **SID**

- **Machine**

- **Port**

- **(Database) User name**
• (Database) Password
• ConnectString

3. For metrics collection, you need to define the thresholds for several metrics. Define instance parameters that will be used to categorize requests for the following:

   A request will be termed Long Pending if it is in Pending status for longer than the "Long Pending Request Threshold In Minutes".

   A request will be considered Long Running if it runs for longer than the "Long Running Request Threshold In Minutes" and (1+0.1*"Long Running Tolerance Percentage")*Average Running Time of the Concurrent Program.

4. When you are done, click Add to add the target.

**Custom Concurrent Program Target Metrics**

Once you have added a custom concurrent program target, you can monitor it. It should be listed on the User Defined Targets tab. Click on its name link to view details.

Click on the Show link under Details for links to drill down on the following:

• Number of Concurrent Requests by Status
• Number of Hourly Completed Requests
• Requests Completed with Error
• Long Pending Requests
• Long Running Requests

From here, you can access the metrics collected for this target by navigating to Target menu > Monitoring > All Metrics. The collected metrics are listed below.
Metrics Collected

The following metrics are collected:

Basic Information

This page lists metrics for the following:

- Requests Completed Successfully
- Requests Completed with Warnings
- Requests Completed with Errors
- Minimum Run Time
- Maximum Run Time
- Average Run Time

Concurrent Requests by Status

The numbers for requests in each status below are listed.

- Concurrent Requests Pending (Normal)
- Concurrent Requests Pending (Standby)
- Concurrent Requests Scheduled
- Concurrent Requests Inactive (No Manager)
- Concurrent Requests Inactive (On Hold)
- Concurrent Requests Running

Hourly Completed Requests

- Concurrent Requests Completed Successfully
- Concurrent Requests Completed With Warning
- Concurrent Requests With Error
- Concurrent Requests Successful Requests Rate (%)
- Concurrent Requests Warning Rate (%)
- Concurrent Requests Error Rate (%)

Long Pending Requests
- Request ID
- Concurrent Program Short Name
- Concurrent Program Name
- Request Start Date
- Username
- Phase
- Status
- Pending Time
- Concurrent Manager

Long Running Requests
- Request ID
- Concurrent Program Short Name
- Concurrent Program Name
- Request Start Date
- Username
- Phase
- Status
- Running Time
- Concurrent Manager

Pending Requests
- Request ID
- Concurrent Program Short Name
- Concurrent Program Name
• Request Start Date
• Username
• Phase
• Status
• Pending Time
• Concurrent Manager

Requests Completed with Error
• Request ID
• Concurrent Program Short Name
• Concurrent Program Name
• Request Start Date
• Username
• Phase
• Status
• Execution Time

Requests Completed with Warning
• Request ID
• Concurrent Program Short Name
• Concurrent Program Name
• Request Start Date
• Username
• Phase
• Status
• Execution Time
Running Requests

- Request ID
- Concurrent Program Short Name
- Concurrent Program Name
- Request Start Date
- Username
- Phase
- Status
- Running Time
- Concurrent Manager

Adding a Concurrent Manager Target

You can add a concurrent manager custom target so that the system will collect metrics on activity and usage for requests run by the concurrent manager.

1. To add a concurrent manager custom target, navigate to the Concurrent Processing Dashboard > User Defined Targets tab, and click **Add** under Concurrent Manager.
2. For your new target, define the following:

- **Target Name Prefix** - This value is determined by the system based on the instance name and cannot be updated.

- **Target Name** - Enter in a target name "suffix". The actual target name will be composed of the Target Name Prefix (above) and the value of this field.

- **Target Type** - The system automatically provides the value "Custom Oracle Concurrent Manager".

- **Concurrent Manager Short Name** - Use the LOV icon to search for and select the concurrent manager short name. In searching for the manager name you can search by concurrent manager short name, concurrent manager name, or application.

- **Monitoring Host**

For the Basic Properties region, values for the following should default in. These values are used as credentials by the target for metrics collection:

- **SID**

- **Machine**

- **Port**
• (Database) User name
• (Database) Password
• ConnectString

3. For metrics collection, you need to specify values for three Instance Properties that will be used to categorize requests for the following:

A request will be termed Long Pending if it is in Pending status for longer than the "Long Pending Request Threshold In Minutes".

A request will be considered Long Running if it runs for longer than the "Long Running Request Threshold In Minutes" and (1+0.1*"Long Running Tolerance Percentage")*Average Running Time of the Concurrent Program.

You can also change these properties by clicking the "Monitoring Configuration" link on the Target Home page.

4. When you are done, click Add to add the target.

**Monitoring a Custom Concurrent Manager Target**

Once you have added a custom concurrent manager target, you can monitor for it. It should be listed on the User Defined Targets tab. Click on its name link to view details.

From here, you can also monitor the metrics for this target by navigating to Target menu > Monitoring > All Metrics.

**Active Processes**

• Target Node
• OS Process ID
• Session ID
• Process Status

Pending Requests
• Request ID
• Concurrent Program Short Name
• Concurrent Program Name
• Request Start Date
• Username
• Phase
• Status
• Pending Time

Running Requests
• Request ID
• Concurrent Program Short Name
• Concurrent Program Name
• Request Start Date
• Username
• Phase
• Status
• Running Time
Concurrent Processing Metrics

This section lists the concurrent processing metrics available from the All Metrics page. Navigate to the All Metrics page by selecting Target menu > Monitoring > All Metrics. For each type of metric below, the details listed for each record are shown.

**Active Concurrent Requests by Application**
- Application Short Name
- Application Name
- Non-Repeating Pending Requests (Normal and Standby)
- Repeating Pending Requests (Normal and Standby)
- Non-Repeating Running Requests
- Repeating Running Requests

**Applications by Errored Executions**
- Application Short Name
• Application Name
• Total Executions
• Errored Executions
• Errored Executions (%)

Applications by Executions
• Application Short Name
• Application Name
• Total Executions
• Successful Executions (%)
• Errored Executions (%)

Applications by Pending Requests
• Application Short Name
• Application Name
• Number of Pending Requests

Applications by Running Requests
• Application Short Name
• Application Name
• Number of Running Requests

Programs by Average Running Time
• Concurrent Program Name
• User Concurrent Program Name
• Total Executions
• Average Running Time
• Maximum Running Time
Programs by Errored Executions
- Concurrent Program Name
- User Concurrent Program Name
- Total Executions
- Total Executions (Errored)
- Executions Errored (%)

Programs by Executions
- Concurrent Program Name
- User Concurrent Program Name
- Total Executions
- Successful Executions (%)
- Errored Executions (%)

Programs by Total Running Time
- Concurrent Program Name
- User Concurrent Program Name
- Total Executions
- Total Running Time
- Successful Executions (%)

Top Pending Requests
- Request ID
- Program Name
- Program Short Name
- Request Start Date
- Pending Time
• User Name
• Manager Name
• Phase
• Status

Top Running Requests
• Request ID
• Program Name
• Program Short Name
• Request Start Date
• Running Time
• User Name
• Manager Name
• Phase
• Status

Top Scheduled Requests
• Request ID
• Program Name
• Program Short Name
• Request Start Date
• Scheduled to Run In (Minutes)
• User Name
• Manager Name
• Phase
• Status
Top Users (Requests Submitted)
- User Name
- Number of Requests

Users by Pending Requests
- User Name
- Number of Pending Requests

Users by Running Requests
- User Name
- Number of Running Requests

Setting Long Running and Long Pending Requests Parameters for Metrics and Incidents
Oracle Application Management Pack for Oracle E-Business Suite allows you to define parameters for long running and long pending requests. Follow the procedure below to do so.

1. From the Concurrent Processing Dashboard, add a custom concurrent program or concurrent manager target.

2. For the custom target, enter in values for these fields:
   - Long Pending Request Threshold in Minutes
   - Long Running Request Threshold in Minutes
   - Long Running Tolerance Percentage

The three parameters above are instance parameters for categorizing a request as long running or long pending.

A request will be considered long pending if it is pending for more than the "Long Pending Threshold in Minutes" value.

A request will be considered long running if it runs for more than the "Long Running Request Threshold in Minutes" value AND for longer than \((1 + 0.01\cdot[\text{Long Running Tolerance Percentage}][\text{Average Running Time of the Concurrent Program}])\).

3. After you have set these parameters, you can go to the All Metrics page to see these categories listed. Navigate to the All Metrics page by navigating to the Target
Menu, selecting Monitoring, then selecting All Metrics.

For Long Pending Requests, the following details are available through drilling down:

- Request ID
- Concurrent Program Short Name
- Concurrent Program Name
- Request Start Date
- Username
- Phase
- Status
- Pending Time
- Concurrent Manager

For Long Running Requests, the following are available through drilling down:

- Request ID
- Concurrent Program Short Name
- Concurrent Program Name
- Request Start Date
- Username
- Phase
- Status
- Running Time
- Concurrent Manager

For Long Running and Long Pending Requests, you can drill down to get a count for each.

4. On the same All Metrics page, click on Metric and Policy Settings to edit the incident threshold for long pending and long running requests. Choose to view "All Metrics" from the View dropdown list and set the incidents count for Long Pending Requests and Long Running Requests.
Monitoring Concurrent Requests in a Blocked State

The metric **Concurrent Requests in Blocked State** for the target **Oracle Concurrent Manager** is used to collect information on requests that are in blocked state and raise incidents for requests where the requests are blocked for specified period of time. This metric is shipped without threshold time period; so to use this metric, you must provide the threshold time in minutes. This metric is also available for the target **Custom Oracle Concurrent Manager** which collect information of blocked concurrent requests which are specific to a Concurrent Manager.

---

Monitoring Capacity Utilization of Concurrent Managers

The metric **Capacity Utilization of Concurrent Managers** for the target **Oracle Concurrent Manager** is used to collect information on the utilized capacity for each manager type, and raise an incident when the utilized capacity is below a threshold value. This metric is shipped without a capacity threshold value, so to use this metric, you must provide a capacity utilization threshold in a percentage. This metric is also available for the target **Custom Oracle Concurrent Manager** which collect information about the capacity utilization of the specific concurrent manager.
Monitoring Unscheduled Requests

The metric **Unscheduled Requests** for the target **Custom Oracle Concurrent Program** is used to collect the number of the requests unscheduled for a concurrent program and raise an incident if there is any unscheduled request for a concurrent program that is recommended to be scheduled. This metric is shipped without a threshold. You must set it to 0 to get alerts.
Monitoring Schedules for Requests

The metric **Monitor Schedule for Requests** for the target **Custom Oracle Concurrent Program** is used to collect the frequency with which a concurrent program request is scheduled (minutes, hours, days, or months) and raise an incident if it is not scheduled as per best practices. This metric is shipped without a threshold time period, so you must provide the threshold time in minutes, hours, days, or months.
Oracle E-Business Suite Summary on the Exalogic Dashboard

You can add an Oracle E-Business Suite Summary region for instances running on Exalogic machines to enable monitoring for these instances.

This region contains:

- A pie graph for consolidated status of Oracle E-Business Suite targets.

- A summary table that shows name of the Oracle E-Business Suite instance, status, incidents, configured components, service, compliance violations.
To add an Oracle E-Business Suite summary region on the Exalogic dashboard, perform the following steps:

1. Click on the global menu Targets > Exalogic. The landing page with all the discovered Exalogic instances should be displayed.

2. Click on any instance. The Exalogic dashboard should be displayed.

3. Click on the personalization page icon. The page should become editable.
4. Click on the **Add Content** button for a list of available regions. Click the Add icon for Oracle E-Business Suite Instances to add the region.
5. Click Close to exit the editable page.

To remove the Oracle E-Business Suite summary region from the Exalogic dashboard, click on the personalization page icon, and the page should become editable. Click on the cross icon (X) on the top right side of the region to remove the Oracle E-Business Suite summary region.

To change the location of the Oracle E-Business Suite summary region, click on the View Action Menu icon on the top right side of the region and click Move Up/Move Down to rearrange the region on the Exalogic dashboard.

**End To End Performance Monitoring with RUEI and JVMD**

AMP now integrates seamlessly with RUEI and JVMD for monitoring performance of
transactions. Real User Experience Insight (RUEI) understands how users are interacting with your product. Using the measurements that RUEI collects, you can assess the effectiveness of user interface design, the responsiveness of web servers and the internet, and the success of user operations. Java Virtual Machine Diagnostics (JVMD) looks at the finest details of code execution and to identify problems like race conditions, blocked threads, and memory leaks. To learn more about RUEI and JVMD, see Part VI - Monitoring Application Performance of Oracle Enterprise Manager Cloud Control Getting Started with Oracle Fusion Middleware Management Plug-in.

Supported Oracle E-Business Suite Versions

This feature works only for Oracle E-Business Suite Release 12.2 and above, where the middle tier is deployed on the WebLogic Server.

Prerequisites

- **Discover the Oracle E-Business Suite instance** - To do end to end monitoring first discover the Oracle E-Business Suite instance in AMP

- **Install Java Virtual Machine Diagnostics** - Deploy the JVMD Manager (JVM Diagnostics Engine) in Enterprise Manager. For information, see “Installing JVM Diagnostics” in Oracle Enterprise Manager Cloud Control Basic Installation Guide.

- **Deploy JVMD Agent on the WLS server of the Oracle E-Business Suite instance** - For information, see “Installing JVM Diagnostics” in Oracle Enterprise Manager Cloud Control Basic Installation Guide.

- **Register the Oracle E-Business Suite Database with JVMD** - After the JVMD agent is deployed on the respective Oracle E-Business Suite application server, and once it is ready to diagnose JVM issues, then you need to register the database of the relevant Oracle E-Business Suite with the JVMD engine. This step is required in order to navigate to the database diagnostics page from JVMD pages.
  - Navigate to Setup > Middleware Management > Application Performance Management.
  - Select the row JVM Diagnostics Engines and click on Configure.
  - Click on the Register Databases tab.
  - Click on Add Database Instance, and select the respective Oracle E-Business Suite database instance and click on Select.

- **Install Real User Experience Insight** - For information, see the Oracle Real User Experience Insight Installation Guide.
Setting up End to End Monitoring

Configure Oracle E-Business Suite in RUEI:
Real User Experience Insight can be configured to support drilling down to JVM Diagnostics. For example, if a page is taking too much time to load, RUEI will detect it. You can then drill down from RUEI to JVMD and find out the root cause of why the page is hanging.

1. Log in to RUEI.

2. Navigate to Configuration > Applications > Suites.

4. Enter a suite name. This is the name that can be used to uniquely identify an Oracle E-Business Suite in RUEI. Provide any name that uniquely defines the Oracle E-Business Suite instance being configured.

5. Provide the domain name and port of the Oracle E-Business Suite applications URL in the Find Domain and Find Port fields. For instance, if http://domain.abc.com:8080/AppsLogin is your Oracle E-Business Suite applications URL, “domain.abc.com” will be the domain field value and 8080 will be the port field value.

6. Enter "*" in the Find in URL field. This entry means that any request to the Oracle E-Business Suite applications URL will be monitored. Alternatively, you can provide some patterns so that only those URLs that match the given pattern will be monitored. Click Next.

7. Enter "E-Business Suite" as the Suite Type and click Finish. The newly-created suite appears on the page.

8. Click on the created suite name.

9. Click on the Advanced tab.

10. Click on Enterprise Manager subtab.

11. Click on ‘n/a’ for Enterprise name. In the name field, provide the name of the Oracle E-Business Suite instance that is discovered in Enterprise Manager where you want to drill down to JVMD or the Oracle E-Business Suite search user sessions pages. For example, "tst1223_Oracle E-Business Suite".
Configure Protocols:


2. Based on the Oracle E-Business Suite instance protocol (http/https), click on the respective protocol and provide/add the respective port on which Oracle E-Business Suite is up and running. You can also provide the port on which forms are running in the respective protocols.

Configure Link for RUEI to EM:

In diagnosing an issue in RUEI, it is possible to drill down to JVM Diagnostics in Enterprise Manager, if the EM instance is linked to RUEI. Use these steps to link RUEI to EM:

1. Click on Configuration > General > Advanced settings > Clickout Settings. Click on Add new clickout setting.
2. Select the version of Enterprise Manager in the clickout tool list.

3. Provide host and port values of the Enterprise Manager instance.

4. Click on Advanced. Provide the protocol (http/https).
5. Click on Save.

6. After linking, you should be able to see the link "Inspect in Enterprise Manager" when right‐mouse‐clicking on any session activity in the Browse data tab.

**Analyzing a Performance Issue**

1. Log in to RUEI screen and click on Browse data tab.
2. Select the date on the left hand side to filter the data accordingly. Select E-Business (Forms) from the dropdown list below Applications tab.

3. Click on the Session diagnostics tab below the list mentioned in the above step.

4. Select the EBS suite name configured in section "Configure Oracle E-Business Suite in RUEI" from the Application drop down. If you are trying to search for sessions of a specific user ID, EBS responsibility ID, or ECID, select the values accordingly from the respective drop down fields. Not all values need to be selected for each dropdown list to perform the search.

5. Click on Search.
6. Click on a session link.
7. Multiple session activities are displayed. Check the Info column. A red-colored icon identifies that the session activity ended with some error or is hanging.
8. Right click on that session activity, click on Inspect in EM 12C > Trace JVM request.
9. This will take you to EM screen where after logging in, you will be taken to JVMD screen directly based on the failed session activity’s ECID.

Drilling down from RUEI to AMP

You can drill down to AMP from RUEI to monitor user sessions.

Configure Link for RUEI to drill down to AMP:
1. Navigate to Configuration > General > Advanced settings > Clickout Settings.
   Click on Add New Clickout Setting.
2. Select E-Business Suite Diagnostics in the clickout tool list.
3. Provide host and port values of the Enterprise Manager instance.
4. Click on Advanced and provide the protocol (http/https).
5. Click on Save.
6. After creating this link, you should be able to see the link Inspect in EBS Diagnostics when you right-mouse-click on any session activity in Browse data.
Monitoring User Sessions by drilling down from RUEI:

Once the Inspect in EBS Diagnostics link is available, select the child menu User Search to drill down to AMP. You will see the active sessions of the Oracle E-Business Suite user like Concurrent Processing (CP), Forms, and Oracle Application Framework (OAF) sessions. You can drill down to each session to get the details.

Custom Metrics

You can create custom metrics in case if it is not covered by the metrics shipped out of the box.

1. Navigate to Enterprise > Monitoring > Metric Extensions.
2. Click Create > Metric Extension.
3. Select Applicable to as Oracle E-Business Suite.
4. Select Adapter as SQL.
5. Define the query. Define columns in next step.
6. Add any target and test. Query will hit this EBS target.
7. Submit.
8. Select the metric you created, Actions > Save As Deployable Draft.
9. Select the metric you created, Actions > Publish Metric Extension.

10. Select the metric you created, Actions > Deploy to Targets.

11. Select any target and deploy.

For more details, see "Using Metric Extensions" in Oracle Enterprise Manager Cloud Control Administrator’s Guide.

**Custom Compliance Rules**

Follow these steps to create custom compliance rules.

1. Navigate to Enterprise > Compliance > Library.

2. Create > Repository Rule.


4. Define Query, violation condition and other details.

5. Make sure that query has target_guid as the first column.

6. Click Test and Submit.

7. Now you can map this rule to a custom standard and then the custom standard to a custom framework.

   Please note System defined compliance objects are non-editable. So you cannot map any compliance object to any System defined compliance object. However you can use Create Like to create a copy of System defined object and then edit that.

8. You can always edit a custom compliance object and map rule to standard, standard to framework.

For more details, see "Managing Compliance" in Oracle Enterprise Manager Lifecycle Management Administrator’s Guide.

**Administration of Oracle E-Business Suite**

**Starting and Stopping Services**

You can start and stop the components running on each node using the Administration menu. Select Administration > Start and Stop Services from the target menu. All the application nodes will be shown with the targets running in them. You can select individual target or a node (which means you are selecting all targets running on that node) and start or stop it. ICM does not show up under a specific node because we can
start and stop it from any node where it is enabled. If the Oracle E-Business Suite instance features Online Patching, only run editions targets will be shown.

Jobs will be submitted to start and stop services. The details and status of these jobs can be tracked through standard Enterprise Manager Job screens.

**Note:** For Oracle E-Business Suite Release 12.2, you cannot perform any action if a cutover is detected.

---

**Privileges need to start and stop services**

An administrator must have the EM_ALL_ADMINISTRATOR role to run the jobs to start and stop components. In addition, an administrator must have the "Start and Stop Services" privilege to start and stop services.

For more information on privileges and roles, see: link: Privileges and Roles for Managing Oracle E-Business Suite, page 7-1.
Credentials that must be set to start and stop services

- The preferred credential must be set for Oracle E-Business Suite node for the credential set OS Credentials.

- The preferred credential must be set for Oracle E-Business Suite for the credential set AppsDBCredsSet.

For more information on preferred credentials, see: Setting Oracle E-Business Suite Preferred Credentials, page 5-1.

Manual Synchronization of Editions

If the Oracle E-Business Suite instance features online patching, it is now possible to manually synchronize the edition details from UI. This comes handy if the corrective actions fail due to some reason resulting in the system considering the wrong edition as the run edition. Navigate to Administration > Synchronize Edition Details in the target menu.

This will submit a job equivalent to the corrective actions. This job will gracefully exit if the editions details are already in sync or if a corrective action is in progress. The same
UI will also show the details of previous attempts to manually sync the edition details.

**Privilege Propagation with Administration Groups**

An administration group in Enterprise Manager is a special kind of group wherein the target members can be added automatically based on certain target properties of the members. If an administration group is defined with some specifications, and if some target’s properties match those specifications, then the target is automatically added to the administration group without manual intervention. When a target is added to the group, Enterprise Manager applies settings using a template collection consisting of monitoring templates, compliance standards, and so on. This completely eliminates the need for administrator intervention. Administration groups are privilege propagating. A privilege defined for an aggregate target is also set for all the member targets of that aggregate. Thus, for a target to be part of any administration group, it must be privilege propagating; otherwise the privileges cannot be set for its members. Beginning with Release 12.1.0.3.0, the following targets are privilege propagating.

- Oracle E-Business Suite
- Oracle Application Service

For more information on administration groups in Enterprise Manager, see the *Oracle Enterprise Manager Cloud Control Administrator’s Guide*.

**Important:** To use this functionality, an administrator must have both Full Any Target and Create Privilege Propagating Group target privileges to be able to create an Administration Group.

**Creating an administration group in Enterprise Manager**

1. From the Enterprise Manager console, navigate to Targets.
2. From the list, choose Groups.
3. Select Create on the left side.
4. Select Administration Group from the list.
5. Define the Administration Group’s target properties. Choose one or more target properties by clicking on Add in Hierarchy Levels table.
6. Specify the target property value(s) by adding in the Hierarchy Nodes table.
7. Click Create to save your work and create the group.
Adding targets as members of an administration group

Once an administration group is created, members can be added by specifying member properties as that are of the group. For an Oracle E-Business Suite instance, the following steps are used to set the target properties.

1. Navigate to Targets from the Enterprise Manager console.

2. From the list, choose Oracle E-Business Suite.

3. Select an instance by clicking on it.

4. From the target menu, choose Target Setup.

5. Select Properties.

6. Set the target property value to one of the values specified in the Administration Group page by clicking on the **Edit** button.

7. To save, click **OK**.

8. To view the Administration group members, go back to Targets and then Groups.

You can now see the Oracle E-Business Suite instance and members added to the administration group created earlier and also in the corresponding subgroup based on the value of target property chosen.

Example

In this example, we have created an administration group with two subgroups corresponding to Production and Development lifecycle statuses.
We set the Lifecycle status of an Oracle E-Business Suite instance to Production.
The Oracle E-Business Suite target members are added to the group automatically and to the Production level as shown in the figure below.
This chapter covers the following topics:

- Settings to Monitor Oracle E-Business Suite

**Settings to Monitor Oracle E-Business Suite**

You can change the configuration with which each Oracle E-Business Suite instance is monitored. You can do two things

- Change monitoring schema

- Change the availability definition of the Oracle E-Business Suite instance

To configure monitoring, go the Oracle E-Business Suite Management page. Select the Oracle E-Business Suite instance and click **Configure**.

### Changing the monitoring schema

After clicking the Configure button, you can change the details of the monitoring schema. You can either change the user name or password here and click **Next** or directly proceed to change the availability computation by clicking **Next**.
Extending the Oracle E-Business Suite Target Model

The status of the Oracle E-Business Suite target is determined by the status of its member targets. It uses AND logic, means all the members must be up for the Oracle E-Business Suite target to be up. Customers can add more targets or removing existing targets.

Note: In Release 12.1.0.3.0, the AMP availability computation matches the Enterprise Manager computation so that the same status is shown across all pages. The "Partially Up" status is retired now.

Viewing the existing availability definition

Navigate to Targets (menu) > Oracle E-Business Suite. From the Oracle E-Business Suite Management page, select an instance and click Configure. After specifying parameters, click Next to go to the Availability Definition page.

You can see all the targets being used to evaluate the status.

You can select a specific target type.
You can also search with a target name.

**Changing the availability definition**

In the above UI, check the targets you wish to include in the availability computation. Un-check a target if you want to exclude it. Click on the **Add Target** button to add any other target which is not part of the Oracle E-Business Suite hierarchy like SSO, LDAP, Load Balancer, and so on. Then click **Next**. Review the availability computation summary and click **Submit** to save your changes.
If the Oracle E-Business Suite instance features online patching, only run edition targets are shown in the UI. If you remove the current run edition target from the availability computation, the corresponding patch edition target will also be removed so that it works seamlessly once a cutover happens. The summary page where you can review the availability computation shows the details of the run edition and patch edition targets that are affected.

**Adding or Removing an Oracle E-Business Suite Node**

If you add or remove a node as part of availability definition, all its child members will also be added or removed.

**Targets that cannot be removed as part of availability configuration**

You cannot remove the database, database node, or the WLS Admin server from availability definition.
This chapter covers the following topics:

- Diagnosing Issues using Pack Diagnostics
- Diagnostic Tests for Cloning
- Diagnostic Tests for Patch Manager
- Diagnostic Tests for Customization Manager
- Diagnostic Tests for User Monitoring

### Diagnosing Issues using Pack Diagnostics

**Pack Diagnostics**

Oracle Application Management Pack for Oracle E-Business Suite includes a diagnostics feature which can be used to troubleshoot issues by running diagnostic tests. The tests are grouped into the modules listed below.

- Cloning
- Patch Manager
- Customization Manager
- User Monitoring

To navigate to the diagnostics module, select Pack Diagnostics from the Administer menu in the Oracle E-Business Suite Management page.
How to run a diagnostic test

To execute a diagnostic test, click on the Create button. This will take you to the page where you must provide the details to do the diagnosis. You must enter the following details:

**Diagnostic Test Details**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique name to identify this instance of execution. This name can be later used to search for this instance of execution.</td>
</tr>
<tr>
<td>Module</td>
<td>You can select a specific module or all modules. When you select a module, all tests for that module will be run.</td>
</tr>
</tbody>
</table>
| Show Details| You can select the extent of detail you want in the final report.  
  • All - This option logs all information regardless of whether the diagnostic test completes with success or error.  
  • Error - This option only logs details for those tests that error out. |
Diagnosing Issues

Field Description

<table>
<thead>
<tr>
<th>Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generic</td>
<td>Select this option to perform a health check of a specific module.</td>
</tr>
<tr>
<td>User Specific</td>
<td>Select this option to diagnose issues faced by the current logged-in user in a specific module.</td>
</tr>
</tbody>
</table>

Description Optional description for this instance of the execution.

You must add the Oracle E-Business Suite instance against which the diagnostic test will be executed. You can add multiple Oracle E-Business Suite instances. Click on the Add button in the Targets section. A list of values will pop up with the list of all the Oracle E-Business Suite instances discovered, and you can select the needed Oracle E-Business Suite instances. Once you are done with the selection, click the Submit button.

A job to run the tests is submitted, and the status column in the Requests table will show the status of the execution. You can refresh the page to get the latest status. You can click on the Status column to drill down further to see a detailed report of the execution. Expand the hierarchical table by clicking Expand All. There will be Tasks and Steps. Click on the status column of each step to get the detailed report for that step.

**Search for a test execution**

The pack diagnostics page by default list the name and other details of recent executions. You can search for any execution by its name.

**Executing a test again**

You can rerun an instance of execution without entering the details again. Search for that instance. Select it and click on the Retest button.

**Diagnostic Tests for Cloning**

You should run diagnostic tests on your system in preparation for the cloning procedures to ensure your system is set up properly. These tests can be accessed from the Diagnostics dashboard, available from the Pack Diagnostics link on the Oracle Applications page. For more information on running diagnostic tests, see: Running Pack Diagnostics Tests, page 10-1.

The following tables list tests related to cloning.
### Generic Diagnostics Tests for Cloning

<table>
<thead>
<tr>
<th>Step</th>
<th>Severity</th>
<th>Test Description</th>
<th>Notes/Expected Results/Corrective Measures</th>
</tr>
</thead>
<tbody>
<tr>
<td>EBS</td>
<td>Warning</td>
<td>Check if EBS has Shared File System</td>
<td>Check if the Oracle E-Business Suite is a multi-node applications tier with a shared file system configured. Expected results: Yes/No. This is an informational message. If the shared file system is enabled and the result is No, please check 's_atname' to find out if all the nodes are consistent. Name of Command: CheckIfSFS</td>
</tr>
<tr>
<td>EBS</td>
<td>Critical</td>
<td>Check if AutoConfig is run on Database Tier</td>
<td>Verify if AutoConfig has been run on the database tier. For cloning to work, it is mandatory that AutoConfig was successfully run on the source database tier. Name of Command: CheckIfAutoConfigIsRun</td>
</tr>
<tr>
<td>EBS</td>
<td>Critical</td>
<td>Check If AutoConfig Is Run on Applications Tier</td>
<td>Verify if AutoConfig has been run on the applications tier. For Cloning to work, it is mandatory that AutoConfig was successfully run on the source applications tier. Name of Command: CheckIfAutoConfigIsRun</td>
</tr>
<tr>
<td>Step</td>
<td>Severity</td>
<td>Test</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>----------</td>
<td>-----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>EBS</td>
<td>Warning</td>
<td>Get the Database Tier Operating System User Name</td>
<td>Get the O/S User Name for the database tier.</td>
</tr>
<tr>
<td>EBS</td>
<td>Warning</td>
<td>Get Agent Perl Version</td>
<td>Verify Agent Perl utility version.</td>
</tr>
<tr>
<td>Step</td>
<td>Severity</td>
<td>Test</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>----------</td>
<td>------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| EBS  | Warning  | Get key environment variables for Database Context | Obtain key environment variables for Database Context, including:  
  - PATH  
  - LD_LIBRARY_PATH  
  - LIBPATH  
  - SHLIB_PATH  
  - ORACLE_HOME  
  - ORACLE_SID  
  - PERL5LIB  
  - TNS_ADMIN | Certain database context variables of the source Oracle E-Business Suite instance need to be definitively set with non-null values for the cloning job to proceed successfully. If this diagnostic test fails, run AutoConfig on the database tier so that the correct environment file is generated again. The values in the environment file are used in this command.  
  Name of Command: GetEnvironmentVariableValues |
| EBS  | Warning  | Get the APPS tier Operating System User Name | Get the O/S User Name for the applications tier. | If this diagnostic test fails, rerun AutoConfig on the applications tier.  
  AutoConfig should populate the 's.appsuser' variable in the applications tier context file correctly.  
  Name of Command: GetAppsOSUserInfo |
<table>
<thead>
<tr>
<th>Step</th>
<th>Severity</th>
<th>Test</th>
<th>Description</th>
<th>Notes/Expected Results/Corrective Measures</th>
</tr>
</thead>
</table>
| EBS    | Warning  | Get key information required for Apps Context Configvariables | Obtain key environment variables for the applications context, including:  
|        |          | s_base  
|        |          | s_dbuser  
|        |          | s_dbgroup  
|        |          | s_appuser  
|        |          | s_appsgroup  
|        |          | s_dbport  
|        |          | s_port_pool  
|        |          | s_config_home  
|        |          | s_atName  
|        |          | s_hostname | Certain applications context variables of the source Oracle E-Business Suite instance need to be definitively set with non-null values for the clone job to proceed successfully. If this diagnostic test fails, run AutoConfig on the applications tier so that the correct environment file is generated again. The values in the environment file are used in this command.  
|        |          |                                                      | Name of Command: GetAPPSConfigVariables |
| EBS    | Critical | CheckIOPatches for <Oracle E-Business Suite Release Name> | Verify that certain patches have been applied on the Oracle E-Business Suite target.  
|        |          |                                                      | Certain I/O patches need to be definitively run on the Oracle E-Business Suite instance for some of the clone flows to work successfully. Note that this step may change – depending on the Oracle E-Business Suite release (for example, 11i, 12.0, and so on). The list of patches is contained in an XML file that might be modified to include or exclude recommended patches.  
<p>|        |          |                                                      | Name of Command: CheckEBSUpdates |</p>
<table>
<thead>
<tr>
<th>Step</th>
<th>Severity</th>
<th>Test</th>
<th>Description</th>
<th>Notes/Expected Results/Corrective Measures</th>
</tr>
</thead>
<tbody>
<tr>
<td>EBS</td>
<td>Critical</td>
<td>Get EBS Perl Version</td>
<td>Check Oracle E-Business Suite Perl utility version.</td>
<td>Cloning using the management pack requires Oracle E-Business Suite Perl utilities to be at a certain version level for certain cloning flows to function properly. Please make sure that the Perl version on the Oracle E-Business Suite instance is compatible with that in the Agent (see related diagnostic test for the Agent Perl Version).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Name of Command: CheckEBSPerlVersion</td>
</tr>
<tr>
<td>EBS</td>
<td>Critical</td>
<td>Check if AutoConfig is run on Applications Tier</td>
<td>Verify if AutoConfig has been run on the applications tier.</td>
<td>It is mandatory that AutoConfig completed successfully on the source applications tier for cloning to work.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Name of Command: CheckIfAutoConfigIsRun</td>
</tr>
<tr>
<td>EBS</td>
<td>Warning</td>
<td>Get information for key Database Context Config variable</td>
<td>Obtain key database context variables that are required for non-“Smart Clone” cloning procedures, including: s_base s_dbuser s_dgroup s_appssuser s_appsuser s_appsgroup s_dbport s_port_pool s_hostname</td>
<td>Certain database context variables of the source Oracle E-Business Suite instance need to be set with non-null values for the clone jobs to finish successfully. If this diagnostic test fails, rerun AutoConfig on the database tier.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Name of Command: GetDBConfigVariables</td>
</tr>
<tr>
<td>Step</td>
<td>Severity</td>
<td>Test</td>
<td>Description</td>
<td>Notes/Expected Results/Corrective Measures</td>
</tr>
<tr>
<td>------</td>
<td>----------</td>
<td>------</td>
<td>-------------</td>
<td>-------------------------------------------</td>
</tr>
<tr>
<td>EBS</td>
<td>Warning</td>
<td>Get key environment variables for Application Context</td>
<td>Obtain key environment variables for the applications context, including: PATH LD_LIBRARY_PATH LIBPATH SHLIB_PATH ORACLE_HOME ORACLE_SID PERL5LIB TNS_ADMIN</td>
<td>If this diagnostic test fails, rerun AutoConfig on the applications tier. Name of Command: GetEnvironmentVariableValues</td>
</tr>
<tr>
<td>EBS</td>
<td>Warning</td>
<td>Checks if Oracle E-Business Suite AD Snapshot is valid</td>
<td>Verify if the Oracle E-Business Suite AD snapshot is valid.</td>
<td>In order to perform a &quot;scale-down clone&quot; process (that is, a multi-node source applications tier instance which has non-shared APPL_TOPs to a unified APPL_TOP in the target), AMP needs to ensure that the snapshots for the source APPL_TOPs have been updated properly. Make sure the Maintain &quot;Update Current View Snapshots&quot; option in adadmin is run at least once after the Oracle E-Business Suite creation. Name of Command: CheckIfADSnapshotIsValid</td>
</tr>
<tr>
<td>EBS</td>
<td>Summary</td>
<td></td>
<td>A summary of all of the diagnostic tests that have been executed, in the following groups: Successful, Failed, With Warning, Aborted, and Total.</td>
<td></td>
</tr>
</tbody>
</table>
### User-Specific Tests for Cloning

<table>
<thead>
<tr>
<th>Step</th>
<th>Severity</th>
<th>Test Description</th>
<th>Notes/Expected Results/Corrective Measures</th>
</tr>
</thead>
<tbody>
<tr>
<td>EBS</td>
<td>Warning</td>
<td>Check Host Credential for Smart Clone flows</td>
<td>If this diagnostic test fails, set the applications context operating system credentials in the &quot;Oracle E-Business Suite Node&quot; target type in the preferred credential store. Name of Command: CheckAppsContextCredentialExistence</td>
</tr>
<tr>
<td>EBS</td>
<td></td>
<td>Check Database schema credentials for Smart clone flows</td>
<td>The database APPS schema credentials must be entered manually with Smart Clone flows.</td>
</tr>
<tr>
<td>EBS</td>
<td></td>
<td>Summary</td>
<td>A summary of all of the diagnostic tests that have been executed, in the following groups: Successful, Failed, With Warning, Aborted, and Total.</td>
</tr>
</tbody>
</table>

### Diagnostic Tests for Patch Manager

You should run diagnostic tests on your system in preparation for running Patch Manager procedures to ensure your system is set up correctly. These tests can be accessed from the Diagnostics dashboard, available from the Pack Diagnostics link on the Oracle Applications page. For more information on running diagnostic tests, see: Running Pack Diagnostics Tests, page 10-1.

The following tables list tests related to Patch Manager:
### Generic Diagnostic Tests for Patch Manager

<table>
<thead>
<tr>
<th>Step</th>
<th>Test Group</th>
<th>Description</th>
<th>Notes/Expected Results/Corrective Measures</th>
</tr>
</thead>
<tbody>
<tr>
<td>EM GC</td>
<td>Check permissions for OMS Stage directory</td>
<td>Determine if a stage directory is defined on the OMS. Determine if the owner has read/write permissions to that directory.</td>
<td>Expected results are: the OMS Stage Directory Location, with the OMS user with read/write permissions.</td>
</tr>
<tr>
<td>EM GC</td>
<td>Check Patch Manager Stage directories</td>
<td>Verify if the properties set in the Preferences page have proper definitions for Patch Manager Stage directories</td>
<td>Refer to Running a Patching Procedure, page 13-14 for instructions on completing this step.</td>
</tr>
<tr>
<td>EM GC</td>
<td>Summary</td>
<td>A summary of all of the diagnostic tests that have been executed, in the following groups: Successful, Failed, With Warning, Aborted, and Total.</td>
<td></td>
</tr>
<tr>
<td>EBS</td>
<td>Check if EBS Snapshot in OMS Repository is valid</td>
<td>Verify if the Oracle E-Business Suite snapshot in OMS Repository is valid.</td>
<td>A snapshot shows data about a system for a point in time. If the snapshot is invalid, navigate to the Targets menu &gt; Oracle E-Business Suite and click on the instance name. Then navigate to the Oracle E-Business Suite menu (in the top left corner) &gt; Configuration &gt; Last Collected &gt; Actions &gt; Refresh.</td>
</tr>
<tr>
<td>EBS</td>
<td>Check for EBS CPU Count</td>
<td>Verify that the target Oracle E-Business Suite system’s CPU Count is greater than zero (0).</td>
<td>If there is not a valid snapshot, contact Oracle Support.</td>
</tr>
<tr>
<td>EBS</td>
<td>Summary</td>
<td>A summary of all of the diagnostic tests that have been executed, in the following groups: Successful, Failed, With Warning, Aborted, and Total.</td>
<td></td>
</tr>
</tbody>
</table>
### User-Specific Diagnostic Tests for Patch Manager

<table>
<thead>
<tr>
<th>Step</th>
<th>Test Group</th>
<th>Description</th>
<th>Notes/Expected Results/Corrective Measures</th>
</tr>
</thead>
<tbody>
<tr>
<td>EM</td>
<td>CheckMetalinkCredentials</td>
<td>Verify if username/password credentials are entered for My Oracle Support.</td>
<td>Refer to the Oracle Enterprise Manager documentation for instructions on completing this step.</td>
</tr>
<tr>
<td>EM</td>
<td>CheckPrivilege</td>
<td>Check if the user currently logged in has authority to patch any instances.</td>
<td></td>
</tr>
<tr>
<td>EM</td>
<td>Summary</td>
<td>A summary of all of the diagnostic tests that have been executed, in the following groups: Successful, Failed, With Warning, Aborted, and Total.</td>
<td></td>
</tr>
<tr>
<td>EBS</td>
<td>Check if Preferred Credentials exist</td>
<td>Check if the EM User has the required Preferred Credential set for APPS and SYSTEM schema users in &quot;Oracle E-Business Suite&quot; target type. Check if that user has the required Preferred Credentials for &quot;Oracle E-Business Suite Node&quot; target type for Database Context and for APPL_TOP Context.</td>
<td></td>
</tr>
<tr>
<td>EBS</td>
<td>Summary</td>
<td>A summary of all of the diagnostic tests that have been executed, in the following groups: Successful, Failed, With Warning, Aborted, and Total.</td>
<td></td>
</tr>
</tbody>
</table>

### Diagnostic Tests for Customization Manager

You should run diagnostic tests on your system in preparation for using Customization Manager to ensure your system is set up correctly. These tests can be accessed from the Diagnostics dashboard, available from the Pack Diagnostics link on the Oracle Applications page. For more information on running diagnostic tests, see: Running Pack Diagnostics Tests, page 10-1.

The following tables list tests related to Customization Manager:
<table>
<thead>
<tr>
<th>Step</th>
<th>Test Group</th>
<th>Description</th>
<th>Notes/Expected Results/Corrective Measures</th>
</tr>
</thead>
<tbody>
<tr>
<td>EM</td>
<td>CheckOMSSstage</td>
<td>Determine if a stage directory is defined on the OMS. Determine if the owner of the directory has read/write permissions to that directory.</td>
<td>Expected results are: the OMS Stage Directory Location and the OMS user with read/write permissions.</td>
</tr>
<tr>
<td>EM</td>
<td>Summary</td>
<td>A summary of all of the diagnostic tests that have been executed, in the following groups: Successful, Failed, With Warning, Aborted, and Total.</td>
<td></td>
</tr>
<tr>
<td>EBS</td>
<td>CheckEBSHome</td>
<td>Verify permissions for APPL_TOP.</td>
<td>Verify that the user running the diagnostic test has the correct permissions for the APPL_TOP directory structure. If the test fails, provide the correct Preferred Credentials information in &quot;E-Business Suite&quot; or &quot;E-Business Suite Node&quot;. See: Setting Up Credentials, page 5-1.</td>
</tr>
<tr>
<td>EBS</td>
<td>CheckAgentHome</td>
<td>Verify permissions within the Agent home directory.</td>
<td>Verify that the user running the Diagnostic test has the correct permissions for the $AGENT_HOME directory structure. If the test fails, provide the correct Preferred Credentials information in &quot;E-Business Suite&quot; or &quot;E-Business Suite Node&quot;. See: Setting Up Credentials, page 5-1.</td>
</tr>
<tr>
<td>Step</td>
<td>Test Group</td>
<td>Description</td>
<td>Notes/Expected Results/Corrective Measures</td>
</tr>
<tr>
<td>------</td>
<td>------------</td>
<td>-------------</td>
<td>--------------------------------------------</td>
</tr>
<tr>
<td>EBS</td>
<td>Check Customization Manager related AD Patches for 11i Release</td>
<td>Verify that certain AD patches have been applied on the Oracle E-Business Suite target.</td>
<td>The set of required interoperability patches will vary for the different Oracle E-Business Suite releases (that is, Release 11i, Release 12, and so on). The list of patches is contained in an XML file that might be modified to include or exclude recommended patches. The file is located at: <code>&lt;OMS_HOME&gt;</code>\sysman\admin\emdrep\ebs\testsuites\CMTestSuite\e.xml</td>
</tr>
<tr>
<td>EBS</td>
<td>Check Customization Manager Patches for 11i Release</td>
<td>Verify that certain Customization Manager patches have been applied on the Oracle E-Business Suite target.</td>
<td>The set of required interoperability patches will vary for the different EBS releases (that is, Release 11i, Release 12, and so on). The list of patches is contained in an XML file that might be modified to include or exclude recommended patches. The file is located at: <code>&lt;OMS_HOME&gt;</code>\sysman\admin\emdrep\ebs\testsuites\CMTestSuite\e.xml</td>
</tr>
<tr>
<td>EBS</td>
<td>CheckAmpAc p</td>
<td>Verify that the Agent is patched with the latest Oracle E-Business Suite management pack release. The Application Management Pack and the Application Change Management Pack patches are required on both the OMS and Agents.</td>
<td>If the Agent is not at the appropriate release, then it will need to be installed or upgraded through Oracle Universal Installer.</td>
</tr>
<tr>
<td>EBS</td>
<td>GetAPPSConf igVariables</td>
<td>Check if the context property JDBC_URL is available.</td>
<td>The context variable JDBC_URL needs to be set with non-null values for the Customization Manager jobs to proceed successfully. If the test fails, wait until the metric collection occurs, or force evaluation of the metric collection explicitly</td>
</tr>
</tbody>
</table>
## Diagnosing Issues

<table>
<thead>
<tr>
<th>Step</th>
<th>Test Group</th>
<th>Description</th>
<th>Notes/Expected Results/Corrective Measures</th>
</tr>
</thead>
<tbody>
<tr>
<td>EM</td>
<td>Summary</td>
<td>A summary of all of the diagnostic tests that have been executed, in these groups: Successful, Failed, With Warning, Aborted, and Total.</td>
<td></td>
</tr>
<tr>
<td>GC</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### User-Specific Diagnostic Tests for Customization Manager

<table>
<thead>
<tr>
<th>Step</th>
<th>Test Group</th>
<th>Description</th>
<th>Notes/Expected Results/Corrective Measures</th>
</tr>
</thead>
<tbody>
<tr>
<td>EBS</td>
<td>Summary</td>
<td>A summary of all of the diagnostic tests that have been executed, in these groups: Successful, Failed, With Warning, Aborted, and Total.</td>
<td></td>
</tr>
</tbody>
</table>

### Diagnostic Tests for User Monitoring

The following table has details for generic tests for user monitoring.
### Generic Tests for User Monitoring

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Corrective Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>CheckIOPatches</td>
<td>Checks whether the mandatory interoperability patches needed for user monitoring are applied in this Oracle E-Business Suite instance.</td>
<td>Apply the mandatory interoperability patches in the Oracle E-Business Suite instance.</td>
</tr>
<tr>
<td>CheckRESTHealth</td>
<td>User monitoring uses REST services deployed on the Oracle E-Business Suite instance. This test checks if the REST services are accessible or not.</td>
<td>Check the error message in the report. Refer to the emoms.log for additional information.</td>
</tr>
<tr>
<td>CheckEBSProfile</td>
<td>Checks if the site-level profile Sign-On:Audit Level is set to 'FORM' in this Oracle E-Business Suite instance.</td>
<td>Set the site-level profile Sign-On:Audit Level to 'FORM'.</td>
</tr>
</tbody>
</table>

The following table lists user-specific tests for user monitoring.

### User-Specific Tests for User Monitoring

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Corrective Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>CheckEBSGlobalCred</td>
<td>Checks if the preferred credential is set for AppsUserCredsSet for this Oracle E-Business Suite instance.</td>
<td>Set the preferred credential.</td>
</tr>
<tr>
<td>CheckEBSRole</td>
<td>Checks if the Oracle E-Business Suite user, whose credential is set as the preferred credential for AppsUserCredsSet, has the LCM_EM_CLIENT responsibility in this Oracle E-Business Suite instance</td>
<td>Assign the LCM_EM_CLIENT responsibility to the Oracle E-Business Suite user.</td>
</tr>
</tbody>
</table>
Cloning an Oracle E-Business Suite System

This chapter covers the following topics:

• Cloning an Oracle E-Business Suite System
• Running a Single Node to Single Node or Multi Node to Single Node Cloning Procedure for Release 11i and 12.1.x
• Running Scale-Up and Scale-Down Multi-Node Cloning Procedures
• Running Multi Node to Multi Node or Single Node to Multi Node Cloning for Oracle E-Business Suite Release 12.2
• Adding Custom Steps to a Smart Clone Deployment Procedure

Cloning an Oracle E-Business Suite System

One of the key features of the Oracle Application Management Pack for Oracle E-Business Suite is the ability to clone an Oracle E-Business Suite system automatically using the Smart Clone procedure.

The key highlights of the cloning process include:

• The Oracle Application Management Pack for Oracle E-Business Suite allows Oracle E-Business Suite systems to be cloned using the Cloud Control provisioning framework.

• Cloud Control automates the creation of clone systems and executes any required application-specific actions.

• Cloning of systems deployed on Oracle Real Application Clusters (RAC) is possible. For more information, see the My Oracle Support Knowledge Documents listed later in this section.
Smart Clone

Smart Clone expects, as a prerequisite, the target Oracle E-Business Suite database to be cloned and discovered in the Enterprise Manager. In doing so, customers can choose their own options in creating the target Oracle E-Business Suite database by cloning from the source Oracle E-Business Suite database using the Database Plug-in Provisioning Pack, RMAN, a storage system solution, or so on; whichever suits their needs the best. Smart Clone starts with taking the discovered target database as an input to configure a database target and then clones the applications tier of the source instance. It then applies that to the target Oracle E-Business Suite system.

Smart Clone supports the following scenarios for Release 11i and Release 12.x:

- Configuring single instance databases
- Configuring RAC databases
  - Customizing the listener names is supported if you have the required Oracle E-Business Suite patches applied.
  - Configuring listeners with SCAN IPs is supported if both the database version and the cluster version are greater than 11.2.0.2

The following table lists the details of use cases and their supported releases of Oracle E-Business Suite:

<table>
<thead>
<tr>
<th>Use Case</th>
<th>Source Oracle E-Business Suite Instance</th>
<th>Target Oracle E-Business Suite Instance</th>
<th>Releases Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>1A</td>
<td>Single Apps Node configured with Single Instance DB or RAC DB</td>
<td>Single Apps Node configured with Single Instance DB or RAC DB</td>
<td>11i, 12.0, 12.1, 12.2</td>
</tr>
<tr>
<td>1B</td>
<td>Single Apps Node configured with Single Instance DB or RAC DB</td>
<td>Multi Apps Node (with or without Shared File System) configured with Single Instance DB or RAC DB</td>
<td>12.0, 12.1, 12.2</td>
</tr>
<tr>
<td>2A</td>
<td>Multi Apps Node (with or without Shared File System) configured with Single Instance DB or RAC DB</td>
<td>Single Apps Node configured with Single Instance DB or RAC DB</td>
<td>11i, 12.0, 12.1, 12.2</td>
</tr>
</tbody>
</table>
Use Case | Source Oracle E-Business Suite Instance | Target Oracle E-Business Suite Instance | Releases Supported
--- | --- | --- | ---
2B | Multi Apps Node (with or without Shared File System) configured with Single Instance DB or RAC DB | Multi Apps Node (with or without Shared File System) configured with Single Instance DB or RAC DB | 12.0, 12.1, 12.2 (For Release 12.2, see note below)

In addition to the above features, the following scenarios are supported:

- As soon as Oracle E-Business Suite announces the certification on any database version with Oracle E-Business Suite, then the Oracle Application Management Pack for Oracle E-Business Suite (Release 12.1.0.3.0) customers should be able to use the Smart Clone deployment procedure immediately for Oracle E-Business Suite cloning.

- Any specific needs like data masking, data compression, and so on can be performed before running Smart Clone.

- Smart Clone supports cloning of systems with different OS users for the database tier and the applications tier.

For Option 2B above, (Multi Apps Node to Multi Apps Node cloning) with Release 12.2, you should avoid using the same server between the source and target.

Also, for Options 2A and 2B (Multi Apps Node to Single/Multi Apps Node cloning) with Release 12.2, observe the following:

- You must not use the same port pool for the target Oracle E-Business Suite system as that for the source Oracle E-Business Suite system.

- You must not use any of the source Oracle E-Business Suite hosts for target hosts.

**Terms**

The following table lists some cloning terms used in this document.

<table>
<thead>
<tr>
<th>Term</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source</td>
<td>Oracle E-Business Suite system being cloned.</td>
</tr>
<tr>
<td>Target</td>
<td>Oracle E-Business Suite system being created as a copy of the source system.</td>
</tr>
</tbody>
</table>
### Smart Clone

**Term**  
The cloning utility in Oracle Application Management Pack for Oracle E-Business Suite. Smart Clone allows you to use a database target cloned using an external solution as an input to its cloning procedures.

### Requirements and Setup Steps

- **Cloning using Oracle Application Management Pack for Oracle E-Business suite requires Perl 5.005 or higher on the Oracle Enterprise Manager agent. The user who starts the agent processes must set the PERL5LIB environment variable pointing to Perl 5.005 (or higher) libraries. Also, the Perl executable 5.005 must be used.**

- **While upgrading the database from 9i to 10g (or 11g) with an Oracle E-Business Suite Release 11i instance, you need to ensure that the source instance perl.exe is pointed to the database 10g (11g) ORACLE_HOME of the Oracle E-Business Suite.**

- **All the virtual internet protocol (VIP) addresses configured in the Oracle Cluster Ready Services (CRS) of the targets nodes identified for the created RAC instance must be up and running.**

- **With Release 11i, for a clone job from Single Node - Single User to Single Node - Multiple User, ensure that you have write permissions for user IDs to the target base directory. Give 770 permissions to the directories from/to the target base directory with the following command:**
  
  ```
  $ chmod -R 770 <target base directory>
  ```

- **If for a cloning process the target is multi-node and the database node domain and the applications node domain are different, perform the following step:**
  
  1. Include the target database node server name in the /etc/hosts file of the target applications node so that the applications node will be able to resolve the database node without the domain name. The modification should be like the following (this entry is for Linux x86; change as appropriate for your platform):
     
     ```
     <ip-address> <Machine name with domain name> <Machine Name>
     ```
     
     For example:
     
     ```
     140.87.205.217 adc60002demo.us.oracle.com adc60002demo
     ```

     2. For Release 12 only: In addition to the above entry in the /etc/hosts file, the applications node context file needs to be changed.

     Change the `s_dbdomain` entry in the
     
     `<STAGE_LOC>/appsTier/context/apps/<SID>_<SERVER_NAME>.xml` file to the
correct domain name of the database tier.

For example, if the database node domain name is idc.oracle.com, and the applications node domain name is us.oracle.com, then the context file
/dl/QA/stage/PMS29/08052035852/PMS29_adc60010demo.xml
should be changed to
<domain oa_var="s_dbdomain">idc.oracle.com</domain>

- The OS utilities make, ld, cc, and ar must be in the environment PATH variable in all the host targets. If not, please update the PATH variable accordingly and restart the agent in the same terminal.

Prerequisites

The following are prerequisites to running an individual Smart Clone procedure:

1. The source Oracle E-Business Suite instance must:
   - be UP and healthy.
   - have had AutoConfig run successfully. It is mandatory that AutoConfig was successfully run on the source applications tier and source database tier.
   - have been discovered in Oracle Enterprise Manager and its status must not be pending.
   - have its /etc/oraInst.loc pointing to the correct oraInventory at the time of running Smart Clone.

   Note: On some platforms such as Solaris, the variable is /var/opt/oracle/oraInst.loc.

2. The target database must have already been cloned from the source Oracle E-Business Suite database.

   To do this, you can:
   - Use the Enterprise Manager 12c Database Plug-in to perform the required database cloning procedures OR
   - Use any other technology which suits your database cloning needs.

3. After it is cloned, the target database must:
   - be up and running.
• have been discovered in Enterprise Manager 12c. You must discover the target
database before you run Smart Clone.

  **Note:** Do not use the same SID (System Identifier) for the target
database as the source database. Doing so will lead to the last
step of Smart Clone (discovery of the cloned instance) failing.

4. The Oracle E-Business Suite Agent Plug-in must be deployed on all the target
database hosts and application tier hosts. After deploying the agent plug-in on the
target database hosts, run the step `root.sh`; otherwise Smart Clone will fail.

5. The Enterprise Manager user running the Smart Clone procedure must have the
appropriate privileges.

The following privilege setup instructions can be ignored if the user is a "Super
Administrator".

In order to execute the Smart Clone deployment procedure, a non-Super
Administrator user must have certain target-level privileges and the resource
privileges.

The privileges listed below could be granted in many ways depending on the
desired level of granularity of privileges to be granted to the user. For more details
on granting privileges, please refer to the section "Configuring Security" in the
manual *Oracle Enterprise Manager Cloud Control Administrator’s Guide 12c Release 1*.

The following outlines one of the ways of granting the required privileges for
executing the Smart clone procedure.

**Target Privileges**

• Add any Target
  
  • Privileges applicable to all targets
    
    • Name: Add any Target (Description: Add any target in Enterprise
    Manager)

• Operator any Target
  
  • Privileges applicable to all targets
    
    • Name: Operator any Target (Description: Ability to perform
    administrative operations on all managed targets)
    
    • Included Privileges - View any Target
    
    • Applicable Target Types - All Target Types
Resource Privileges

1. Job System resource:
   - Name - Job System
   - Description - Job is a schedulable unit of work that administrator defines to automate the commonly run tasks
   - Resource Type Privilege - Create

2. Deployment Procedure:
   - Name - Deployment Procedure
   - Description - Deployment procedures are customizable orchestration routines for various Provisioning and Patching tasks
   - Resource Type Privilege - Create

6. The following Named Credentials must be defined:
   - Host target type
     - Authentication Target Type: "Host"
     - Credential Type: "Host Credentials"
   - Oracle E-Business Suite target type
     Please refer to the section Creating Named Credentials for Oracle E-Business Suite, page 5-2 for instructions on creating the Oracle E-Business Suite Database Credentials.
   - The normal host preferred credentials where the WebLogic Administration Server is running must also be set.

Cloning with RAC Instances

With Smart Clone, if the target Oracle E-Business Suite instance database is of type "RAC" and if you want to configure Parallel Concurrent Processing after the clone is completed, then it is recommended that you follow instructions described in the following My Oracle Support Knowledge Documents, depending on your RDBMS version:
   - Document 312731.1, "Configuring Oracle Applications Release 11i with 10g RAC and 10g ASM"
• Document 757980.1, "Using Oracle 11g Release 1 Real Application Clusters and Automatic Storage Management with Oracle E-Business Suite Release 11i (11.1.0.6)"

• Document 455398.1, "Using Oracle Real Application Clusters and Automatic Storage Management with Oracle E-Business Suite Release 11i and Oracle Database 11g"

• Document 783188.1, "Certified RAC Scenarios for E-Business Suite Cloning" for more information on cloning of systems deployed on Oracle Real Application Clusters (RAC) is possible.

• Document 559518.1, "Cloning Oracle E-Business Suite Release 12 RAC-Enabled Systems with Rapid Clone" for information on cloning a Release 12 system on a RAC database

Preferences
For Oracle E-Business Release 12.1 and earlier, the following properties are set in the Preferences page. Navigate to the Preferences page by navigating to Targets > Oracle E-Business Suite > Administer > Preferences. These preferences are not applicable to cloning with Oracle E-Business Suite Release 12.2. For Release 12.2, default values are used.

• Number of parallel threads/processes that will be used while zipping, transferring and unzipping the files under APPL_TOP directory of the applications tier.
  • Minimum value: 1
  • Maximum value: 16
  • If the value is empty OR less than 1 OR greater than 16, then the default value of 8 is used.

• Number of parallel threads/processes that will be used while zipping, transferring and unzipping the files under Tools Oracle Home directory of the applications tier.
  • Minimum value: 1
  • Maximum value: 8
  • If the value is empty OR less than 1 OR greater than 8, then the default value of 4 is used.

• Number of parallel threads/processes that will be used while zipping, transferring and unzipping the files under Tools Oracle Home directory of the applications tier.
  • Minimum value: 1
Considerations for Cloning with Oracle E-Business Suite Release 12.2

Oracle E-Business Suite Release 12.2 is deployed on Oracle WebLogic Server. As a result, most of the technology stack scripts used in cloning (such as adpreclone, adclone, adstrtall, adstpall, and so on) require the WebLogic Admin password. Therefore, the WebLogic Admin password is required in the cloning procedure interview for Release 12.2 systems.

Also, note the following regarding zipping of files during the cloning process:

- `<COMMON_TOP>/clone/FMW/FMW_Home.jar` will be very large (2.7 GB).
- The WebLogic Server home directory (FMW_Home) will NOT be zipped or transferred.

Diagnostic Tests

For information on diagnostic tests for this feature, see: Diagnostic Tests for Cloning, page 10-3.

Running a Single Node to Single Node or Multi Node to Single Node Cloning Procedure for Release 11i and 12.1.x

This section describes running the Single Node to Single Node and Multi Node to Single Node Smart Clone procedure. These procedure can be used for Release 11i and Release 12.1.x.

At a high level, a Smart Clone procedure performs the following:

1. Configures the target database.
2. Clones and configures the applications tier from the source Oracle E-Business Suite system.

These two steps result in creating a target Oracle E-Business Suite system which is ready to use.

**Note:** On an HP-UX Itanium platform, the plug-in will show the "Oracle Applications JVM Usage" target as down. The cause of this issue is that the target type .xml contains control M (^M) characters. To resolve this issue,

1. Go to <Agent Home>/plugins/oracle.apps.ebs.agent.plugin_12.1.0.3.0/metadata.
2. Remove ^M characters in oracle_apps_jvm.xml.
3. Restart the agent.

**To run a single-node cloning procedure:**

2. Select "Smart Clone" from the dropdown list and click Go.
3. Enter general information for the cloning process. This step captures information related to the target database already cloned and discovered in Enterprise Manager. Provide a transaction name for the Clone Name.

Choose the source Oracle E-Business Suite you would like to clone from the LOV.

Specify the target database which is to be cloned from the source Oracle E-Business Suite's database.

Based on the type of database chosen (that is, a single instance database or a RAC database), the Target Database Details region is dynamically rendered.
For a single instance database, provide the following:

- Target Database
- Apps Schema Username
- Apps Schema Password
- System Schema Password
- TNS admin directory

You can click on Validate Database button or you can leave it to the Next button to perform the same action.

If the target database is a RAC database, the Target Database Details region is rendered differently, as shown in the following figure. Specify whether SCAN is configured in the target database.
4. Enter RAC Target database details, if applicable.

This step only applies if the target database is a RAC database. This step is skipped if the target database has the type Single Instance.

If the source Oracle E-Business Suite technology stack has the required patches applied for configuring customized names for listeners, then this page will automatically render in such a way that you provide names for the target database listeners by providing the required names in the column "New Listener Name".

If the source Oracle E-Business Suite technology stack does not have the required patches, then Smart Clone will provide default names for the listeners using the naming convention "LISTENER_<hostname>".

If the source Oracle E-Business Suite technology stack has the required patches applied for configuring the target database with "SCAN Listeners", then the "Custom SCAN Details" section is rendered with the "SCAN Name" and "SCAN Port" fields populated automatically. It is highly recommended not to change these values if it automatically populated. If for some reason the SCAN Name and SCAN
Port fields are not populated (for example, if the cluster target instance discovered in Enterprise Manager has not populated these values yet as properties), then you must enter the correct values for these fields.

Optionally, check the box "Use Custom SCAN Name and Port" if you want to get the target database configured with the SCAN listener. If you do not check the box "Use Custom SCAN Name and Port" box, then Smart Clone will clone the target database with virtual host names.

If the source Oracle E-Business Suite technology stack does not have the required patches, then the "Custom SCAN Details" section will not be rendered, and the target database will be configured with virtual host names.

If the target instance is already configured with scan listeners, then by default the "Use Custom SCAN Name and Port" box will be checked.

5. Enter source and target information.

   In this step, Smart Clone captures information related to the source and target.
   
   • All application tier information of the source Oracle E-Business Suite system is displayed.

   • You enter details for the target Oracle E-Business Suite system.

   If the source Oracle E-Business Suite system is deployed on a single applications tier, the Source regions appear as shown in the following figure. Information is shown for the following services: Admin, CP (Concurrent Processing), Forms, and Web.
In the Available Target System Nodes region, choose the source host that can be used as a reference while cloning the target applications tier. Specify the target host from the LOV where Smart Clone should create the target applications tier.

If the source Oracle E-Business Suite system is deployed on a multi-node applications tier, then the Source regions appear as shown below.

The Source System Nodes region shows the details of the source Oracle E-Business Suite applications tier in terms of

- Number of nodes the applications tier is deployed on.
- Details of the services on the nodes.

For a Release 11i multi-node applications tier system, you will need to choose the nodes for the services which are to be used as references for creating the Release 11i single node applications tiers. Do this in the "Select Source Nodes for Each Service" region.

For Release 12, selecting the service in this section is unnecessary because the reference source host will be selected only from the "Available Target System Nodes" region.

6. In the Available Target System Nodes region, choose "Single-Node Target". This is
the default option.

Then choose the source host that can be used as a reference while cloning the target applications tier. Specify the target host from the LOV where Smart Clone should create the target applications tier.

For the target system node, click the Specify Details icon to update its properties in the Target Node Summary page.

7. The Target Node Summary page is shown below.

The port pool and individual port values are updated from the source instance.

If there is an invalid value in the port pool from the source instance, the following error is shown: "NOTE: Source Apps portpool context variable (s_port_pool) is invalid: <value>. Setting to default value '0'. Please update as needed!"

**Important:** For Oracle E-Business Suite Release 11i, you must select
the Override Defaults option and in the prompt 'Target Node Summary' page, update the following entries:

- **JDK Location** - Enter the JDK location in your target instance.
- **JRE TOP** - Enter the same location as the JDK location in your target instance.
- **PERL executable location** - Enter `<iAS home in the target instance>/Apache/perl/bin/perl`.

8. In the Copy Parameters step, enter information on how the copying process should be done.

If you are using the same host for both the source and target instance, ensure that the source stage directory is different from the target stage directory.

9. Enter Credentials.

Smart Clone uses named credentials. You can select and test the named credentials on this page.

Named credentials can be created by navigating to the Setup menu, then Security > Named Credentials, and clicking **Create**.
Smart Clone requires the following credentials to be created:

- Application Node OS Credentials and Database Node OS Credentials.
  - Authentication Target Type - Host
  - Credential Type - Host Credentials
- Database Schema Credentials

Please refer to the section Creating Named Credentials for Oracle E-Business Suite, page 5-2 for information on creating the Oracle E-Business Suite Database Credentials.

**Note:** Database schema credentials appear only when the source applications system is on Release 11i and using a non-shared file system.
The Credentials page for a Smart Clone procedure where the source applications system is multi-node and the target database is non-RAC is shown in the figure below. This page allows you to enter in and test all required credentials for the nodes.
The Credentials page for a Smart Clone procedure where the source applications system is single node and the target database is RAC is shown in the figure below. On this page you can enter and test the required credentials for all the nodes.

10. Enter values for custom parameters. These would be used in any directive steps you have created.

You can create directive steps to be integrated into a deployment procedure. For more information on deployment procedures, see the Oracle Enterprise Manager Cloud Control Administrator’s Guide. For a description on how to create a directive step and insert it into a procedure created using the "Create Like" feature and a
shipped Smart Clone procedure, see: Adding Custom Steps to a Smart Clone Deployment Procedure, page 11-48.

11. Schedule the deployment.

12. Review your Smart Clone deployment procedure and click Finish.
Running Scale-Up and Scale-Down Multi-Node Cloning Procedures

This section describes using Smart Clone for scale-down and scale-up cloning of Oracle E-Business Suite application nodes.

This type of procedure is supported for Oracle E-Business Suite Releases 12.0 and 12.1.

This procedure is similar to the single-node Smart Clone procedure; the main difference is in specifying the source and target in the "Source/Target" step in the interview process.

The following steps provide a high-level description of a Smart Clone procedure:

1. Smart Clone configures the target database.

2. Smart Clone clones and configures the applications tier from the source Oracle E-Business Suite system.

These steps result in creating a target Oracle E-Business Suite system which is ready to use.

To run a multi-node cloning procedure:

1. Navigate to the Cloning home page by using the following path: Targets menu > Oracle E-Business Suite > Administer > Cloning. Choose "Smart Clone" from the
"Start a Clone" list.

2. Enter general information for the cloning process. This step captures information related to the target database already cloned and discovered in Enterprise Manager.

   Provide a transaction name for the Clone Name.

   Choose the source Oracle E-Business Suite you would like to clone from the LOV.

   Select the target database which is cloned from the source Oracle E-Business Suite's database.

   Based on the type of database (that is, a single instance database versus a RAC database), the rendering of the Target Database Details region will dynamically change. The figure below shows the rendering of the region for a single instance database.

   Provide the following for the target database:

   - Apps Schema Username
   - Apps Schema Password
   - System Schema Password
   - TNS admin directory

   You can click on Validate Database button or you can leave it to the Next button to perform the same action.
If the target database is a RAC database, the Target Database Details is rendered differently, as shown in the following figure.
Provide the following for the target database:

- Apps Schema Username
- Apps Schema Password
- System Schema Password

Specify whether SCAN is configured in the target database.

You can click on Validate Database button or you can leave it to the Next button to perform the same action.

3. Enter RAC Target database details, if applicable.

This step only applies if the target database is a RAC database. This step is skipped if the target database is a single instance database.

If the source Oracle E-Business Suite technology stack has the required patches applied for configuring customized names for listeners, then this page would
automatically render so that you provide names for the target database listeners in the required field "New Listener Name".

If the source Oracle E-Business Suite technology stack does not have the required patches, then Smart Clone will give default names to the listeners using the naming convention "LISTENER_<hostname>".

If the source Oracle E-Business Suite technology stack has the required patches applied for configuring the target database with "SCAN Listeners”, then the "Custom SCAN Details" region is rendered with the "SCAN Name" and "SCAN Port" fields populated automatically. It is highly recommended not to change these values if it automatically populated. If for some reason the SCAN Name and SCAN Port fields are not populated (for example, if the cluster target instance discovered in Enterprise Manager has not populated these values yet as properties), then you must enter correct values into these fields.

Optionally, check the box "Use Custom SCAN Name and Port" if you want to get the target database configured with the SCAN listener. If you do not check the box "Use Custom SCAN Name and Port", then Smart Clone will clone the target database with virtual host names.

If the source Oracle E-Business Suite technology stack does not have the required patches, then the "Custom SCAN Details" region will not be rendered and the target database will be configured with virtual host names.

If the target instance is already configured with SCAN listeners, then by default the "Use Custom SCAN Name and Port" box will be checked.

4. Enter source information in the Source/Target step.
   The “Source System Nodes” region shows the details of the source Oracle E-Business Suite applications tier including:
   - Number of nodes on which the applications tier is deployed
• Details of the services on the nodes

5. Enter target information on the Source/Target step.

Choose the type of target. For multi-node cloning, the options are:

• Multi-node target with a non-shared file system

• Multi-node target with a shared file system

Note that when the target has a shared file system that:

• The first node in the admin service list is considered the primary service.

• The Target location has "Override Defaults" selected as a provision to update the shared directory location for APPL_TOP, COMN_TOP, and so on.

If you choose either of the multi-node choices, a new set of options is shown:

6. Add a node to each service by clicking on the Add button for the service and choosing the node from the LOV.
If you want to delete a node from a service, select the node to be deleted and click the **Delete** button.

7. After you add the lists of nodes, you can navigate to the "Common Properties" page.
   
   In this page you specify properties such as port data and the applications base directory location.

   **Common Properties for Non-Shared APPL_TOP**
When you click the **Check Availability** button, the port availability on all selected nodes will be checked. This verification is also done when you click **OK** for the page itself.

The port pool and individual port values are updated from the source instance.

If there is an invalid value in the port pool from the source instance: following error will be shown: "**NOTE: Source Apps portpool context variable (s_port_pool) is invalid: <value>. Setting to default value '0'. Please update as needed!**"

Click **Next** to proceed to the next step. After you click Next, the system checks to confirm all the services are enabled on the target node.

**Note:** Dependent services are automatically added to the nodes.

8. In the Copy Parameters step, choose options for how your copying will be done.
9. Enter Credentials.

Smart Clone uses Named Credentials. You can select and test the named credentials on this page.

Named credentials can be created by navigating to the Setup menu, then Security > Named Credentials, and clicking Create.

Smart Clone requires the following credentials to be created:

- Application Node OS Credentials and Database Node OS Credentials.
  - Authentication Target Type - Host
  - Credential Type - Host Credentials
- Database Schema Credentials

Please refer to the section Creating Named Credentials for Oracle E-Business Suite, page 5-2 for information on creating the Oracle E-Business Suite Database Credentials.
**Note:** Database schema credentials appear only when the source applications system is on Release 11i and using a non-shared file system.

The Credentials page for a Smart Clone procedure where the source applications system is multi-node and the target database is non-RAC is shown below. This page allows you to enter and test all required credentials.
The Credentials page for a Smart Clone procedure where the source applications system is single node and the target database is RAC is shown below. This page allows you to enter and test the required credentials.

10. Enter values for custom parameters.

You can create directive steps to be integrated into a deployment procedure. For more information on deployment procedures, see the Oracle Enterprise Manager Cloud Control Administrator’s Guide. For a description on how to create a directive step and insert it into a procedure created using the "Create Like" feature and a shipped Smart Clone procedure, see: Adding Custom Steps to a Smart Clone
11. Schedule the deployment.

12. Review your Smart Clone deployment procedure and click Finish.
What's Next

When a multi-node to multi-node applications tier cloning procedure is submitted, then, irrespective of whether it is a “scale-up” or “scale-down” procedure, the admin node is configured first with the given services enabled. Then each node will be configured one after the other, depending on the node details specified in the cloning interview.

After all the nodes are configured, the URLs used in accessing Oracle E-Business Suite are redirected to the node on which AutoConfig was last run. Therefore, after all nodes are configured, you should run AutoConfig again on the node in which the web service is enabled.

**Note:** For more information, see My Oracle Support Knowledge Document 1349509.1, "All the URLs Accessing Oracle E-Business Suite Are Getting Redirected to the Web Node Where AutoConfig Last Ran."


The following steps describe the single node to single node cloning procedure for Oracle E-Business Suite Release 12.2.
1. Navigate to the Cloning home page by selecting Targets > Oracle E-Business Suite > Administer > Cloning. Select “Smart Clone for Oracle E-Business Suite 12.2.x” and click Go.

2. Enter basic information for your cloning procedure, including Clone Name, Description, and target and source information.

   Also enter the source WebLogic Admin Password and the target database APPS credentials.

   In the case of single-node target database cloning, you will be prompted the TNS_ADMIN of target database.

   If the target database is a RAC database, a new region of prompts appears to capture RAC-specific information, as shown below.
For the RAC Target DB Node Specific Details:

- **Virtual Host Name** - The virtual host name. Note that the domain name must NOT be appended.

- **Current Listener Name** - The value with which the database instance can be connected.

- **New Listener Name** - If you want to change the existing listener name, enter the new name here. If you want to retain the existing listener name, then enter the current listener name in this field.

- **TNS Admin Directory** - The TNS_ADMIN value with which the database instance can be connected.

For the RAC Target DB Custom SCAN Details section: If the target database is already SCAN-configured, then select "Yes" for "Does the Target DB already has SCAN Configured". In this case, enter the Local Database port. Also in this case, "Enable SCAN Configuration in the Target DB" will automatically become "Yes".

If you wish to configure SCAN on the target database, then select "Yes" for "Enable SCAN Configuration in the Target DB". You will then be prompted for the SCAN name and port.

The SCAN name and SCAN port will be populated from the cluster target.

3. **Enter target application details.**

Choose Single Node Apps for the Target Application Tier.
Select the host on which the target applications system is intended to be cloned and the base directory. Once the base directory is provided, other directories details are automatically populated. Please note that these auto-populated values are read-only.

You can choose the port pool for run file system and patch file system. You can validate the ports individually for the run file system and the patch file system. In case of port unavailability, an error will list the invalid port information.

4. In the Stage Directories step, enter stage location information.
The source stage location is where the source application file system is staged. The target stage is the location where the staged application files are copied.

**Important:** Ensure that the source stage location is outside `<common_top>/clone`. Also ensure that these directories have write permissions.

Specify your copy options:

No Copy - Select this if the source and target applications file systems are in the same host. This is applicable to Single-Node to Single-Node applications cloning. Make sure both source and target stage locations are same.

If you choose Copy, select the Copy Method:

- Remote File Transfer Option - Choose this if the source and target applications file systems are in different hosts.

- Manual Copy Option - If this option is chosen, you will have to manually copy the source file system to target file system. The clone procedure will be halted and will wait for user confirmation.

5. Provide Host Credential Details in the next page.
You can validate a credential using the Test button.
In the case of a RAC database, all the target database node information must be entered.

6. Enter the Schedule information.
You can select "Immediate" to submit the Smart Clone run immediately, or you can schedule the Smart Clone run for a future date.

7. Review the information you have entered.
In the case of a RAC target database, specific information pertaining to RAC is also displayed.

**Note on Manual Steps for a Smart Clone procedure for Oracle E-Business Suite Release 12.2.x:**

In the Smart Clone Deployment Procedure for Release 12.2.x, as Auto Config on Database Tier will update the sqlnet.ora; there will be a manual step just before the
target Oracle E-Business Suite discovery step to enable the OMS host(s) to connect to the target Oracle E-Business Suite database. You need to verify and update the OMS host(s) entry for tcp.invited_nodes if tcp.validnode_checking is set to yes in sqlnet.ora, and click Confirm for this manual step.

Running Multi Node to Multi Node or Single Node to Multi Node Cloning for Oracle E-Business Suite Release 12.2

1. Navigate to the Cloning home page by selecting Targets > Oracle E-Business Suite > Administer > Cloning. Select “Smart Clone for Oracle E-Business Suite 12.2.x” and click Go.

2. Enter basic information for your cloning procedure, including Clone Name, Description, and target and source information.

   Also enter the source WebLogic Admin Password and the target database APPS credentials.

   In the case of single-node target database cloning, you will be prompted the TNS_ADMIN of target database.
If the target database is a RAC database, a new region of prompts appears to capture RAC-specific information, as shown below.

For the RAC Target DB Node Specific Details:

- Virtual Host Name - The virtual host name. Note that the domain name must NOT be appended.
- Current Listener Name - The value with which the database instance can be connected.
- New Listener Name - If you want to change the existing listener name, enter the new name here. If you want to retain the existing listener name, then enter the current listener name in this field.
- TNS Admin Directory - The TNS_ADMIN value with which the database instance can be connected.

For the RAC Target DB Custom SCAN Details section: If the target database is
already SCAN-configured, then select "Yes" for "Does the Target DB already has
SCAN Configured" In this case, enter the Local Database port. Also in this case,
"Enable SCAN Configuration in the Target DB" will automatically become "Yes".

If you wish to configure SCAN on the target database, then select "Yes" for "Enable
SCAN Configuration in the Target DB". You will then be prompted for the SCAN
name and port.

The SCAN name and SCAN port will be populated from the cluster target.

3. Enter target application details.

For Target Application Tier, choose either Multi Node Apps with Non Shared File
System or Multi Node Apps with Shared File System.

![Target Apps Details](image)

To add a node to a service:

1. Click the **Add** button.

2. Select the host from the LOV window.
To delete a node from the nodes belonging to a service:

1. Select the node or nodes to be deleted from the table.

2. Click on Delete.

Note that the Target System Inst Directory is configurable.

When you click **Validate**, the port availability on all selected nodes will be checked.

4. In the Stage Directories step, enter stage location information.

The source stage location is where the source application file system is staged. The target stage is the location where the staged application files are copied.
Cloning an Oracle E-Business Suite System

Note: Ensure that these directories have write permissions.

Specify your copy options:

No Copy - Select this if the source and target applications file systems are in the same host. This is applicable to Single-Node to Single-Node applications cloning. Make sure both source and target stage locations are same.

If you choose Copy, select the Copy Method:

- Remote File Transfer Option - Choose this if the source and target applications file systems are in different hosts.
- Manual Copy Option - If this option is chosen, you will have to manually copy the source file system to target file system. The clone procedure will be halted and will wait for user confirmation.

5. Provide Host Credential Details in the next page.

You can validate a credential using the Test button.

In the case of a RAC database, all the target database node information must be entered.
6. Enter the Schedule information.

You can select "Immediate" to submit the Smart Clone run immediately, or you can schedule the Smart Clone run for a future date.

7. Review the information you have entered.
In the case of a RAC target database, specific information pertaining to RAC is also displayed.

Note on Manual Steps for a Smart Clone procedure for Oracle E-Business Suite Release 12.2.x:
In the Smart Clone Deployment Procedure for Release 12.2.x, as Auto Config on Database Tier will update the sqlnet.ora; there will be a manual step just before the...
target Oracle E-Business Suite discovery step to enable the OMS host(s) to connect to the target Oracle E-Business Suite database. You need to verify and update the OMS host(s) entry for `tcp.invited_nodes` if `tcp.validnode_checking` is set to `yes` in `sqlnet.ora`, and click Confirm for this manual step.

---

### Adding Custom Steps to a Smart Clone Deployment Procedure

This section describes creating custom steps and adding them to a Smart Clone deployment procedure. For more information generic information on how to create a directive step and add it to a copy of an out-of-the-box deployment procedure, refer to the *Oracle Enterprise Manager Cloud Control Administrator’s Guide*.

**Create a directive step:**

1. From the Enterprise menu, select Provisioning and Patching, then select Software Library.
2. Create a new directive. From the Actions menu, select Create Entity, then select Directives.
3. Specify a name and other attributes for the directive.
4. Add parameters for the directive.
5. Select the “Software Library” location and the script to be executed. In the example below, a Perl script is used.

6. Click Next and Save and Upload.

Create a copy of the out-of-box Smart Clone deployment procedure:
1. From the Enterprise menu, select Provisioning and Patching, then select Procedure Library.
2. Select "Smart Clone" and click "Create Like".

3. Enter a name and other general information.
4. On the Procedure Steps tab, select the step before, inside, or after which you want to add the custom step, and click **Insert**.
5. Give the new step a name and enter additional information for the step.
6. Search for the directive and click **Next**.

7. Map the parameters as required in the Map Properties step.

   In our example, a text box will be provisioned in the Smart Clone procedure interview to provide the value for "Parameter 2".

   **Note:** The option ‘Ask User during Procedure Interview’ is NOT
supported in Smart Clone for Release 12.2.x.

8. Save the custom step and then save the procedure.
9. You can now submit the newly-created deployment procedure.
Introduction to Change Management

This chapter covers the following topics:

• Introduction

• Change Approval Framework and Change Management Privileges

• Preferred Credentials for Change Management

• Notifications Setup

• Diagnostic Tests

Introduction

Change Management for Oracle E-Business Suite (formerly delivered in the product "Oracle Application Change Management Pack for Oracle E-Business Suite" and abbreviated as "ACP" or "ACMP") provides a centralized view to monitor and orchestrate changes (both functional and technical) across multiple Oracle E-Business Suite systems. Change Management offers the capabilities to manage changes introduced by customizations, patches and functional setups during implementation or maintenance activities.

Change Management for Oracle E-Business Suite consists of two main components:

• Patch Manager allows you to deploy patches across Oracle E-Business Suite instances from a single console. Patch Manager integrates with My Oracle Support and can automatically download and deploy patches across multiple (single or multi-node) Oracle E-Business Suite instances. Both Oracle E-Business Suite patches and patchsets, as well as patches created with Customization Manager, are supported.

• Customization Manager automates the process of packaging, releasing, deploying, and migrating customizations for a single Oracle E-Business Suite instance or multiple Oracle E-Business Suite instances. It provides capabilities to integrate with third-party source control repositories to access customizations that need to be
packaged. Before packaging the updates, Customization Manager validates the customization against software coding best practices. These custom packages can then be patched to Oracle E-Business Suite instances like any other Oracle Patch either using the Oracle Applications DBA (AD) utilities or using Patch Manager.

These components can be accessed using the navigation path Targets > Oracle E-Business Suite > Administer > Change Management.

**Major Benefits**

- Simplifies the mechanism of orchestrating changes across multiple Oracle E-Business Suite systems.
- Improves user productivity by automating the deployment of changes.
- Reduces human errors by providing a standards-based change deployment framework.
- Provides notifications to specified users of updates to the Oracle E-Business Suite systems.

Change Management thus helps to lower the total cost of ownership by providing these benefits from the central Oracle Enterprise Manager console which allows you to manage the entire application environment.

**Change Approval Framework and Change Management Privileges**

The Change Approval Framework helps ensure that all changes done using any of the products in Change Management go through a change approval mechanism. This change control mechanism entails one level of approval for any change that results in a configuration or code change of an Oracle E-Business Suite instance. The Change Approval Framework provides tracking and auditing with respect to the change control requests and historical data. A common change control tracking dashboard is provided for tracking all change requests within Change Management. Auto-approvals are possible if the requestor is a Super Administrator or has the respective approver role with approval target access.

All critical changes within Patch Manager and Customization Manager would need to go through the change control mechanism.

See the section Privileges for Change Management, page 7-5 for information on required privileges.

Navigate to Targets > Oracle E-Business Suite > Administer > Change Management > Change Approval Requests.
The Change Approval page allows users with the proper privileges to perform the following:

- Search for requests as per role access.
- Approve or reject a given change control request after viewing details.
- Track historical data with respect to change control requests for auditing purposes using "Related History".

**Preferred Credentials for Change Management**

When using Change Management features, you will need to access Oracle E-Business Suite instances. You can set up credentials for these instances for every user as a one-time setup step instead of entering them every time you need to access an instance. Note that preferred credentials are not shared across users. See the Credentials chapter beginning with the section Overview of Credentials, page 5-1 for more information.

**Notifications Setup**

You have the option of sending e-mail notifications to users regarding updates to the Oracle E-Business Suite systems. To have these notifications sent successfully, you must have the system set up properly:

- Ensure that the agent on the Oracle Management Server is up and running.
- Ensure that the command parDeploy has been run as part of the setup of Oracle Enterprise Manager Cloud Control 12c.
• Enter the SMTP information as described below.

To set the SMTP information in Oracle Enterprise Manager:
The Outgoing SMTP Server information must be entered in Oracle Enterprise Manager.

  Note: If the SMTP information is not set correctly, notifications will not be sent.

1. Within Oracle Enterprise Manager, navigate to Setup > Notifications > Notification Methods.

2. Set the Outgoing Mail (SMTP) Server value.

3. Enter additional information as needed.

Diagnostic Tests

Oracle Application Management Pack for Oracle E-Business Suite includes diagnostic tests that should be run to ensure your system is set up correctly to use the pack’s features. These tests are run using the Pack Diagnostics link under Related Links on the Oracle E-Business Suite Instances page. For more information on using the Pack Diagnostics link, see: Running Pack Diagnostics Tests, page 10-1.
This chapter covers the following topics:

- Introduction
- Patch Manager Home
- Creating a Patch Run (Release 12.1 and Earlier)
- Copying a Patch Run for Release 12.1 and Earlier
- Creating Patch Deployment Procedures for Oracle E-Business Suite Release 12.2
- Extending Patch Manager Deployment
- Logging, Health Checks, and Troubleshooting

**Introduction**

Patch Manager allows you to deploy patches across Oracle E-Business Suite instances from a single console. You can create a patch run definition and run it multiple times on multiple instances and you can copy a patch procedure and modify it to suit your business needs. Also, you can easily access details on patch runs, correct errors if necessary, and continue the patch runs.

**Note:** If you will use Patch Manager with Oracle E-Business Suite Release 12.2, you should be familiar with Online Patching concepts before using Patch Manager. Refer to *Oracle E-Business Suite Concepts* and *Oracle E-Business Suite Maintenance Guide* for information on Online Patching.

**Key Features**

Patch Manager

- Automates the deployment patches across multiple Oracle E-Business Suite
- Utilizes most common Oracle E-Business Suite Applications DBA (AD) Utilities.
- Utilizes patching best practices and reduces downtime.
- Integrates with Customization Manager to deploy custom packages.
- Enforces policies for applying patches onto pre-production systems before applying them to production systems (patch promotion policies).
- Supports downloading patches directly from My Oracle Support for deployment.
- Supports deployment of patches that were previously downloaded to a central location on the Oracle Management Server.
- Supports National Language Support (NLS) patches.
- Provides a complete history of all patch deployments.
- Provides a customizable patch deployment procedure.
- Leverages Oracle Enterprise Manager infrastructure for distributed processing.

With Patch Manager, you can
- View the readme of a patch with just one click.
- Schedule deployments based on the target’s time zone.
- Schedule deployments of patches immediately or in the future.
- Perform a complete series of pre/post health checks when deploying patches.
- Track and monitor all patching deployments “Running”, “Scheduled”, “Saved” and “Succeeded” from a centralized console.
- Send and receive notifications for patch failures and completion.

For information on diagnostic tests for this feature, see: Diagnostic Tests for Patch Manager, page 10-10.

**Patch Manager Home**

The Patch Manager home page provides an overview of the patch deployment procedures. You can personalize the page using the Personalize Page icon, to hide, show, or reorder the regions on the page. For example, if you are patching Release 12.2 targets primarily, you can personalize the page to display the Online Patching region.
first and display the Abort Runs and Cutover Runs regions as well. The shipped page has the following regions displayed by default:

- Patch Promotions - used with patch promotion policies
- Patch Runs - used for targets on releases 12.1 and earlier
- Online Patching - used for Release 12.2 targets
- Patch Logs - used to access patching log files

Two other regions are available, but are hidden by default. Both of these pertain to Release 12.2 deployment procedures:
- Abort Runs
- Cutover Runs

---

**Patch Promotion Policies**

Patch Manager can provide automatic enforcement of user defined promotion policies. These policies can be used to specify that patches must be applied to pre-production systems before being applied to production systems. This feature provides Audit Trail visibility and enhanced internal controls for patch application.

By default, the patch promotion policy feature is not enabled out of the box. Administrators can enable the promotion policy by setting the preference "Enforce Patch Promotion Policy". Once it is enabled, administrators can define various patch
promotion policies including multiple Oracle E-Business Suite targets and enforce the sequence in which the patches are promoted. Approvals are required for each Oracle E-Business Suite target. Requests for approval will be generated when a patch is submitted. A Super Administrator can decide not to use the patch promotion policy for emergency patching or can choose not to include a specific Oracle E-Business Suite target instance in any patch promotion policy. In the case of emergency patching, Patch Manager sends out a notification of the patch promotion violation as a warning. An example of a patch promotion policy will include the following sequence of patch promotions to pre-production instances and then to production instance.

Test ==> Development ==> User Acceptance ==> QA ==> Production

Setting up a Patch Promotion Policy

To create a new patch promotion policy, navigate to Patch Manager Home > Action (menu) > Configure Promotion Policies. Then follow these steps:

1. Select the Create icon.
2. Provide a name for your policy.
3. Enter the targets for your policy.
   
   **Important:** A target may belong to only one active policy. Because a given production system generally has multiple supporting instances that are clones of the production system, it would not make sense to put a supporting environment in two different patch promotion policies.

4. Specify the promotion order number.
5. Click Save to save your work.
The Patch Promotion Policy region on the home page displays patches and their statuses on various targets. This table dynamically changes based upon the policy displayed. You can select multiple rows within the table in order to promote patches to the next target defined in the policy.

For example, several developers might submit patches to a development environment. During the promotion of these patches to the next environment, an administrator has the capability to bundle the multiple patches into a single deployment procedure.

Users can select the patches they want to promote and click on **Promote** to apply the patches to the next Oracle E-Business Suite target instance in the patch promotion.
policy. The Patch Manager interview is then pre-populated with the selected patches and the target information.

A check mark under each target implies that the patch has been applied. An 'X' mark indicated patch has not been applied to that target Oracle E-Business Suite instance. Users can view deployment procedure details in the Deployment Details window. Users can also access the patch readme file from the within the Deployment Details window.

**Patch Runs**

The Patch Runs region of the Patch Manager Home lists the patch runs and their statuses for Oracle E-Business Suite Release 12.1 and earlier.

You can perform various actions on a patch run depending on its status:

- **Review** - Review details of the patch run.
- **Create Like** - Copy an existing patch run, in order to change any aspect of the patch run or to run an identical run due to changes in the patch or target.
- **Edit** - If a patch run is in Saved status, you can edit it.
- **Submit** - If a patch run has been approved through the approval management system, it can be submitted from here.

To start a new patch run for Oracle E-Business Suite Release 12.1 and earlier, select "New Run". If a user has used the "Create Like" feature for the shipped "Patch Oracle E-Business Suite" deployment procedure then clicking "New Run" will prompt the user which deployment procedure they would like to use. Otherwise, clicking "New Run" will begin the patch run interview.

By default, all records are displayed in the table. To filter the records by status, use the "Show" list. You can also use the "Search" button to apply additional filters to control which records are displayed.

**Online Patching**

The Online Patching region displays patch deployments against Release 12.2 targets.

Note that with Release 12.2, the adop patching process in Patch Manager is broken down into two deployment procedures. The first deployment procedure runs the prepare, apply, finalize, and optionally actualize_all phases. The second deployment procedure executes the cutover, cleanup, and optionally fs_clone phases.

You can click the New Deployment to begin a new online patching interview. As with the "Patch Runs" region, if a user has used the "Create Like" feature on the deployment procedure, you will be prompted to specify which deployment procedure you want to use.
In this region you can filter by "Latest" or "All". These choices will show only the latest adop session or all of them.

The records in this region are displayed in a tree format with a parent - child - grandchild relationship. The parent is the target, the child is the adop session, and the grandchildren are the patch deployments. Patch Manager supports multiple patch deployments in a single adop session. If the deployment procedure has not started or has not run through the "prepare" phase then the deployment records will fall under "ADOP Pending Sessions".

Columns in the region are:

- **Phase** - The adop phase the deployment procedure is currently running or ran last.
- **Apply Status** - The status of the "Apply" deployment procedure.
- **Cutover Status** - The status of the "Cutover" deployment procedure.
- **Review** - Link to the review page displaying all interview information.
- **Create Like** - Allows for duplication of an interview.
- **Edit** - Allows for editing a saved interview.
- **Remove** - Allows for removal of a deployment record. Note that the record is not deleted, just removed from the display. The status of the record must be "Saved" or "Stopped" for this icon to be available.
- **Submit** - Allows for submission of a deployment procedure after the interview has been approved in the approval management system.
- **ADOP Details** - This icon opens a window showing the adop phases, applied patches, database editions, and file system details.
- **Abort** - Clicking this icon submits a deployment procedure that runs "adop phase=abort" on all nodes. Before the submission occurs there is a check to ensure the target Oracle E-Business Suite system is in a state that allows for abort (such as, the prepare phase has been run). The check also verifies that the session for which you are running abort is the latest adop session; this step is to ensure that the correct session is to be aborted.
- **Cutover** - This icon submits the cutover deployment procedure. It opens a window in which you can schedule the cutover. This feature also ensures the adop session for which you are running is actually the latest.
- **Requestor** - This is the user who requested the patch be applied.
- **Created By** - This is the user who created the interview.
• Last Updated - Timestamp indicating when the deployment procedure was last updated.

**Patch Logs**

The Patch Logs region allows you to access patching log files across all hosts of an Oracle E-Business Suite system.

To access log files:

1. First select an Oracle E-Business Suite target to which you have been granted access in Enterprise Manager.

2. After you choose a target, a list of hosts is displayed in a separate window along with the log file directory for each host.

3. From this window you can choose the log file(s) you want to view online or download to your computer as a ZIP file.
Prerequisites for viewing Patch Manager logs

To access the Patch Manager Log Viewer, you must have your preferred credentials set for the Oracle E-Business Suite Node target(s) of all middle tier hosts. To set these, the navigation in Enterprise Manager is Setup > Security > Preferred Credentials > Oracle E-Business Suite Node. These credentials are required in addition to the credentials needed to use Patch Manager.

In addition, you must have been granted the privilege to raise a Patch Manager request.

For more information, see: Overview of Credentials, page 5-1 and Privileges for Change Management, page 7-5.
Abort Deployments

This region shows all of the executions of the "Abort an Oracle E-Business Suite Online Patch Cycle" deployment procedure.

You can submit a request to run an Abort operation against a specific target using the Submit Abort icon.

This region is hidden by default. To have this region appear on the Patch Manager home page, use the Personalize Page icon on the home page.

Cutover Deployments

This region displays all executions of the "Cutover Oracle E-Business Suite" deployment procedure. This region is hidden by default. To have this region appear on the Patch Manager home page, use the Personalize Page icon on the home page.

You can submit a request to perform the cutover operation using the Submit Cutover icon.

Records can be filtered by status using the "Show" list. The "Pending Patches" button
displays all patches that have been applied but not cutover.

Prerequisites

The following are prerequisites to running a patching procedure. Unless otherwise noted, they apply to all Oracle E-Business Suite releases:

1. To download an Oracle patch directly from My Oracle Support, the following property must be set in the Preferences page.
   - **Connect to My Oracle Support for Patches** - This box should be checked.

2. Patches are downloaded to the OMS when they are applied. Set the preference **OMS Patch Stage Directory Location** to the directory to which the patch should be downloaded.

   **Note:** If a patch has already been downloaded to the OMS, it will not be downloaded again.

   After a patch is on the OMS, it will then be moved to the target Oracle E-Business Suite system. The exception to this step is the case in which the system detects that an Oracle patch is already on the target; the system will not move the patch from the OMS to the target again. Custom patches, described in the next chapter, will always be moved from the OMS to the target because a developer can change the patch.

3. The following preferences are set to directories under the APPL_TOP by default. In general, you should leave these set to the default locations. You can override the default locations, but ensure that the Target Patch Directory Location is not shared amongst multiple Oracle E-Business Suite instances. The Target Stage Directory Location can be shared if all users accessing it have read/write permissions for all files.
   - **Target Stage Directory Location** - The directory to which zipped patches are downloaded.
   - **Target Patch Directory Location** - The directory to which patches are unzipped and from where the patches are applied.

   For more information, see: Setting Preferences, page 6-1.

4. **(Oracle E-Business Suite Release 12.1 and earlier only)** As part of a queueing mechanism for patch runs, set the property **Minutes Patch Manager should wait for a down target**.

   If a patch run is executing and detects that a target(s) that it is supposed to patch is in a blackout state, the patch run will wait this specified time before failing. Patch
Manager will check every minute to see if the target has come out of the blackout state; if it has, Patch Manager will continue with the patch run. This property specifies in minutes the maximum length of time Patch Manager will wait before the patch run fails.

5. Patch Manager uses Preferred Credentials. These must be set prior to running a patch procedure. Navigate to Setup > Security > Preferred Credentials to set these. The Preferred Credentials that might be required are:
   - Oracle E-Business Suite Node credentials must be set to the applmgr account for middle tiers and Oracle account for database tiers.
   - Oracle E-Business Suite must have the "AppsDBCredSet" (the APPS schema) and "AppsSysDBCredSet" (the SYSTEM schema) set.
   - Oracle WebLogic Server preferred credentials must be set for Oracle E-Business Suite Release 12.2 targets.

   **Note:** Database credentials are not required for Oracle E-Business Suite Release 12.2 targets.

For more information, see: Overview of Credentials, page 5-1.

**Blackout Periods**

During the patching deployment process, the system will try to "black out" the targets associated with an Oracle E-Business Suite system. In order for the blackout to occur, the user submitting the patch run must have been granted the 'operator' or 'blackout target' target privilege for the Oracle E-Business Suite targets. Below is a list of Oracle E-Business Suite targets that will be blacked out if the system detects this user has the authority to black them out:

- Concurrent Processing Service
- Forms Based Applications Service
- Internal Concurrent Manager
- Listener
- Oracle Applications Infrastructure Service
- Oracle Applications Service
- Oracle Applications System
- Oracle Concurrent Manager
• Oracle E-Business Suite Custom Objects
• Oracle E-Business Suite Infrastructure
• Oracle E-Business Suite Nodes System
• Oracle E-Business Suite Patch Information
• Oracle E-Business Suite System
• Oracle E-Business Suite Workflow
• Oracle Workflow Agent Listener
• Oracle Workflow Background Engine
• Oracle Workflow Notification Mailer
• Self Service Applications Service
• Workflow Service
• Database Instance
• Host

By default, the blackout time period is one hour. You can control the blackout duration setting the following properties in the Preferences page: Navigate to this page from the Preferences link under Related Links on the Oracle E-Business Suite home page.

• **Default Blackout Hours in Patch Manager**

• **Default Blackout Minutes in Patch Manager**

In addition, as part of a queueing mechanism for patch runs, set the property Minutes **Patch Manager should wait for a down target**. If a patch run is executing and detects that a target(s) that it is supposed to patch is in a blackout state, the patch run will wait this specified time before failing. Patch Manager will check every minute to see if the target has come out of the blackout state; if it has, Patch Manager will continue with the patch run.

Finally, for targets of Oracle E-Business Suite Release 12.1 and earlier, if you want AutoPatch to apply a patch regardless of whether the Oracle E-Business Suite system is in Maintenance Mode (and Maintenance Mode is enabled), then check the **Default Hotpatch in Patch Manager** box.
Creating a Patch Run (Release 12.1 and Earlier)

To create a patch run for Release 12.1 and earlier, ensure you have completed the prerequisite steps described earlier. Then navigate to Targets > Oracle E-Business Suite > Administer > Change Management > Patch Manager. From the Patch Manager home page, select "New Deployment" in the Patch Runs region.

Note that you can also copy an existing patch run. From the Home page, select the patch run you wish to copy and click the Create Like icon.

**Note:** In the Patch Run interview you can use the Back button to go back to a previous step; however, entered values on the current page will be lost.

To create a Patch Deployment for Release 12.1 and earlier:

1. In the Deployment Details page, enter the details below.
   - Patch Deployment Name - Enter a user-friendly name for the patch run. You can search on this name later on.
   - Target System Name - Choose the target system.
     Click the Verify Credentials button to test the Preferred Credentials for the applications system.
     Select Override Patch Nodes to choose the hosts on which adpatch will run.

In the Deployment Details page, enter the details below.
- Patch Deployment Name - Enter a user-friendly name for the patch run. You can search on this name later on.
- Target System Name - Choose the target system.
  Click the Verify Credentials button to test the Preferred Credentials for the applications system.
  Select Override Patch Nodes to choose the hosts on which adpatch will run.
The default host name is pre-populated. This option provides support DMZ configurations where some nodes contain a shared APPL_TOP and some nodes do not.

**Note:** You can select only one Oracle E-Business Suite target.

- **Workers** - The number of workers available on the system. Note that you can change this value.
- **Description**
- **Justification**
- **Requestor** - The default value is the user name with which you are signed in. You can change this to another name.
- **Notification Email(s)** - Enter the email addresses of users who should be notified of the patch run request. These users could review and approve the request, as appropriate.

2. In the Patch Details page, search for the patch(es) to be applied.

You can search on the following criteria:

- **Patch Number**
- **Language** - "All installed languages" will return the base (Generic or platform-specific) patch plus any language patches (if they exist) for every
language installed on the selected targets. Choosing a specific language from the drop-down list will return its language patch if it exists plus the base patch.

- Created By
- Platform - Select "Generic Platform" if patch is not port-specific.
  
  If you are searching for a patch for a specific platform, your search results will return a Generic-platform patch if no platform-specific patch exists.

From the Patch Search Results table, select which patch(es) you wish to apply.

The search results will include the following for each patch found:
- Patch Number
- Platform
- Language
- Description
- Created By
- Replaced By
- Patch Name
- Product
- Release

The following appears for each patch in the Selected Patches table.
- Order - The order in which the patches should be applied. This will be displayed only when you have more than one patch selected and do not have the Merge Patches button selected. You can then reorder the patches.
- Patch Number - The patch number.
- Patch Name
- Platform - The platform for the patch.
- Language
- Description
- Product - The name of the owning product.
• README - Click on this icon to review the README file for the patch.
• Created By - The user who created the patch (for custom patches).
• Replaced By - The patch number that replaces this patch, if any.
• Release - The release to which the patch is valid.
• Files - The files to be downloaded for the patch.
• Remove - If you want to remove this patch from the list, click this icon.

**Note:** For a controlled-release patch, a password is necessary for downloading the patch. An icon appears, which you can click to enter a password. Passwords expire after a set duration, so for scheduled deployments further in the future, make sure you have already downloaded the patch and staged it.

Use the **Merge Patches** button if you wish to merge two or more patches.

**Note:** You should merge AD patches separately from non-AD patches.

Finally, you can check for prerequisites for your patches using the **Check Prerequisites** button.

**Specify the schedule and patching options for the patch application**

1. Specify a schedule.

![Oracle EM 12c Patch Manager](image)

You can choose to apply the patches immediately or at a later date.

If you choose Start Immediately as the schedule type to have the patches applied immediately.

If you choose Schedule, you can specify the time and date you wish to have the patches applied. Provide the Date, Time, and Time Zone.

You can specify a Grace Period as well. If you choose an Indefinite Grace
Period, then if for some reason the patches cannot be applied at the immediate time, the system will try to apply them as soon as possible, and will keep trying indefinitely. If you provide a defined Grace Period by specifying the system to end the Grace Period after your given hours and minutes, the system will not try to apply the patches after that amount of time.

The Blackout Length indicates the amount of time the target system will have a blackout status in Enterprise Manager. Set this length to a higher value for large patch runs.

2. Specify Patch Options.

Specify details for how the patch should be applied.

For more information on many of these options, see: Oracle E-Business Suite Patching Procedures and Oracle E-Business Suite Maintenance Utilities.

**Patching Procedure Options** include the following:

- Create Target Backup Before Patching - Adds a pause after system is prepared for backup allowing for a manual backup.
- Create Target Backup After Patching - Adds a pause after patch is applied and database is brought back down to allow for a manual backup.
- Enable HotPatch Mode - Patch will be applied without shutting down the applications or database, disabling archive mode, or enabling maintenance mode.

In HotPatch mode, AutoPatch applies a patch regardless of whether the Oracle E-Business Suite system is in maintenance mode. Maintenance mode controls the system downtime period by managing user login sessions.

**Note:** In HotPatch mode, if the patch application fails, the
process will still perform/execute the blackout steps in the "Patch Oracle E-Business Suite" procedure. The blackout notifies other Enterprise Manager administrators that a maintenance procedure is being performed on the environment.

- Disable Archive Mode - Issues an 'alter database noarchivelog' command.

- Pause Before AutoPatch Steps - Adds a pause before AutoPatch (adpatch) is run to allow for any necessary manual preparation.

  AutoPatch (adpatch) is the Oracle Applications DBA (AD) tool that applies patches to an Oracle E-Business Suite system.

- Pause After AutoPatch Steps - Adds a pause immediately after patch is applied to allow for any necessary manual activities.

- Run AutoConfig - Run AutoConfig, the AD tool that manages configuration changes in an Oracle E-Business Suite system.

**AutoPatch Options** include the following:

- Disable JSP Compilation - Tells adpatch not to automatically compile out-of-date JSP files (nocompilejsp command).

- Disable Invalid Objects Compilation - Tells adpatch not to compile invalid objects (nocompiledb command).

- Enable Schema Validation - Tells adpatch to connect to all registered Oracle E-Business Suite schemas at the start of the patching process.

- Disable File Generation - Tells adpatch not to run commands normally found in generate driver (nogenerateportion command).

**AD Administration Options** are listed below. These tasks are done to manage database objects (database objects or data in the database related to Oracle E-Business Suite). For example, a patch might add new menu entries or change the setup of a flexfield.

- Generate Message Files - Creates new message files after the messages have been loaded into the database. The README should instruct you when this is necessary.

- Compile APPS Schema - Compiles the APPS schema.

- Compile Menu Information - Compiles menus.
• Compile Flexfields - Compiles flexfields.
• Recreate Grants and Synonyms for APPS Schema - Recreates grants and synonyms for the APPS schema.
• Relink Application Programs
• Generate Product JAR Files
• Generate Reports Files
• Generate Form Files

For the **Notifications** region, specify the statuses for which you would like to be notified.

3. Review your patch deployment.

![Review Page](image)

The Review Page lets you review your patch run details, target list, patch details, patching options, and schedule.

**Copying a Patch Run for Release 12.1 and Earlier**

You might want to copy an existing patch run to change some aspect of it or to rerun it due to changes in the patch or target. To do this, select the patch run in the Patch Manager Home page and click the **Create Like** icon.

The system will take you through the patch deployment creation pages as if you were creating a new patch run, but with most values copied from the original patch run. Please note the following:
• The Patch Deployment Name defaults to the original name prefixed with "Copy of" and appended with the date.

• The Requestor field has a default value of the original requester’s user name. Change this value as appropriate.

• The new patch run would be scheduled to run immediately by default, because the original run may have been scheduled for a now past date and time.

Creating Patch Deployment Procedures for Oracle E-Business Suite Release 12.2

To create a Patch Deployment:
Ensure that you have completed the prerequisite steps described earlier.

Navigate to Targets > Oracle E-Business Suite > Administer > Change Management > Patch Manager. From the Patch Manager home page, select "New Deployment" in the Online Patching region.

1. On the Deployment Details page, enter the details below.
   • Patch Deployment Name - Enter a user-friendly name for the deployment procedure. You can search on this name later on.

   • Target System Name

   • Verify Credentials - Click this button to check your credentials. This feature ensures that valid preferred credentials are set for you. For information on credentials, see: Overview of Credentials, page 5-1.

   • Oracle E-Business Suite Node credentials (all middle tiers, no database tier credentials are required)

   • System schema credentials

   • APPS schema credentials

   • WLS domain credentials

   • Description

   • Justification - Enter a justification that can be used by an approver deciding to approve or reject this request for patching.

   • Requester - The default value is the user name with which you are signed in. You can change this to another name.
• Notification Email(s) - Any users listed here will be notified when the patching deployment request is sent to approval management.

  **Note:** These notifications are different from notifications sent regarding the status of a submitted deployment procedure.

2. In the Patch Details page, search for the patch to be applied.
You can search for a patch based on the following criteria:

- Patch Number
- Language
- Created By
- Platform

**Note:** You must retrieve the desired patch through the Search region even if you have already downloaded the patch to the stage location (the process will not re-download the patch, however).

The act of searching will search:

- Custom patches if a patch number greater than 11 characters has been entered or no patch number has been entered.

- Oracle patches if the patch number is less than 12 characters and the "Connect to My Oracle Support for Patches" preference is checked in the Preferences page. Since the target has already been chosen at this point in the interview process, the search will examine the target and search for only patches that are relevant with respect to languages and platform.

- Downloaded patches if the patch number is less than 12 characters and the "Connect to My Oracle Support for Patches" preference is unchecked in the Preferences page.

Selecting the **Merge Patches** option will merge the patches when running adop
Selecting the **Check Prerequisites** option will connect to My Oracle Support (MOS), check the prerequisites for all the selected patches, and then check the target system to see if those patches have been applied. You must have "Connect to My Oracle Support for Patches" enabled in the Preferences page to use this option.

The patch application order can be modified by clicking the "Move Up" and "Move Down" arrows.

Note that this page does not require any patches be selected. With Release 12.2, an "empty" patching cycle is supported in Patch Manager where only prepare, finalize, cutover, and cleanup are run.

The following appears for each patch in the Patch Search Results Table:

- **Add** icon
- **Patch Number** - The patch number.
- **Platform** - The platform for the patch.
- **Language**
- **Description**
- **Created By**
- **Replaced By**
- **Patch Name**
- **Product** - The name of the owning product.
- **Release**

Click on the Add icon to add a patch to your patch deployment. It will appear in the Selected Patches table.

The following appears for each patch in the table.

- **Remove** - If you want to remove this patch from the list, click this icon.
- **Order** - The order the patches should be applied. Use the Up and Down icons to change the order of the patches.
- **Patch Number** - The patch number.

**Note:** For a controlled-release patch, a lock icon appears next to the patch number. Click on the icon to enter a password.
Passwords expire after a set duration, so for scheduled deployments further in the future, make sure you have already downloaded the patch and staged it.

- Platform - The platform for the patch.
- Language
- Description
- Readme
- Created By
- Replaced By
- Patch Name
- Product - The name of the owning product.
- Release
- Files - The files to be downloaded for the patch.

3. Specify Patch Options.
With Oracle E-Business Suite Release 12.2 the adop patching process required two deployment procedures. The first deployment procedure runs the prepare, apply, finalize, and optionally actualize_all phases. The second deployment procedure executes cutover, cleanup, and optionally fs_clone.

On the options page you determine when each of these deployment procedures are executed. The first deployment procedure (that runs adop prepare, apply, finalize, and optionally actualize_all) can be started immediately upon submission or scheduled. If the "Schedule" option is selected, a date field is dynamically displayed. The grace period is the amount of time Enterprise Manager should wait if the Enterprise Manager job system cannot start the deployment procedure at the intended time.

Specify details for how the patch should be applied.

**Patch Application Deployment Procedure**

Specify the **Start Options**:
• Start Immediately

• Schedule

• Indefinite Grace Period

For the Prepare phase, specify **Pause After Prepare**. This option will stop execution of the deployment procedure after the adop prepare phase has been run. A user would then need to manually acknowledge the pause for Enterprise Manager to continue with the next step.

For the Apply phase, specify **Pause After Apply**. This option will stop execution of the deployment procedure after the adop apply phase has been run. A user would then need to manually acknowledge the pause for Enterprise Manager to continue.

For the Apply phase, specify **Actualize All Objects**. This option will run the adop actualize_all phase. If this option is chosen then the cleanup mode is switched to "full".

For the Apply phase, specify **Hotpatch**. This option will disable all other adop phases and run adop in hotpatch mode. This option is not supported unless specifically stated in the patch readme. A warning message is also displayed in Patch Manager when this option is chosen.

For the Finalize phase, specify the **Finalize Mode**. This option runs adop finalize phase in either Quick or Full mode.

Specify **Pause After Finalize**. This option stops the execution of the deployment procedure after the adop finalize phase has been run. A user would then need to manually acknowledge the pause for Enterprise Manager to continue.

**Cutover Deployment Procedure**

Specify the **Cutover Options**.

The Cutover deployment procedure has three options for execution:

• Start Immediately

• Schedule

• No Cutover

It can start immediately or be scheduled as above. In this case an immediate start means immediately after the "apply" deployment procedure executes. If a user schedules this deployment procedure and the apply deployment procedure is still running after the schedule date the apply deployment procedure will fail when it attempts to submit cutover. The cutover deployment procedure can also be skipped entirely with the "No Cutover" option. "No Cutover" may be useful on a development environment where ten developers are patching a single target and
they only want to bounce the instance at midnight. Another example may be when a prerequisite patch was missed. In this situation a user could do a patch run through finalize with the missed prerequisite then restart the original failed deployment procedure.

Check the **Indefinite Cutover Grace Period** box if you want Enterprise Manager to wait an indefinite amount of time if the Enterprise Manager job system cannot start the deployment procedure at the intended time.

For the Cutover phase, the **Restart Middle Tier** is selected by default. When cutover is run, this option controls whether the middle tier is restarted.

The **Pause After Cutover** option stops the execution of the deployment procedure after the adop cutover phase has been run. A user would then need to manually acknowledge the pause for Enterprise Manager to continue.

For the Cleanup phase, choose whether you want the **Cleanup Mode** be run as Quick or Full.

For **FS Clone**, specify if you want to run a full file system synchronization.

### Notifications

For the Notifications region, specify for which statuses you want notifications to be sent. Users will be notified of a given status if the box is checked and either of the "Apply" or "Cutover" deployment procedures fall into that status.

Statuses for notifications are:

- Action Required
- Problems
- Succeeded
- Running
- Suspended

4. Review your deployment procedure.
The Review Page lets you review your deployment procedure details.

**Extending Patch Manager Deployment**

You can extend Patch Manager procedures using the Deployment Procedure Manager using the steps below. In these steps you create a copy of an existing procedure and extend it in the Deployment Procedure Manager.

1. Navigate to Enterprise menu > Provisioning and Patching > Procedure Library.

2. Extensions are supported for the following two patching procedures for Oracle E-Business Suite:
   - "Patch Oracle E-Business Suite" (for Release 12.1 and earlier)
   - "Patch Oracle E-Business Suite Online" (for Release 12.2)

   **Note:** Extensions are not supported in the deployment procedures
for cutover and abort.

3. Click the **Create Like** button.

4. Rename the copy of the original procedure as desired. You can make other updates here as well.

5. Save your new procedure.

6. Upon saving, the Deployment Procedure Manager Procedures tab appears. Your new procedure is listed first. You can select this procedure and click **Edit** to add steps, choose notifications, or make other changes. For example, you might want to add steps to a copy of the shipped Patch Oracle E-Business Suite procedure to automate the following steps: Pre-Patch Application Tier Backup, Post-Patch Database Tier Backup, or Post-Patch Application Tier Backup.

For more information on the Deployment Procedure Manager and provisioning in Enterprise Manager, refer to the Enterprise Manager documentation, including:

- *Oracle Enterprise Manager Lifecycle Management Administrator’s Guide*

- Oracle Enterprise Manager online help

**Logging, Health Checks, and Troubleshooting**

This section describes logging, health checks, and troubleshooting features within Patch Manager.

**How to Access Patch Logs**

The primary way to access log files is using the log viewer in the Patch Logs region of the Patch Manager Home page. See: Patch Logs, page 13-8.

Alternatively, you can drill down into the steps within an online patching deployment procedure execution to see the logs.

**How to Restart Failed Workers**

For Oracle E-Business Suite Release 12.1 and earlier targets, use the following steps:

1. Navigate to your patch run using any method in "View a Patch Run".

2. Click on the Patch Run Name.

3. Click on the adpatch step (Apply Patch).
4. Select the check box for the failed target.

5. Click Update and Retry.

6. Change the parameter "restart_workers" to YES and click Retry.

   **Note:** These steps are also listed in the AD Patch Log when you have a failed worker.

For Oracle E-Business Suite Release 12.2 and later targets, use similar steps to those above except navigate to your deployment and go to the adop apply phase step. Select the check box for the failed target, click Update and change the parameter "restart" to Yes and click Retry.

1. Navigate to your deployment and select the it.

2. Click on the adop apply phase.

3. Select the check box for the failed target.

4. Click Update and Retry.

5. Change the parameter "restart" to YES and click Retry.

**How to Change the Patch Run Purge Policy**

Enterprise Manager periodically purges Patch Manager deployment procedure execution data. As a result, older patch runs may not be accessible in Patch Manager. To change the purging frequency, run the following PL/SQL block connected to the repository as SYSMAN:

```sql
BEGIN
    MGMT_JOBS.drop_purge_policy('SYSPURGE_POLICY');
    MGMT_JOBS.register_purge_policy('SYSPURGE_POLICY', <number of days>, null);
END;
```

**Troubleshooting Patch Manager Deployment Failures**

Access the log files is using the log viewer in the Patch Logs region of the Patch Manager Home page. See: Patch Logs, page 13-8.

To find errors using the Enterprise Manager Provisioning feature, do the following:

1. Find your patch run or deployment on the Patch Manager Home page.

2. Click on the status link for the patch run or deployment.

   The Procedure Activity tab of the Deployment Procedure Manager in Provisioning
appears.

3. For a patch run or deployment that failed, click on its Status link.

4. A list of Procedure Steps in the patch run or deployment is shown. Use the dropdown list to filter on the steps shown; for example, choose "Failed Steps" to see the steps that failed. More information on these steps is shown.

Health Checks

Patch Manager validates these servers shutting down and starting up: listener, Forms server, Apache web services, and Internal Concurrent Manager.
This chapter covers the following topics:

- Introduction
- Major Features and Definitions
- Applications Standards Validation
- Working with User-Defined Customization Standards
- Adding a User-Defined Customization Standard
- Oracle-Compliant Source Header
- Uploading Existing Custom Patches
- Automatic File Driver File Generation and Update
- Customization Manager Main Page
- File Source Mapping
- Example of a File Source Mapping with Parameters
- E-Business Suite Mapping
- Creating a Package
- Updating a Package
- Saving a Package
- Searching for a Package
- Viewing Package Details
- Package Reports
- Creating a Report
- Viewing a Report
- Searching for a Report
- Releasing and Sharing a Package
Introduction

Customization Manager automates the process of packaging, releasing and reporting customizations for a single Oracle E-Business Suite instance or multiple Oracle E-Business Suite instances. It provides capabilities to integrate with third-party source control repositories to access customizations that need to be packaged. It also integrates with Patch Manager for deployment of custom patches to one or more Oracle E-Business Suite instances.

Customization Manager also provides a dashboard to manage custom applications across Oracle E-Business Suite instances. It provides capabilities to not only register and validate custom applications across instances, but also a drill down to the custom objects associated with any registered custom application on a given instance. Registration and validation of the custom application ensures that custom packages associated with the custom application can be deployed on the given Oracle E-Business Suite instance.

Key Benefits

- Automates creation of customization packages that are deployable with Patch Manager or standard Oracle E-Business Suite Applications DBA (AD) Utilities
- Provides repository to manage/catalog customizations.
- Validates custom code against software coding best practices using a standards checker. Both Oracle shipped standards and user-defined customization standards can be applied.
- Integrates with most source control systems.
- Supports National Language Support (NLS) patches.
- Generates reports on customization packages or manifests in these formats: rich text format (RTF) for Microsoft Word, PDF, or Microsoft Excel.
- Leverages Oracle Enterprise Manager infrastructure for distributed processing.
- Provides an interface to manage custom applications across the enterprise.

File Types

Customization Manager allows you to package custom files of a variety of file types, including the following:
- Oracle Application Object Library (FND) objects - menus, responsibility, concurrent programs, and so on
- Forms
- Reports
- Database objects - views, tables, triggers, packages, and so on
- Oracle Application Framework components

For more information on file types, see the appendix.

For more information on making customizations, see the Oracle E-Business Suite Developer’s Guide and the Oracle Application Framework Developer’s Guide.

Setup Steps for Customization Manager

- Ensure that the Preferred Credentials are set for each user as described in the Credentials chapter beginning with the section Overview of Credentials, page 5-1.

- Ensure that the Stage Directory is specified in the Preferences page. This property specifies the OMS stage directory for package creation. To set this, navigate to Targets > Oracle E-Business Suite > Administer > Preferences. For more information, see: Setting Preferences, page 6-1.

Major Features and Definitions

Package

A package is a fundamental unit of work of Customization Manager. A package consists of all the relevant objects that constitute a customization along with all the necessary metadata relevant for the given customization. A customization package can have one or more custom patches associated which can be deployed to promote customizations.

File Manifest

The file manifest contains a list of files to be included in a package.

File Metadata Repository

The File Metadata Repository stores metadata information of custom files used to create customization packages. This information can be used to manage and catalog customizations within the system.
Technology Stack Details

The Technology Stack Details for a package is a snapshot of the technology stack properties for the Oracle E-Business Suite instance where the package was compiled.

Reporting

Customization Manager provides several methods for generating reports on packages:

- Generate a Standard report on a single package.
- Compare two packages using a Comparison report.
- The Instance Comparison report can be used to compare a given package against an instance with respect to technology stack, files with versions, missing entries for file driver file, custom products involved, and so on. It can be used to assess the likely impact before actually applying the custom patch on the given instance.

Reports can be generated in RTF for Microsoft Word, PDF, and Microsoft Excel.

Releasing a Package

Once a customization package is created and tested successfully, it might need to be shared with other users. This is possible by updating the package metadata and setting the package status as "Released".

Obsoleting a Package

For scenarios where the given customization is no longer valid, the customization package may be retired by updating the package metadata and setting the package status to "Obsoleted".

Diagnostic Tests

For information on diagnostic tests for this feature, see: Diagnostic Tests for Customization Manager, page 10-12.

Applications Standards Validation

Customization Manager has a standards checker to check that the files included in a custom package meet certain coding standards. This checker tests all code for standards compliance and cannot be turned on or off.

Some standards are mandatory and will result in failure when Customization Manager attempts to build the package. Other standards are recommended, and the standards checker will give a warning but the package will be built.
For example, Customization Manager mandates that each file included within a customization package has an Oracle-compliant source header present within the file. If a file in a package is missing this header, the package cannot be built.

Beginning with Release 12.1.0.3.0, you can define your own standards for Customization Manager.

**Working with User-Defined Customization Standards**

You can add your own standards to the standards checker feature to ensure files included in a custom package meet your custom coding standards.

Use the Custom Standards page to perform the following functions for user-defined customization standards:

- **Add**

  To add a new user-defined customization standard, you must have the either the EBS_CM_RAISE_REL_PKG_REQ privilege and/or the EBS_CM_APPRV_REL_PKG_REQ privilege.

- **View**

- **Edit**

  You can edit only the standards that you created. Released and obsolete standards cannot be edited.

  You can edit the following for a standard: Description, Release, File Type, Severity, and Regular Expression. The Standard Name and Standard Type cannot be edited.

- **Delete**

- **Release**

  After a standard is saved, a user can raise a request to release the standard. Only a user with the EBS_CM_APPRV_REL_PKG_REQ privilege can approve/reject the request. If the request is approved, then the standard will go to Released state; otherwise, it will go back to Saved state. Meanwhile, the standard will be in Pending Approval state. Once released, the standard cannot be edited or deleted.
but can only be obsoleted.

- **Obsolete**
  
  Only released standards can be obsoleted. Once a standard is obsolete, it cannot be edited or deleted.

- **Download**
  
  You can download a list of released user-defined customization standards in HTML format. This list includes the following fields: Standard Name, Standard Type, Description, Release, File Type, and Severity.

In addition, when you create or edit a standard, you have the option to test the standard before saving it.

**Adding a User-Defined Customization Standard**

Use the following steps to create your standard.

1. Navigate to the Custom Standards page from the Customization Manager home page using the link under "Related Links."

2. Click on **Add**.
Enter the following:

- **Standard Name**
- **Description**
- **Release**
  - All - For all supported releases.
  - 11i - For Release 11i.
  - R12 - For Release 12.0 and above.
- **File Type**
- **Severity**
  - Error
• Warning

• Standard Type
  • File Path
  • File Name
  • File Content

• Regular Expression

4. Optionally test your standard. Select a file and click **Test**.

5. Click **Submit** to save your standard.

**Oracle-Compliant Source Header**

Each file included within a customization package is recommended to have an Oracle-compliant source header present within the file.

The following is an example of an Oracle-compliant header:

```
$Header: sample.txt 10.1 2012/04/06 09:38 lmathur ship $
```

The header contains the following elements:

• Filename

• Revision ID - This needs to be incremented every time a file is checked in

• Date and time of checkin

• Author

• Shipment state - ship/noship. For custom files, use the value **ship**.

**Automatic Header Update and Insertion**

This option can be enabled while defining or updating the "File Source Mapping" used for package creation. When the "Automatic header update" option is selected, Customization Manager takes care of querying the source control repository to derive the revision number and updates the Oracle-compliant header present within the file with the same, during the process of package creation.

It is important to ascertain that the correct "Version command" is provided to lookup/query the revision number from the given source control repository, except when using CVS or File System. This feature is not supported when the source
repository is 'File System'. Also, for CVS there is no need to specify the version command as the header is always looked up from the $Header string present within the file.

**Important:** When using the automatic header update feature with CVS, you must have a $Header placeholder within each source file. The placeholder header must be embedded in the source file before the file is checked in into CVS.

Also ensure that you change the file name with the correct case within the $Header before embedding the header in the file.

**Important:** When using Subversion, it is required to use Subversion client version 1.2 or above for automatic header update.

**Automatic header update** is supported for all file types. For binary files like forms, reports, and so on, you must provide a dummy placeholder for the header with enough appropriate offset (space). It is recommended to leave at least 40% extra offset (space) to accommodate incrementing revision numbers. During the process of package creation, the system uses this as a placeholder and updates it with the correct header. Again, the automatic header update option should be enabled and the correct version command should be specified within the file source mapping. The header is calculated based on the release and the version in the source control. For example, if you are building a package for Release 12 and the version of the file in the subversion repository is 29, then the header version calculated would be 120.29.

**Automatic header insertion** is supported only for selected file types when using Subversion as the source control system. In this case, Customization Manager inserts a valid Oracle compliant header into the source file during the process of package creation, even when there is no $Header present in the file. The following file types are supported for automatic header insertion in case the file does not contain a proper $Header:

- .css
- .drvx
- .htm
- .html
- .ildt
- .java
- .jlt
Adding a Header to Custom RTF Files

You can add a header to a custom RTF file by adding it to the file’s "Comments" property. For example, in Microsoft Word, navigate to the File menu, select Properties, and enter the header in the Comments field as shown in the figure below.
Uploading Existing Custom Patches

You can upload a custom patch to Customization Manager repository:

The upload option is provided to upload existing custom patches created in the Customization Manager repository. On upload, a package with status "Succeeded" is created. The status can move to status "Released" or "Obsoleted" as other customization packages. One or more NLS patches can be uploaded for a given package. Once uploaded, the patches can be deployed using Patch Manager. Also, attachments can be added for the uploaded packages.

Note: Reporting and update capabilities are not available for the uploaded packages.

Automatic File Driver File Generation and Update

A file driver file is a master file for adpatch to identify valid Oracle E-Business Suite files for a given product (including a custom product). It is required to have an entry
within the file driver file for selected file types like forms, reports, and so on. If not, then the following error is thrown during patching: "File in patch is not a known Oracle Applications file".

Customization Manager takes care of this file driver file requirement automatically. Customization Manager implicitly generates a file driver file for the relevant files in a package. During deployment with Patch Manager, these entries are automatically added to the custom product master file driver file. In case a user applies a patch manually with adpatch, he or she can run updateFileDriver.pl within the <package>/meta-inf folder before invoking adpatch.

Note that if you get the error "File in patch is not a known Oracle Applications file" while applying a custom patch built with Customization Manager, then it could be due to a missing entry in file driver file for the custom product for one or more custom files.

The file driver file for a custom product is located under:

$<custom_product_top>/admin/driver/<custom_product_short_name>file.drv

For example, if XXCO is the custom product, then you can find the file driver file under $XXCO_TOP/admin/driver/xxcofile.drv

All custom files would require an entry in the respective file driver file depending on the custom product they belong, EXCEPT files which have destination path beginning with any of the following:

- admin
- sql
- mds
- lib
- patch
- help
- def

as well as any java file under destination path beginning with "java".

The usual format for an entry into the file driver file is:

<product>  <subdirectory>  <filename>

Sample entries are as below:

xxco    admin/sql XXCONLADD.sql
xxco    forms/<LANG> XXCOFORM.fmb
The main page for Customization Manager lists packages that are registered in the system. For each package, the following is given:

- **Name** - The name of the package.
- **ID** - The ID of the package. This is always unique across packages.
- **Product** - The owning product or custom application.
- **Type** - The type of package. Valid values include AOL, FORMS, PL/SQL, XML Publisher, OAF, and Others. This is purely for classification purposes and has no bearing on the functionality of the package.
- **Status** - The status of the package. Valid values include Saved, In Progress, Failed, Succeeded, Released, Pending Approval, and Obsoleted. Note that some actions are restricted based on the status of a package.
- **Owner** - The owner of the package. Note that some actions are restricted based on the owner of a package.
- **Last Updated** - The date and time the package was last updated.
- **Update** - Use this icon to update a package.
- **Delete** - Use this icon to delete a package.

You can search for a package based on its name or ID, or click the "Advanced Search"
The following functions are available for a given package (depending on its status and ownership):

- Using the procedure specified, deploy the package as a patch job in Patch Manager using the **Deploy** button. Packages with statuses "Succeeded" or "Released" can be deployed.

- Update the package metadata using the **Update Metadata** button. Packages with the statuses Succeeded or Released only can be updated for metadata changes, provided they are owned by the user currently logged in.

- Run a report on the package using the **Report** button. Packages with statuses Succeeded, Released or Obsoleted can be used for reports.

- Create a copy of a package using the **Create Like** button.

You can also create a new package using the **Create** button or upload an existing package using the **Upload** button.

Use the Related Links at the bottom of the page to access the following features:

- File Source Mapping
- E-Business Suite Mapping
- Package Report
- File Metadata Repository
- Custom Applications
- Custom Application Requests
- Custom Standards
File Source Mapping captures all the required metadata for retrieving custom files from a source control or file system repository. Creating a File Source Mapping is usually performed once as a setup step. You may create one or more File Source mappings, if required.

The main File Source Mapping page allows you to search for a File Source Mapping by name. The table lists each mapping with the following:

- **Name** - The name given to the mapping. Click on the link to go to the Update File Source Mapping page.

- **Host Name** - The name of the host from where the source control or file system is accessible.

- **Source Type** - The type of the source control system. Valid values are: SubVersion, CVS, File System, or Others.

- **Owner** - The user who created this File Source Mapping.

- **Last Updated** - The date and time the mapping was last updated.

- **Enabled** - Specifies if the mapping is enabled or disabled. You can enable/disable a mapping in the Update File Source Mapping page.

- **Public** - Whether the given mapping is public. If a mapping is public, all users can view it, but only the owner and Super Administrators can edit it.

- **Delete** - Use the icon provided to delete a mapping. You can delete a mapping only when no package is associated with it.
To create a File Source Mapping:

Perform the following steps to create your File Source Mapping. Note that for the checkout command, you should follow the checkout command syntax provided on the page.

1. Enter the name for the file source mapping.

2. Enter the host name of the file source mapping. You can select the host from the list of values.

3. Enter the stage path. This should be a folder on the given host with read/write access which is used for temporary processing during checkout.

4. Select the source control type. Possible values are:
   - SubVersion
   - CVS
   - File System
   - Others

The source control type is used to default the checkout command. However, the checkout command can be modified based on your source control or file system configuration. If your source control system is not among CVS, SubVersion or File System, then you may choose “Others” and enter your checkout command.

5. Enter the complete command, with required parameters, to be used to check out files. The parameters that can be used to construct the checkout command are mentioned under the "Checkout Command Syntax: section. Oracle strongly recommends that you to test the checkout command by using the "Test Checkout Command" option. It is also important to ascertain that the user provided within the "host" credentials has the correct permissions on the given host selected for
6. Optionally enter the environment script to be run before files are checked out, to set any environment parameters or preprocessing, if required.

7. Enter a description for your reference.

8. Mark the file source mapping as Public if desired.

   If a file source mapping is marked as Public, any user can view it and use it to create a package. However, only the owner and Super Administrators can edit the file source mapping.

   This feature is typically useful when you would want the system administrator to create one mapping and enable all developers to use them, without having them know the details of the source control system.

   Note that a Super Administrator can see all transactions. A Super Administrator can access all file source mappings, Oracle E-Business Suite mappings, reports, and packages. A Super Administrator can also modify and delete them.

9. The "Test Command" feature allows you to test the checkout command and the version command provided on the remote checkout host. It is strongly recommended that you test the checkout command and version command to help prevent any failures during checkout while creating a package. Enter Test Checkout Command information

   Enter the following:
   - Product
   - Source Path
   - File Name
   - Version
   - Language
• Branch - If your source control system requires it and if %branch% token is included within the checkout command.

• Tag - If your source control system requires it and if %tag% token is included within the checkout command.

• User Name - If your source control system requires it and a %user_name% token is included within the checkout command.

• Password - If your source control system requires it and a %password% token is included within the checkout command.

Use the Preview or Test button to preview or test the checkout command and version command. The results will be shown in the Command Preview or Test Results field.

To create a File Source Mapping using the "Create Like" option:
Select the "Create Like" button to create a file source mapping by copying the details from an existing file source mapping. This procedure can be used typically to create a mirror copy of the file source mapping or create another file source mapping with minor modifications without having to enter all the relevant details about the file source mapping.

To update a File Source Mapping:
You can update a File Source Mapping by clicking on its name listed in the main File Source Mapping page. You can only update the fields described below. It is not possible to update the host for a given file source mapping.

Note that you can check or uncheck the Enabled box to enable or disable a file source mapping.

1. Enter the source control type. Possible values are:
   • SubVersion
   • CVS
   • File System
   • Others

2. Enter the complete command, with required parameters, to be used to check out files.

3. Enter the stage path. The stage path is the location of the directory, with write permissions, to where the files would be checked out.
4. Optionally enter the environment script to be run before files are checked out, to set environment parameters.

5. Enter a description.

6. Mark the file source mapping as Public if desired. If it is marked as Public, all users can view the mapping. However, only the owner and Super Administrators can edit it.

7. The separate preview and test section is provided so that you can preview the checkout command and test it on the remote checkout host. It is strongly recommended that you test the checkout command before actually using it to create a package.

Enter the following:
- Product
- Source Path
- File Name
- Version
- Language
- Branch
- Tag
- User Name
- Password

Use the Preview or Test button to preview or test the checkout command. The results will be shown in the Command Preview or Test Results field.

**Example of a File Source Mapping with Parameters**

The following table provides information on the file source mapping parameters and sample values for each parameter.
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Related User Interface Page</th>
<th>Sample Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>%product_code%</td>
<td>Substitution variable for the product code</td>
<td>Create/Update Package - File Listing</td>
<td>xxco</td>
</tr>
<tr>
<td>%file_path%</td>
<td>Substitution variable for source path</td>
<td>Create/Update Package - File Listing</td>
<td>patch/115/import</td>
</tr>
<tr>
<td>%file_name%</td>
<td>Substitution variable for file name</td>
<td>Create/Update Package - File Listing</td>
<td>Custom_Responsibilities.l dt</td>
</tr>
<tr>
<td>%version%</td>
<td>Substitution variable for version</td>
<td>Create/Update Package - File Listing</td>
<td>115.32</td>
</tr>
<tr>
<td>%lang_code%</td>
<td>Substitution variable for language</td>
<td>Create/Update Package - File Listing</td>
<td>US</td>
</tr>
<tr>
<td>%branch%</td>
<td>Substitution variable for branch</td>
<td>Create/Update Package - General</td>
<td>Prod13</td>
</tr>
<tr>
<td>%tag%</td>
<td>Substitution variable for tag</td>
<td>Create/Update Package - General</td>
<td>Release12c</td>
</tr>
<tr>
<td>%user_name%</td>
<td>Substitution variable for username</td>
<td>Create/Update Package - General</td>
<td>developer1</td>
</tr>
<tr>
<td>%password%</td>
<td>Substitution variable for password</td>
<td>Create/Update Package - General</td>
<td>welcome1</td>
</tr>
</tbody>
</table>

Here is the syntax of a checkout command with the parameters:

```bash
svn cat
gfile:///usr/local/svn/%product_code%/%file_path%/%lang_code%/%file_name%
--username %user_name% --password %password% > %file_name%
```

Here is the above checkout command with values substituted for the parameters:

```bash
svn cat
gfile:///usr/local/svn/xxco/patch/115/import/US/Custom_Responsibilities.l dt
--username developer1 --password <password> >
Custom_Responsibilities.l dt```
E-Business Suite Mapping

Creating an E-Business Suite Mapping is an optional setup step. This mapping is used if Java or PLD file compilation is required. It is also used for report generation. The E-Business Suite Mapping indicates the Oracle E-Business Suite instance which would be used to compile Java or PLD files or used for report generation. Please note that all operations on this instance are read-only and using an instance for E-Business Suite mapping cannot cause any kind of change on the given instance via Customization Manager.

The main E-Business Suite Mapping page allows you to search for an E-Business Suite Mapping by name. The table lists each mapping with the following:

- **Name** - The name given to the mapping. Click on the link to go to the Update E-Business Suite Mapping page.
- **Instance Name** - The name of the Oracle E-Business Suite instance.
- **Owner** - The user who created this mapping.
- **Last Updated** - The date the mapping was last updated.
- **Enabled** - Specifies if the mapping is enabled or disabled. You can enable/disable a mapping in the Update E-Business Suite Mapping page.
- **Public** - Whether this E-Business Suite Mapping is available for all users. If a mapping is marked as Public, all users can view it, but only the owner and Super
Administrators can edit it.

- Delete - Use the icon provided to delete a mapping. You can delete a mapping only when there are no packages associated with it.

Select the Create button to create a new mapping.

**To create an E-Business Suite Mapping:**

Use the following steps to create an E-Business Suite Mapping.

1. Enter a name for the mapping.

2. Enter the name of the reference Oracle E-Business Suite instance. Options for this instance are automatically discovered by Oracle Application Management Pack for Oracle E-Business Suite.

3. Mark the mapping as Public, if desired.

   If an E-Business Suite Mapping is marked as Public, any user can view it and use it to create a package, but only the owner and Super Administrators can edit it.

   This feature is typically useful when you would want the system administrator to create one mapping and enable all developers to use them, without having them know the details of the source control or Oracle E-Business Suite system.

   Note that a Super Administrator can see all transactions, including E-Business Suite mappings. A Super Administrator can access all file source mappings, E-Business Suite mappings, reports, and packages. A Super Administrator can also modify and delete them.

4. Enter the stage path. The stage path is the location of the directory with write permissions used for temporary processing during compilation and build process.
5. Enter the prepend classpath. This field is valid only with Java files; this classpath is prepended to these files when a package is built. This can be used to specify any third party libraries if you custom java files have dependencies on them.

6. Enter a description for the mapping.

**To create an E-Business Suite Mapping using the "Create Like" option:**
Select the Create Like button to create an E-Business Suite Mapping by copying the details from an existing E-Business Suite Mapping. This procedure can be used typically to create a mirror copy of the E-Business Suite mapping or create another E-Business Suite Mapping with minor modifications without having to enter all the relevant details about the E-Business Suite Mapping.

**To update an E-Business Suite Mapping:**
To update an E-Business Suite Mapping, click on its name in the main E-Business Suite Mapping page. Note that you cannot update the E-Business Suite Mapping name or the instance mapping here.

1. Check the Enabled box if you want the E-Business Suite Mapping to be active.

2. Check or uncheck the "Public" box depending on whether the mapping should be viewable by all users.

3. Enter the stage path. The stage path is the location of the directory with write permissions to where files would be compiled.

4. Enter the prepend classpath. This field is valid only with Java files; this classpath is prepended to the environment classpath during package compilation.

5. Enter a description for the mapping.

**Creating a Package**

Use the following procedures to create packages:

**To create a package:**
1. Enter general information for the package. The Package ID is an auto-generated unique number.
• Package Name - Enter a user-friendly name for the package.

• Release - Select 11i for Release 11i or R12 for Release 12.0 and above.

• Product - Enter the owning product application. This product can be a custom product created in Oracle E-Business Suite (not in Customization Manager).

• Package Type - Enter the package type. This value is for your own classification and convenience for searching and cataloging. No validation is performed on this field.

• Description - Enter a description for your reference. This description becomes part of the package readme.

• File Source Mapping - Enter the File Source Mapping for this package. Select from the list of previously-defined mappings.

• Branch - Enter the branch for the source control system, if required. The branch will be substituted for the %branch% token within your checkout command.

• Tag - Enter the tag for the source control system, if required. The tag will be substituted for the %tag% token within your checkout command.

• User Name - Enter the user name to connect to the source control system, if required. The User Name will be substituted in the "%user_name%" parameter of the checkout command.

• Password - Enter the password for the above user name, if required. The password entered here would be substituted for the %password% token within your checkout command.

• Upload Manifest - If you have a file manifest in a comma-separated value (CSV) format on your computer, you can upload it here.

The following is an example of a file manifest:
You may add or remove file entries manually from the File Listing page. Alternatively, you may also include file entries from the File Metadata Repository using the **Include Files** button.

For each file, enter the following:

- **Product** - The owning product application. This product can be a custom product created in Oracle E-Business Suite (not in Customization Manager). This would be substituted in the "%product_code%" parameter in the checkout command.

- **Source Path** - The source directory for the file on the source control system or file system. This would be substituted in the "%file_path%" parameter in the checkout command.

- **File Name** - The name of the file. This would be substituted in the "%file_name%" parameter in the checkout command.

- **Version** - Optional. The version of the file. The version is only needed if the
checkout command will use the version information. This would be substituted to the "%version%" parameter in the checkout command.

- **File Type** - The type of the file. Ensure that the correct type is selected for the file entry. The Oracle Applications DBA (AD) patch driver instructions are based on the type selected. For details, please refer to the appendix describing the file types.

- **Destination Path** - The destination path for the file in the Oracle E-Business Suite instance excluding the language subdirectory relative to the product top.

  For common file types, a default destination path is provided automatically but this default value can be overridden.

  The destination path must be an AD-compliant destination path according to Oracle E-Business Suite standards.

  The destination path in the patch driver is automatically suffixed with the language code chosen with exception to "Generic".

  **Note:** For "Generic" files, ensure that the destination path is entered correctly: For example,

  Product: XXCO
  Source Path: forms/US
  File Name: IDC.fmb
  Destination Path: forms
  Language: US

  The final destination path is "forms/US" but the values are entered separately.

- **Language** - Optional. The language code for the file. Select the language code as needed to generate the respective NLS patch.

- **Status** - The status can be one of the following:
  - **Valid** - Indicates that the entry is valid.
  - **Review** - Indicates that the entry needs to be reviewed.
  - **Duplicate** - Indicates that the entry is duplicated.
  - **Blank** - Indicates that one of the required fields is blank.

  **Important:** Customization Manager strongly recommends that each file included within a customization package has an Oracle-compliant source header present within the file.
The following is a sample Oracle compliant header:

$Header: sample.txt 10.1 2012/04/06 09:38 lmathur
noship $ 

The header contains the following elements:

- Filename

- Revision ID - This needs to be incremented every time a file is checked in

- Date and time of checkin

- Author

- Shipment state - ship/noship

3. Enter in additional information for your package.
- Enter the E-Business Suite information (Conditionally required). The E-Business Suite mapping information is only required when the package contains at least one Java or PLD file. You can select the Oracle E-Business Suite Mapping from the list provided.

- Enter the Package Metadata. You can enter the instructions for package application here. These instructions will become part of the package readme.

- Enter Comments. These comments will be recorded as part of the package history for tracking changes made to the package.

- Enter Prerequisite Information.

  For Release 11i packages, you can enter one or more prerequisite patch numbers that can be used for deployment validation with AD utilities.

  For Release 12 (and higher) packages, enter in the prerequisite patch numbers that will be used in validation when the package is deployed through Patch
Manager. Note that this validation is done only if you use the **Check Prerequisites** button in the Patch Details page when creating a patch run in Patch Manager.

**Note:** Prerequisite information entered here for Release 12 packages is only used in deployment by Patch Manager.

- Enter Mailing List information.

You can enter e-mail addresses for people who should be sent notifications about the package’s creation status on the event of success or failure. It is recommended to have e-mail notifications set so that the appropriate users can be notified about the package success or failure.

4. Click **Submit**.

### To create a package using the "Create Like" option:

Customization Manager allows you to create a package by copying the details from an existing package. This procedure can be used typically to create a mirror copy of the package or create another package with minor modifications without having to enter all the relevant details about the package.

**Note:** If you are using a version of Mozilla Firefox higher than 5, the Create Like page is not loaded automatically. To work around this issue, click the **Refresh** button on the page.
To create a package using the Upload option:

If you have any legacy custom patches, the same can be uploaded to the Customization Manager repository in context to a new customization package. Click the **Upload** button from the package search page to upload an existing custom patch. While uploading a custom patch, the following information is required:

- **Package Name**
- **The release to which the custom patch belongs to.**
- **The custom product/application associated with the custom patch**
- **Package type: only for classification purposes**
- **Description for your reference**
- **Any specific instructions for applying the custom patch**

You can upload one or more custom patches (NLS patches) to this customization package. However, it is important that all of them must be associated with the same unique patch number. Clicking the **Submit** button creates a customization package with the status "Succeeded". This customization package can now be deployed just like any other customization package and can be "Released" or "Obsoleted", when required.
Updating a Package

To update a package, find the package listing in the main Customization Manager page and select the icon in the Update column.

To update a package’s definition:

1. Enter general information for the package. The Package ID is an auto-generated unique number and cannot be updated. The Package Name cannot be updated as well.
   - Release - Choose the release for the package.
   - Product - Enter the owning product application. This product can be a custom product created in Oracle E-Business Suite (not in Customization Manager).
   - Package Type - Enter the package type. This value is for your own classification and convenience for searching and cataloging. No validation is performed on this field.
   - Description - For your reference.
   - File Source Mapping - Enter the File Source Mapping for this package. Select from the list of previously-defined mappings.
   - Branch - Enter the branch for the source control system, if required. The branch will be substituted for the %branch% token within your checkout command.
   - Tag - Enter the tag for the source control system, if required. The tag will be substituted for the %tag% token within your checkout command.
   - User Name - Enter the user name to connect to the source control system, if required. The User Name and Password (below) will be substituted in the ”%user_name%” and ”%password%” parameters of the checkout command.
   - Password - Enter the password for the above user name, if required.
   - Upload Manifest - If you have a file manifest as a comma-separated value (CSV) format on your computer, you can upload it here.

2. You may add or remove file entries manually from the File Listing page. Alternatively, you may also include file entries from the File Metadata Repository using the Include Files button.
   
   For each file, enter the following:
   - Product - The owning product application. This product can be a custom
product created in Oracle E-Business Suite (not in Customization Manager).

- **Source Path** - The source directory for the file on the source control system or file system. This would be substituted in the "%file_path%" parameter in the checkout command.

- **File Name** - The name of the file. This would be substituted in the "%file_name%" parameter in the checkout command.

- **Version** - Optional. The version of the file. The version is only needed if the checkout command will use the version information. This would be substituted in the "%version%" parameter in the checkout command.

- **Type** - The type of the file. Ensure that correct type is selected for the file entry. The Oracle Applications DBA (AD) patch driver instructions are based on the type selected.

- **Destination Path** - The destination path for the file in the Oracle E-Business Suite instance excluding the language subdirectory. This must be an AD-compliant destination path according to Oracle E-Business Suite standards. The destination path in the patch driver is automatically suffixed with the language code chosen with exception to "Generic". The destination path for a file entry is defaulted to the source path, which may be modified if necessary.

- **Language** - Optional. The language code for the file. Select the language code as needed to generate the respective NLS patch.

3. Enter in additional information for the package.

- **Enter the E-Business Suite mapping information** (Conditionally required). The E-Business Suite mapping information is only required when the package contains at least one Java or PLD file. You may select the E-Business Suite Mapping from the list provided.

- **Enter the Package Metadata**. You can enter the instructions for package application here. These instructions will become part of the package readme.

- **Enter Comments**. These comments will be recorded as part of the package history for tracking changes made to the package. As a best practice, it is recommended to add comments describing the changes done to the package and other details. Any comments added are tracked with the package history information.

- **Enter Prerequisite Information**.
  
  For Release 11i packages, you can enter one or more prerequisite patch numbers that can be used for deployment validation with AD utilities.
For Release 12 (and higher) packages, enter in the prerequisite patch numbers that will be used in validation when the package is deployed through Patch Manager. Note that this validation is done only if you use the Check Prerequisites button in the Patch Details page when creating a patch run in Patch Manager.

**Note:** Prerequisite information entered here for Release 12 packages is only used in deployment by Patch Manager.

• Enter in Mailing List information. You can enter e-mail addresses for people who should be sent notifications about the package's update status on the event of success or failure.

4. Click **Submit**.

**Saving a Package**

If, in the process of creating or updating a package definition, you want to save the package definition before submitting a request to have Enterprise Manager actually build the package, click the **Save** button on the File Listing page or the Submit page of the Create/Update process. Your package definition will be saved and it will appear on the main Customization Manager page with a status of Saved.

**Searching for a Package**

You can perform an Advanced Search for packages with the following criteria:

• Name

• ID

• Product

• Instruction Contains

• Prerequisite Patch

• Description Contains

• Owner

• Release

• Package Type
• Standards Check Results
• Status
• Language
• Public (Choose whether you want results with only Public packages, no Public packages, or either)
• Contains File
• Contains File with Version (Used in conjunction with "Contains File")
• Updated within (Days)
• File Source Mapping Name
• Branch
• Tag
• E-Business Suite Mapping Name
• Last Updated By

**Viewing Package Details**

View package details by selecting its name in the search results table on the main Customization Manager page.

**Package Details**

The following details are shown in this region:
• Package ID
• Release
• Product
• Package Type
• Owner
• Created - The date and time the package was created.
• Last Updated - The date and time the package was last updated.
• Last Updated By - The user who last updated the package.

• Status - The status of the package. Possible values are: In Progress, Succeeded, Saved, Failed, Released, and Obsoleted.

• Standard Checker Result - For detailed results, click on the link if applicable.

• E-Business Suite Mapping Name - If applicable.

• File Source Mapping Name

• Branch

• Tag

• Uploaded - Whether this package was created as a result of a patch upload.

• Public - Whether this package is shared across all users.

### History Details (View Package History)

The package history provides a chronological view of all the important events in the lifecycle of a package.

Select the **History Details** button to go to the View Package History page, which provides high-level history tracking of the package, including the timestamp and user-entered comments for the following events:

• Creation of package

• Update of package
• Release of package

You can also drill down to the Oracle Enterprise job details for the package creation and any updates.

View Log

Use the View Log button to view the most recent Oracle Enterprise Manager job details for the package.

Download Log

Use the Download Log button to download the consolidated log for the package creation.

Beginning with Release 12.1.0.3.0, this log is in HTML. Packages created in prior releases still have the package creation consolidated log in .txt format.

The package details and status summary is shown as in the following example.

Customization Manager

Package ID: 1000000000014
Package Name: Sample Package

Status Summary

<table>
<thead>
<tr>
<th>Step Name</th>
<th>Status</th>
<th>Start Time</th>
<th>End Time</th>
<th>Target</th>
</tr>
</thead>
<tbody>
<tr>
<td>INITIALIZER</td>
<td>Succeeded</td>
<td>22-OCT-2013 08:30:11</td>
<td>22-OCT-2013 08:30:11</td>
<td>NA</td>
</tr>
<tr>
<td>CHECKOUT_JOB - UPDATE_INT_STATUS</td>
<td>Succeeded</td>
<td>22-OCT-2013 08:30:18</td>
<td>22-OCT-2013 08:30:18</td>
<td>NA</td>
</tr>
<tr>
<td>CHECKOUT_JOB - PUT_FILE_FROM_REPOSITORY</td>
<td>Succeeded</td>
<td>22-OCT-2013 08:30:19</td>
<td>22-OCT-2013 08:30:19</td>
<td>ns2101371.appl1.oracle.com</td>
</tr>
<tr>
<td>CHECKOUT_JOB - CLEAN_STAGE_AREA_BEDIN</td>
<td>Succeeded</td>
<td>22-OCT-2013 08:30:19</td>
<td>22-OCT-2013 08:30:19</td>
<td>ns2101371.appl1.oracle.com</td>
</tr>
<tr>
<td>CHECKOUTJOB - UPDATE_SUCCESS_STATUS</td>
<td>Succeeded</td>
<td>22-OCT-2013 08:30:20</td>
<td>22-OCT-2013 08:30:20</td>
<td>ns2101371.appl1.oracle.com</td>
</tr>
<tr>
<td>STD_CHECKER</td>
<td>Succeeded</td>
<td>22-OCT-2013 08:30:20</td>
<td>22-OCT-2013 08:30:20</td>
<td>ns2101371.appl1.oracle.com</td>
</tr>
<tr>
<td>BUID JOB - PYTHON_SCRIPT</td>
<td>Succeeded</td>
<td>22-OCT-2013 08:30:20</td>
<td>22-OCT-2013 08:30:20</td>
<td>ns2101371.appl1.oracle.com</td>
</tr>
<tr>
<td>BUID JOB - UPDATE_INT_STATUS</td>
<td>Succeeded</td>
<td>22-OCT-2013 08:30:20</td>
<td>22-OCT-2013 08:30:20</td>
<td>ns2101371.appl1.oracle.com</td>
</tr>
<tr>
<td>STATUS_CHECKER</td>
<td>Failed</td>
<td>22-OCT-2013 08:30:20</td>
<td>22-OCT-2013 08:30:20</td>
<td>NA</td>
</tr>
<tr>
<td>BUID JOB - PUT_FILE_FROM_REPOSITORY</td>
<td>Failed</td>
<td>22-OCT-2013 08:30:20</td>
<td>22-OCT-2013 08:30:20</td>
<td>ns2101371.appl1.oracle.com</td>
</tr>
<tr>
<td>BUID JOB - CLEAN_STAGE_AREA_BEDIN</td>
<td>Failed</td>
<td>22-OCT-2013 08:30:20</td>
<td>22-OCT-2013 08:30:20</td>
<td>ns2101371.appl1.oracle.com</td>
</tr>
<tr>
<td>BUID JOB - UPDATE_SUCCESS_STATUS</td>
<td>Failed</td>
<td>22-OCT-2013 08:30:20</td>
<td>22-OCT-2013 08:30:20</td>
<td>ns2101371.appl1.oracle.com</td>
</tr>
</tbody>
</table>

Within the log file, you can click the Status link for a step to navigate to its details.
Step: CHECKOUT_JOB - DO_JOB (Succeeded)  [Top]

For a failed step, the root cause for the exception will be shown in bold and in red.

Step: BUILD_JOB - DO_JOB (Failed)  [Top]

If a job step fails to start, then an error section is added to show the proper error message.
Description

Any description entered for the package is shown here.

Instructions

Instructions entered in the Package Metadata field are shown here.

Patch Downloads

For each patch generated, the following information is shown here:

- File Name - Click on the patch file name link to download the patch.
- Language - The language of the patch.
- Size - The size of the patch.
- Readme - Click on the icon to download the readme. The readme file is in HTML format and includes the package description and package metadata.

Typically, each customization package could be associated with one or more language patches.
Manifest

The file manifest is shown here. Details for each file include Product, Source Path, File Name, Destination Path, Version, File Type, Language, and Last Updated timestamp.

Use the Download Manifest button to download the manifest as a comma-separated values (CSV) file, viewable in Microsoft Excel.

You can search for a specific file by entering in the file name in the "Locate File" field and clicking Go. Wildcard characters "%" and "*" are supported here.

Technology Stack Details

The Technology Stack details for a package provide a snapshot of the technology stack properties for the Oracle E-Business Suite instance where the package was compiled. You can first check Technology Stack compatibility yourself by running "Instance Comparison" reports.

Attachments

You may add or remove any associated documentation like project plan, design documents, and so on. For each attachment, the following is listed:

- File Name
- Description
- Last Updated timestamp

You can remove an attachment from the package using the Delete icon. If the package is Released or Obsoleted, then the attachments cannot be deleted.

Prerequisite Information

Any prerequisite patches are listed here along with any comments.

Mailing List

View the e-mail addresses for people who should be sent notifications about the package, on the event of success or failure.

Package History

View the history of the package by clicking the History Details button. The package history captures a trail of all major actions upon the package with the comments captured.
Updating Package Metadata

Package metadata can be updated to change the status of the package or to push the file entries metadata in the package to the File Metadata Repository. The "Update Package Metadata" page enables you to do the following:

- Change the status of the package. You can release or obsolete a package by changing its status to "Released" or "Obsoleted". Once a package is updated to the "Released" status, it can no longer be updated and becomes accessible to other users. Once a package is updated to the "Obsoleted" status, it can no longer be updated or deployed.

  **Note:** With the Change Approval Framework, once an approver approves a request to release/obsolete a customization package from a user, the package is released/obsoleted. The user does not need to release/obsolete the package explicitly after the approval.

  **Tip:** Add comments for future reference when you release or obsolete a package. For example, state the reason why you are obsoleting a package.

- Add file metadata entries to the File Metadata Repository.

- If you are the owner of the package or super administrator, you can mark the package as "Public" which entitles the package to be shared across all users for view/update.

- Add comments which are recorded in the package history for the above changes.
Standards Checker Results

The results of the standards checker can be accessed by clicking on the standards checker status.

The standard checker results can also be downloaded as a CSV format file by clicking the **Download Results** button.

To view details about the standard checker validations for a given file, click on the overall status against each file. The details about the standard checker validations include the standard name, result and the message.

In case the standard checker completes with "Error", the package processing is aborted and there are no patches generated.

Package Reports

Customization Manager offers powerful reporting capabilities to help you document, compare and track your customizations. You can generate three types of reports on packages:

- A Standard report gives you details on a single package, including technology stack requirements and the file manifest. You might use this to document customizations.

- A Comparison report allows you to compare two packages. For example, you might want to compare their technology stack snapshots or the versions of the files included in the packages.

- An Instance Comparison report allows you to compare the details of the package with that of an actual Oracle E-Business Suite instance. The details which are compared include custom application, file driver file entries, file manifest and versions, and the technology stack snapshot of a package to the technology stack properties of a given instance. By doing this comparison you can determine possible compatibility issues of the package with the instance and assess the possible impact/possible issues before actually applying the patch.

  **Important:** Oracle strongly recommends that you generate an Instance Comparison report for each custom package and the instance where it is intended to be deployed to identify any technology stack incompatibilities before actually applying the patch.

Reports can be accessed from the Package Report link under Related Links for Customization Manager.
Creating a Report

To create a report, you can

• Select a package from the Package Search results page and click Report

• Click Report button on the View Package page, or

• Click the Create button on the Package Report page.

To create a Standard Report:
A Standard report gives you details on a single package, including technology stack requirements and the file manifest.

1. Enter a user-friendly name for your report.

2. Choose Standard for the Report Type.

3. Enter the package you want the report to be based on in the Package field. This package must have the status of Succeeded, Released, or Obsoleted.

4. Enter the Report Format. Options are:
   • PDF (Portable Document Format)
   • RTF (Rich Text Format)
   • XLS (Microsoft Excel format)

5. Enter the Oracle E-Business Suite Mapping to be used for the report generation.
6. Click Submit.

To create a Comparison Report:
A Comparison report allows you to compare two packages. For example, you might want to compare technology stack requirements or versions of the files included in the packages.

1. Enter in a user-friendly name for your report.

2. Choose Comparison for the Report Type.

3. Enter the package name in the Primary Package field. This package must have the status of Succeeded, Released, or Obsoleted.

4. Enter the package name in the Secondary Package field. This package must have the status of Succeeded, Released, or Obsoleted.

5. Enter the Report Format. Options are:
   - PDF (Portable Document Format)
   - RTF (Rich Text Format)
   - XLS (Microsoft Excel format)

6. Enter the Oracle E-Business Suite Mapping to be used for the report generation. Please note that this instance would be only used to publish the report using BI Publisher.

7. Click Submit.
To create an Instance Comparison Report:

An Instance Comparison report allows you to compare the technology stack properties of a package to the technology stack properties of a given instance. By doing this comparison, you can tell if the package can be properly deployed on the instance.

In addition, the report lists any missing entries in the file driver file, and compares files and versions within the package to those of the instance.

1. Enter in a user-friendly name for your report.

2. Choose Instance Comparison for the Report Type.

3. Enter the package you want the report to be based on in the Package field. This package must have the status of Succeeded, Released, or Obsoleted.

4. Enter the Report Format. Options are:
   - PDF (Portable Document Format)
   - RTF (Rich Text Format)
   - XLS (Microsoft Excel format)

5. Enter the Oracle E-Business Suite Mapping to be used for the report comparison. The Oracle E-Business Suite instance referred by this mapping would be the one which would be compared against the package. As a best practice, it is recommended to generate an instance comparison report for every instance where you intend to deploy the package, to identify any possible incompatibilities/issues before actually applying the package.
6. Click Submit.

**Viewing a Report**

To access reports, navigate to the Customization Manager home page > Package Report (under Related Links).

In the Package Report search results table, the following is shown for each report:

- **Name** - The name of the report.
- **Type** - The type of the report; either Standard, Comparison, or Instance Comparison.
- **Primary Package** - The primary package on which the report is based.
- **Secondary Package (if any)** - For Comparison reports, the second package used in the comparison.
- **E-Business Suite Mapping** - The E-Business Suite Mapping used in the report generation or comparison.
- **Format** - The format of the report; either PDF, RTF, or XLS.
- **Status** - The status of the report.
• Owner - The user who created the report.

• Last Updated - The Last Updated timestamp for the report.

• Download - Click on the link provided to download a ZIP file containing the report.

• Details - Click on the Details icon to view details on the report submission job. This link takes you to the Oracle Enterprise Manager Deployments Status page for the report submission.

• Delete - Click on the Delete icon for the report to delete the report.

**Standard Report Output File**

The Standard Report output file has three sections:

• Package Details - Information pertaining to the package's definition.

• Technology Stack Information - Properties and values of the technology stack of the instance mapped through the Oracle E-Business Suite Mapping for the package.

• File Manifest - The listing of the files in the package, including their respective product, source path, name, version, language, and type.

**Comparison Report Output File**

The Comparison Report output file has three sections:

• Package Details - Information pertaining to the packages' definitions.

• Technology Stack Information - This section shows a comparison of the values of the two packages' technology stack details.

• File Manifest - This section shows a comparison of the versions of each given file in the two packages.

**Instance Comparison Report Output File**

The Instance Comparison Report output file has six sections:

• Package Details - Information pertaining to the package's definition.

• Oracle E-Business Suite Instance Information - Basic information for the instance used in the report comparison. Information includes name, patch level for Applications DBA (AD), patch level for Oracle Application Object Library (FND), and the database release information.
• Missing custom products/applications.

• Missing entries in file driver file.

• File comparison to report missing files or version differences.

• Technology Stack Details - For each given property, this table lists the value for the package and the Oracle E-Business Suite instance, and how they compare to each other.

**Searching for a Report**

You can search for a report by its name on the main Package Report page, or click the Advanced Search link to search based on additional criteria, including:

E-Business Suite Mapping - The E-Business Suite mapping used for the report generation or comparison.

• Primary Package - The primary package for the report.

• Secondary Package - The secondary package, if any. The secondary package would be used in Comparison Reports.

• Type - The type of report; either Standard, Comparison, or Instance Comparison.

• Report Format - The format chosen for the report; either PDF, RTF, or XLS.

**Releasing and Sharing a Package**

After a package is released, it is implicitly shared with other users to deploy. Use the Update Package Metadata page to release a package. See: Updating Package Metadata, page 14-40.

*Note:* With the Change Approval Framework, once an approver approves a request to release a customization package from a user, the package is released. The user does not need to release the package explicitly after the approval.

Before you deploy a custom package in Patch Manager, you should run the Instance Comparison Report to compare the technology stack properties of the package with those of the instance to which the package is being deployed. Patch Manager does not stop the deployment of a patch if the technology stack properties are not compatible, so you should make your best judgement based on the Instance Comparison Reports.
Maintaining the File Metadata Repository

The File Metadata Repository stores metadata information on each file. It can be used as a cataloging repository for all custom files within your enterprise.

The File Metadata Repository is also aware of the objects within the custom files. This capability typically applies to SQL scripts and PL/SQL packages where the objects are tables, indexes, sequences, views, and so on.

The system can parse and discover objects within custom files when added to the File Metadata Repository. This can be initiated from the “Update Package metadata” screen on clicking the box “Add file metadata to file repository”.

Examples of custom objects include:

- Tables
- Views
- Mviews and Mview logs
- Triggers
- PL/SQL package names
- Indexes

You can view and updates objects populated for a given file. You can also search for files containing specified objects and include them during package creation or update.

Search capabilities are limited to:

- PL/SQL spec and body (all formats)
- SQL files
• Oracle Application Framework XML files
• XDF

The information on a file can be uploaded to the repository in one of three ways:
• By uploading a package's file manifest in CSV format to the repository.
• By adding metadata for an individual file manually to the repository.
• By updating the metadata for a file already in the repository.

You can add metadata to the repository using the "Add file metadata to file repository" option in the Update Package Metadata page.

The File Metadata Repository can be accessed from its link under Related Links.

You can search for a file by entering the filename in the Search field on the main File Metadata Repository page. Alternatively, use Advanced Search to search for its file using one or more of the following: Filename, Product, Language, Source Path, Destination Path, Version, File Type, or Object Name.

Also, during the package create/update flow, you can search for files or files referring to objects within the file metadata repository using the Include Files button.

**To upload a file manifest:**
1. Select the Upload Manifest button from the main File Metadata Repository page.
2. Select your file manifest file using the Browse button for the File Manifest field.
3. Optionally add a description.
4. Click Submit.

**To upload an individual file:**
1. Click on the Add button from the main File Metadata Repository page.
2. Enter the name of the file.
3. Enter the product to which the file belongs.
4. Enter its source path.
5. Enter the version of the file.
6. Select the file type from the list provided.
7. Enter the destination path.
8. Enter the language for the file.

9. Optionally enter a description.

10. Click Submit.

To update the metadata for a file already in the File Metadata Repository:
1. Select the Update icon for the file in the Search results table in the main File Metadata Repository page.

2. Update the file name, file type, version, product, source path, destination path, language, and/or description as desired.

3. Click Submit.

You can associate one or more customization objects to a given file in the Related Objects region. For instance, a PLS file might be associated with a PL/SQL procedure name as one of the objects. You might update a given file entry to associate one or more customization objects to it. This capability allows you to catalog and later search for customization objects using the Advanced Search option within the File Metadata Repository. However, there are currently no validation checks built into the system that use this information during package creation or deployment.

Managing Custom Applications

You can manage your custom applications from the Custom Applications page available under Related Links for Customization Manager.

- View custom applications and instance associations
- Hide and unhide the custom applications within Customization Manager
- Register a new custom application
- Validate an already registered custom application
- If a validation request fails, run the Auto-Correct feature for the application
A custom application "definition" is de-coupled from registration. Once an application is defined, it can be registered on one or more instances.

A user must have the "Approve splice request" privilege to hide and unhide custom applications. By default, hidden custom applications will be invisible. A user can check "show hidden custom applications" box to view the hidden custom applications.

To define a new custom application:

1. Navigate to the Custom Applications page. Select "New Custom Application" from the Add drop-down list and click Go. The Define Custom Applications page appears.
2. Specify an Application Short Name for your application. Note that the short name must be a maximum of 8 characters. Only alphanumeric characters and underscore (_) are allowed, and letters must be lowercase. The application short name is recommended to be prefixed with "xx".

3. Specify an Application Name for your application.

4. Optionally provide a description.

5. Click Submit to save your work.

Note that a custom application definition is not associated with any specific Oracle E-Business Suite instance but can be used to register the given custom application on one or more Oracle E-Business Suite instances.

**To discover an existing custom application:**

1. Navigate to the Custom Applications page. Select "Existing Custom Application" from the Add drop-down list and click Go. The Discover Custom Applications page appears.
2. Select the custom application you wish to discover and click **Submit**. You can use the Search feature to narrow down the results the table.

**To validate a custom application:**

Existing registered applications can be validated.

For more information on validation, see: Validation of Custom Applications: Examples, page E-1.
1. Navigate to the Custom Applications page. Click the "Custom Application Requests" link under Related Links. The Custom Application Requests page appears. Select a request, and click the Validate button. Alternatively, you can also select the instance and click the Validate button from the custom application view details screen.

2. Enter in the Application Short Name for the application. You can use the LOV provided. Note that the Application Name defaults in.

3. Enter in the Oracle E-Business Suite instance. You can use the LOV provided. Note that the Preferred Credentials need to be set for this Oracle E-Business Suite instance.

4. Select "Generate Readiness Report for Online Patching" if desired. It reports Edition-Based Redefinition (EBR) violations in the specified custom schema that include objects not complying with the EBR rules about non-editioned objects (data storage objects such as tables and materialized views), and referencing editioned objects (code objects such as: packages, triggers, object types, and so on). This report also lists several naming standard violations that must be fixed prior to applying the online patching enablement patch for Release 12.2.

5. Click Submit. A job to validate the custom application will be submitted. Validation is based on certain standards and is provided by Oracle Applications DBA (AD) utilities.

To run Auto-Correct on a custom application request

If your request to validate a custom application fails, you can use the Auto-Correct feature to help you make the custom application conform to Oracle E-Business Suite standards.

Note: This feature can only be used on failed validation requests.

The user who submits the auto-correction request must have the splice request privilege.

The request must be approved for execution using Change Approval.

1. Navigate to the Custom Applications page. Click the "Custom Application Requests" link under Related Links. The Custom Application Requests page appears. Select a request and click the Auto-Correct button.

Note: If you choose a request that did not fail in the Validation step, you will receive the error "Only failed validation requests are allowed for auto-correction."
2. In the Auto-Correct Custom Application page, enter the following:
   - Custom Application’s Schema Password. If you do not enter a value, the application short name is used by default.
   - Email addresses for users to be notified regarding this request. (Optional)
   - Justification (Required)

3. Click Submit.

4. You can then view your request under Change Approval Requests.

5. Click on the name of the request to view details.

6. You can download the splice log if the corresponding job for your request has been purged and no longer exists in the Enterprise Manager system.

To register a custom application on an Oracle E-Business Suite instance:

Note: Beginning with Release 12.1.0.3.0, you have the option of registering a custom application on a patch edition in Oracle E-Business Suite Release 12.2. In this way, you do not need to wait until a full fs_clone operation is executed to synchronize the patch edition with the run edition to apply custom patches on the patch edition. The WebLogic Administrator credentials must be set before you register the custom application on the patch edition.
1. Navigate to the Custom Applications page. Click the "Custom Application Requests" link at the bottom of the page. The Custom Application Requests page appears. Select a request, and click the Register button. Alternatively, you can also click the Register button on the Custom Application details page.

2. Enter in the Application Short Name for the application. You can use the LOV provided. Note that the Application Name defaults in.

3. Enter in the Oracle E-Business Suite instance. You can use the LOV provided. Note that the required APPLSYS schema, APPS schema and system schema Preferred Credentials need to be set for this Oracle E-Business Suite instance.

4. Enter in an Application ID. Oracle recommends you use an application ID greater than 50000. Customization Manager automatically generates and defaults the recommended application ID.

5. Enter the custom application’s schema password.

6. For an Oracle E-Business Suite Release 12.2 instance, specify whether to register the custom application on the Run file system or the Patch file system.
   If you choose the Patch file system, you have the option to defer the adoption cutover.
7. Select “Run AutoConfig” if desired. AutoConfig execution is necessary for the custom application to be available for patching. Please run AutoConfig manually if you do not choose to run it during the custom application registration.

8. When change approval is enabled, enter e-mail addresses for Notification E-mail(s). In registering a custom application, you first submit a request to register the application. This request must then be approved (either automatically or manually, depending on your Change Approval Framework setup).

9. Enter a justification.

10. Click Submit. A request to register the custom application will be submitted.
To view details of custom application:

View details of a custom application by navigating to Custom Applications, selecting the application name, and clicking the View button. Details include:

- List of instances where custom application is present with status validated/not validated. If the status is not validated, it is recommended to use the Validate button to launch a validation request. A valid status ensures that custom patches for the given custom application can be applied on that instance.

- Custom objects associated with the given custom application which are present on the given instance can be viewed by clicking on the “View Objects” icon. Customization Manager automatically discovers and relates the following objects associated with a custom application:
  - Custom Forms
  - Profile Options
  - Request Sets
  - Custom Database Objects
  - Alerts
  - Audit Group Information
  - All files in the File Metadata Repository for the given custom application.
  - List of packages that have been created for the custom application.
To track details of a custom application request:

A custom application request can be used to register or to validate a custom application on a given instance.

1. Navigate to the Custom Applications page. Click the “Custom Application Requests” link at the bottom of the page. The Custom Application Requests page appears. Select a custom application request from the table and click View.

2. Details for the request will be shown.

Tip: To debug or view logs of a custom application request, click on "Job Details" icon against the specific custom application request. This would navigate to the EM job log associated with the custom application request. Click and view details on the "DO_JOB" step to view the detailed log of the given custom application request. In case of a failure of a custom application request, a new request should be submitted after rectifying the errors/failures listed in the job details log.
To execute a job to register or validate a custom application when the change approval system is enabled:

1. Confirm that the request to execute the job to register or validate the custom application has been approved. To do this, navigate to the Custom Applications page. Click the "Custom Application Requests" link at the bottom of the page. The Custom Application Requests page appears. Approved requests will be listed with the Status "Approved".

2. Select an Approved custom application request from the table and click **Execute**.

3. At the Execute Custom Application Request page, ensure that the displayed information is correct and click **Submit**.

   ![Oracle Enterprise Manager Cloud Control 12c](image)

   **Execute Custom Application Request: ut123**
   - **Application Short Name**: ut123
   - **Application Name**: ut123_Oracle E-Business Suite
   - **E-Business Suite Instance**: ut123
   - **Application ID**: 50000

   ![Tip: Run AutoConfig](image)

   The system will attempt to execute a job to register or validate the custom application. If the system cannot execute the job, details regarding the job will be shown.
This appendix covers the following topics:

- Target Types

**Target Types**

The following table lists details of the individual target types shipped in the management pack.

<table>
<thead>
<tr>
<th>Target Type</th>
<th>Applicable Oracle E-Business Suite Release</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle E-Business Suite</td>
<td>All releases</td>
<td>Target representing entire Oracle E-Business Suite instance.</td>
</tr>
<tr>
<td>Oracle Applications Service</td>
<td>All releases</td>
<td>Target representing all the services provided by Oracle E-Business Suite.</td>
</tr>
<tr>
<td>Concurrent Processing Service</td>
<td>All releases</td>
<td>Target representing the services provided by the concurrent processing infrastructure.</td>
</tr>
<tr>
<td>Forms-Based Applications Service</td>
<td>All releases</td>
<td>Target representing the services provided by Oracle Forms.</td>
</tr>
<tr>
<td>Self-Service Applications Service</td>
<td>All releases</td>
<td>Target representing the services provided by self-service applications.</td>
</tr>
<tr>
<td>Target Type</td>
<td>Applicable Oracle E-Business Suite Release</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Workflow Service</td>
<td>All releases</td>
<td>Target representing the service provided by the Oracle Workflow infrastructure.</td>
</tr>
<tr>
<td>Oracle E-Business Suite Node</td>
<td>All releases</td>
<td>Target representing an individual Oracle E-Business Suite node.</td>
</tr>
<tr>
<td>Oracle Concurrent Manager</td>
<td>All releases</td>
<td>Target representing the concurrent manager.</td>
</tr>
<tr>
<td>Internal Concurrent Manager</td>
<td>All releases</td>
<td>Target representing the internal concurrent manager.</td>
</tr>
<tr>
<td>Oracle E-Business Suite Workflow</td>
<td>All releases</td>
<td>Target representing all the members of the Oracle Workflow infrastructure.</td>
</tr>
<tr>
<td>Oracle Workflow Agent Listener</td>
<td>All releases</td>
<td>Target representing the Oracle Workflow agent listener.</td>
</tr>
<tr>
<td>Oracle Workflow Background Engine</td>
<td>All releases</td>
<td>Target representing the Oracle Workflow background engine.</td>
</tr>
<tr>
<td>Oracle Workflow Notification Mailer</td>
<td>All releases</td>
<td>Target representing the Oracle Workflow notification mailer.</td>
</tr>
<tr>
<td>Oracle Applications JVM Usage</td>
<td>12.1.X</td>
<td>Target representing the JVM that runs the oacore server. This is used to monitor parameters specific to Oracle E-Business Suite deployment.</td>
</tr>
<tr>
<td>Oracle E-Business Suite Custom Objects</td>
<td>All releases</td>
<td>Target representing the customizations in an Oracle E-Business Suite instance.</td>
</tr>
<tr>
<td>Oracle E-Business Suite Patch Information</td>
<td>All releases</td>
<td>Target representing the patching activities in an Oracle E-Business Suite instance.</td>
</tr>
<tr>
<td>JServ for Oracle E-Business Suite 11i</td>
<td>11i</td>
<td>Target representing the j2eecontainer in which the Oracle E-Business Suite 11i is deployed.</td>
</tr>
<tr>
<td>Target Type</td>
<td>Applicable Oracle E-Business Suite Release</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Forms Listener for Oracle E-Business Suite 11i</td>
<td>11i</td>
<td>Target representing the Forms listener in an Oracle E-Business Suite 11i instance that is running in socket mode.</td>
</tr>
<tr>
<td>Forms Servlet for Oracle E-Business Suite 11i</td>
<td>11i</td>
<td>Target representing the Forms listener in an Oracle E-Business Suite instance that is running in servlet mode.</td>
</tr>
<tr>
<td>Discoverer for Oracle E-Business Suite 11i</td>
<td>11i</td>
<td>Target representing Discoverer for Oracle E-Business Suite 11i.</td>
</tr>
</tbody>
</table>
Pre-validation for Discovery

This appendix covers the following topics:

• Prevalidation Checks for Discovery

Prevalidation Checks for Discovery

The following table lists the checks used in the prevalidation step of discovery.

<table>
<thead>
<tr>
<th>Category</th>
<th>Sub category</th>
<th>Description</th>
<th>Applicable Releases of Oracle E-Business Suite</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apps Context File</td>
<td>Number of Context Files</td>
<td>A minimum of one (1) context file must be there.</td>
<td>For 11i and 12.1.X</td>
</tr>
<tr>
<td>Apps Context File</td>
<td>Number of Context Files</td>
<td>A minimum of two (2) context files must be there.</td>
<td>12.2 and above</td>
</tr>
<tr>
<td>Apps Context File</td>
<td>Context Name</td>
<td>Context name should not be empty.</td>
<td>All releases</td>
</tr>
<tr>
<td>Apps Context File</td>
<td>Context Name</td>
<td>Context name must be same for both run and patch editions.</td>
<td>12.2 and above</td>
</tr>
<tr>
<td>Apps Context File</td>
<td>Edition Name</td>
<td>Edition name must be same for all nodes under an edition.</td>
<td>12.2 and above</td>
</tr>
<tr>
<td>Apps Context File</td>
<td>Duplicate Context Files</td>
<td>There should not be two context files for the same applications node.</td>
<td>11i and 12.1.X</td>
</tr>
<tr>
<td>Category</td>
<td>Sub category</td>
<td>Description</td>
<td>Applicable Releases of Oracle E-Business Suite</td>
</tr>
<tr>
<td>-------------------------</td>
<td>--------------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Apps Context File</td>
<td>Duplicate Context Files</td>
<td>There should not be two context files for the same node under an edition.</td>
<td>12.2 and above</td>
</tr>
<tr>
<td>Apps Context File</td>
<td>Number of nodes</td>
<td>Only one applications node per host.</td>
<td>11i and 12.1.X</td>
</tr>
<tr>
<td>Apps Context File</td>
<td>Number of nodes</td>
<td>Only two applications nodes per host: One for the run edition and one for the patch edition.</td>
<td>12.2 and above</td>
</tr>
<tr>
<td>Apps Context File</td>
<td>EBS System Name</td>
<td>Oracle E-Business Suite system name must be the same in all context files.</td>
<td>For all releases</td>
</tr>
<tr>
<td>Apps Context File</td>
<td>Context variables</td>
<td>Mandatory context variables must be there.</td>
<td>All releases</td>
</tr>
<tr>
<td>Apps Context File</td>
<td>WLS Admin Server</td>
<td>Must be up for the run edition.</td>
<td>12.2 and above</td>
</tr>
<tr>
<td>DB ContextFile</td>
<td>Duplicate Context Files</td>
<td>There should not be two context files for the same database node.</td>
<td>All releases</td>
</tr>
<tr>
<td>DB ContextFile</td>
<td>Context Name</td>
<td>Context name should not be empty.</td>
<td>All releases</td>
</tr>
<tr>
<td>DB ContextFile</td>
<td>Number of nodes</td>
<td>Only one database node per host.</td>
<td>All releases</td>
</tr>
<tr>
<td>DB ContextFile</td>
<td>EBS System Name</td>
<td>Oracle E-Business Suite system name must be same in all context files.</td>
<td>All releases</td>
</tr>
<tr>
<td>DB ContextFile</td>
<td>Context variables</td>
<td>Mandatory context variables must be there.</td>
<td>All releases</td>
</tr>
<tr>
<td>EMGC Components</td>
<td>Agent installation</td>
<td>EM Agents must be installed on all hosts.</td>
<td>All releases</td>
</tr>
<tr>
<td>EMGC Components</td>
<td>Agent Compatibility</td>
<td>Agent must be at the same release as OMS or one release lower (n-1).</td>
<td>All releases</td>
</tr>
<tr>
<td>Category</td>
<td>Sub category</td>
<td>Description</td>
<td>Applicable Releases of Oracle E-Business Suite</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>EMGC Components</td>
<td>OS User</td>
<td>Agent OS user and Oracle E-Business Suite OS user must be same or must be in the same OS user group.</td>
<td>All releases</td>
</tr>
<tr>
<td>EMGC Components</td>
<td>Preferred credentials</td>
<td>Preferred credential must be set for the host in which the run edition WLS admin server is running.</td>
<td>12.2 and above</td>
</tr>
</tbody>
</table>
Supported File Types in Customization Manager

This appendix covers the following topics:

- Supported File Types
- Recommended Locations for Common File Types
- Execution Sequence of SQL File Types

Supported File Types

The following table lists the supported file types in Customization Manager. You can include files of only these types in your custom packages. The Object Action column lists the action that AutoPatch performs on files of the given type.

<table>
<thead>
<tr>
<th>File Type Name</th>
<th>Source Extension</th>
<th>Description</th>
<th>Object Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>fmb</td>
<td>fmb</td>
<td>Oracle Forms</td>
<td>copy and genform</td>
</tr>
<tr>
<td>prt</td>
<td>prt</td>
<td>Oracle Reports driver</td>
<td>copy</td>
</tr>
<tr>
<td>rdf</td>
<td>rdf</td>
<td>Oracle Reports</td>
<td>copy and genrep</td>
</tr>
<tr>
<td>pld (Forms)</td>
<td>pld</td>
<td>Forms Library</td>
<td>compile to pll; copy and genfpll</td>
</tr>
<tr>
<td>pld (Reports)</td>
<td>pld</td>
<td>Reports Library</td>
<td>compile to pll; copy and genrppl</td>
</tr>
<tr>
<td>File Type Name</td>
<td>Source Extension</td>
<td>Description</td>
<td>Object Action</td>
</tr>
<tr>
<td>----------------</td>
<td>------------------</td>
<td>--------------------------------------------------</td>
<td>--------------------------------</td>
</tr>
<tr>
<td>pdf</td>
<td>pdf</td>
<td>document file (Portable Document Format (PDF))</td>
<td>copy</td>
</tr>
<tr>
<td>pdf</td>
<td>pdf</td>
<td>XML PDF notrans</td>
<td>copy and load using XDOLoader</td>
</tr>
<tr>
<td>xls</td>
<td>xls</td>
<td>Microsoft Excel file</td>
<td>copy</td>
</tr>
<tr>
<td>mmb</td>
<td>mmb</td>
<td>menu file</td>
<td>copy</td>
</tr>
<tr>
<td>java</td>
<td>java</td>
<td>Java file</td>
<td>compile and deploy under $JAVA_TOP</td>
</tr>
<tr>
<td>zip</td>
<td>zip</td>
<td>zipped file</td>
<td>copy</td>
</tr>
<tr>
<td>class</td>
<td>class</td>
<td>Java class file</td>
<td>copy</td>
</tr>
<tr>
<td>jpg</td>
<td>jpg</td>
<td>JPEG image file</td>
<td>copy</td>
</tr>
<tr>
<td>bmp</td>
<td>bmp</td>
<td>bitmap image file</td>
<td>copy</td>
</tr>
<tr>
<td>dbc</td>
<td>dbc</td>
<td>file used for database connection</td>
<td>copy</td>
</tr>
<tr>
<td>doc</td>
<td>doc</td>
<td>Microsoft Word document file</td>
<td>copy</td>
</tr>
<tr>
<td>dot</td>
<td>dot</td>
<td>Microsoft Word template file</td>
<td>copy</td>
</tr>
<tr>
<td>drv</td>
<td>drv</td>
<td>driver file</td>
<td>copy</td>
</tr>
<tr>
<td>fmx</td>
<td>fmx</td>
<td>compiled form</td>
<td>copy</td>
</tr>
<tr>
<td>software htm</td>
<td>htm</td>
<td>Hypertext Markup Language</td>
<td>copy</td>
</tr>
<tr>
<td>html</td>
<td>html</td>
<td>Hypertext Markup Language</td>
<td>copy</td>
</tr>
<tr>
<td>odf</td>
<td>odf</td>
<td>object definition file</td>
<td>copy</td>
</tr>
<tr>
<td>pkh</td>
<td>pkh</td>
<td>package header</td>
<td>copy and execute as APPS</td>
</tr>
<tr>
<td>File Type Name</td>
<td>Source Extension</td>
<td>Description</td>
<td>Object Action</td>
</tr>
<tr>
<td>---------------</td>
<td>------------------</td>
<td>-------------</td>
<td>---------------</td>
</tr>
<tr>
<td>plb</td>
<td>plb</td>
<td>package body</td>
<td>copy</td>
</tr>
<tr>
<td>RTF File</td>
<td>rtf</td>
<td>rich text format</td>
<td>copy</td>
</tr>
<tr>
<td>XMLP RTF notrans</td>
<td>rtf</td>
<td>copy and load using XDOLoader</td>
<td></td>
</tr>
<tr>
<td>sql</td>
<td>sql</td>
<td>SQL script</td>
<td>copy and execute as APPS</td>
</tr>
<tr>
<td>wft</td>
<td>wft</td>
<td>Workflow Text</td>
<td>copy and upload using WFLOAD</td>
</tr>
<tr>
<td>wfx</td>
<td>wfx</td>
<td>Workflow XML loader files</td>
<td>copy and load using WFXLoader</td>
</tr>
<tr>
<td>XML</td>
<td>xml</td>
<td>Extensible Markup Language file</td>
<td>copy</td>
</tr>
<tr>
<td>BC4J XML</td>
<td>xml</td>
<td>Oracle Application Framework - BC4J XML file customizations</td>
<td>compile and deploy under $JAVA_TOP</td>
</tr>
<tr>
<td>dll</td>
<td>dll</td>
<td>dynamic link library</td>
<td>copy</td>
</tr>
<tr>
<td>mmx</td>
<td>mmx</td>
<td>a kind of menu file</td>
<td>copy</td>
</tr>
<tr>
<td>sym</td>
<td>sym</td>
<td>always accompanies a dll</td>
<td>copy</td>
</tr>
<tr>
<td>tif</td>
<td>tif</td>
<td>image file (Tagged Image File Format)</td>
<td>copy</td>
</tr>
<tr>
<td>sh</td>
<td>sh</td>
<td>Bourne or Korn shell script</td>
<td>copy</td>
</tr>
<tr>
<td>jlt</td>
<td>jlt</td>
<td>Java Loader Text - used by AKLOAD.java</td>
<td>copy</td>
</tr>
<tr>
<td>eex</td>
<td>eex</td>
<td>Oracle Discoverer</td>
<td>copy</td>
</tr>
<tr>
<td>dis</td>
<td>dis</td>
<td>Discoverer Export</td>
<td>copy</td>
</tr>
<tr>
<td>File Type Name</td>
<td>Source Extension</td>
<td>Description</td>
<td>Object Action</td>
</tr>
<tr>
<td>----------------</td>
<td>------------------</td>
<td>--------------------------------------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>lct</td>
<td>lct</td>
<td>Application Object Library</td>
<td>copy</td>
</tr>
<tr>
<td>software ldt</td>
<td>ldt</td>
<td>used in software patches</td>
<td>copy and upload using FNDLOAD</td>
</tr>
<tr>
<td>force upload</td>
<td>ldt</td>
<td>used in software patches</td>
<td>copy and upload using FNDLOAD with CUSTOM_MODE=FORCE option</td>
</tr>
<tr>
<td>sqlj</td>
<td>sqlj</td>
<td>SQLJ file</td>
<td>copy</td>
</tr>
<tr>
<td>ini</td>
<td>ini</td>
<td>Java Parameter File</td>
<td>copy</td>
</tr>
<tr>
<td>xsl (non-dbdrv)</td>
<td>xsl</td>
<td>XML Style Sheets (not used in database driver)</td>
<td>copy</td>
</tr>
<tr>
<td>create_view</td>
<td>sql</td>
<td>Create or Replace View Script</td>
<td>copy and execute as APPS</td>
</tr>
<tr>
<td>create_trigger</td>
<td>sql</td>
<td>Create or Replace Trigger Script</td>
<td>copy and execute as APPS</td>
</tr>
<tr>
<td>create_type</td>
<td>sql</td>
<td>Create or Replace Type Script</td>
<td>copy and execute as APPS</td>
</tr>
<tr>
<td>create_index</td>
<td>sql</td>
<td>Create Index Script</td>
<td>copy and execute as APPS</td>
</tr>
<tr>
<td>seed_data</td>
<td>sql</td>
<td>Custom Seeded Data SQL script</td>
<td>copy and execute as APPS</td>
</tr>
<tr>
<td>create_synonym</td>
<td>sql</td>
<td>Create View Synonym Script</td>
<td>copy and execute as APPS</td>
</tr>
<tr>
<td>jsp</td>
<td>jsp</td>
<td>Java server page</td>
<td>copy</td>
</tr>
<tr>
<td>res</td>
<td>res</td>
<td>resource file to store WF messages and used by WF Resource Generator</td>
<td>copy</td>
</tr>
<tr>
<td>ps</td>
<td>ps</td>
<td>Postscript Pages</td>
<td>copy</td>
</tr>
<tr>
<td>File Type Name</td>
<td>Source Extension</td>
<td>Description</td>
<td>Object Action</td>
</tr>
<tr>
<td>----------------</td>
<td>------------------</td>
<td>------------------------------------------------------------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>properties</td>
<td>properties</td>
<td>Java Property Class</td>
<td>copy</td>
</tr>
<tr>
<td>pll (Forms)</td>
<td>pll</td>
<td>compiled Forms library</td>
<td>copy and run genfppll</td>
</tr>
<tr>
<td>pll (Reports)</td>
<td>pll</td>
<td>compiled Reports library</td>
<td>copy and run genrpll</td>
</tr>
<tr>
<td>ogd</td>
<td>ogd</td>
<td>Oracle Graphics</td>
<td>copy</td>
</tr>
<tr>
<td>env</td>
<td>env</td>
<td>environment file</td>
<td>copy</td>
</tr>
<tr>
<td>js</td>
<td>js</td>
<td>Javascript file</td>
<td>copy</td>
</tr>
<tr>
<td>rpt</td>
<td>rpt</td>
<td>Oracle Reports file</td>
<td>copy</td>
</tr>
<tr>
<td>jar</td>
<td>jar</td>
<td>Java archive file</td>
<td>copy</td>
</tr>
<tr>
<td>Pls</td>
<td>pls</td>
<td>PL/SQL package specification</td>
<td>copy and execute as APPS</td>
</tr>
<tr>
<td>Pks</td>
<td>pks</td>
<td>PL/SQL package specification</td>
<td>copy and execute as APPS</td>
</tr>
<tr>
<td>so</td>
<td>so</td>
<td>UNIX shared library</td>
<td>copy</td>
</tr>
<tr>
<td>Jpx</td>
<td>jpx</td>
<td>BC4J Substitution</td>
<td>copy</td>
</tr>
<tr>
<td>vsd</td>
<td>vsd</td>
<td>source file for gif files used in translations</td>
<td>copy</td>
</tr>
<tr>
<td>dtd</td>
<td>dtd</td>
<td>XML Document Type Definition</td>
<td>copy</td>
</tr>
<tr>
<td>xss</td>
<td>xss</td>
<td>Extensible Style Sheet definition</td>
<td>copy</td>
</tr>
<tr>
<td>wbmp</td>
<td>wbmp</td>
<td>bitmap file for wireless devices</td>
<td>copy</td>
</tr>
<tr>
<td>xgm</td>
<td>xgm</td>
<td>XML Gateway Mapping file</td>
<td>copy</td>
</tr>
<tr>
<td>xgd</td>
<td>xgd</td>
<td>XML Gateway Data definition file</td>
<td>copy</td>
</tr>
<tr>
<td>File Type Name</td>
<td>Source Extension</td>
<td>Description</td>
<td>Object Action</td>
</tr>
<tr>
<td>----------------</td>
<td>------------------</td>
<td>-------------</td>
<td>---------------</td>
</tr>
<tr>
<td>pl</td>
<td>pl</td>
<td>Perl Scripts</td>
<td>copy</td>
</tr>
<tr>
<td>pm</td>
<td>pm</td>
<td>Perl Modules</td>
<td>copy</td>
</tr>
<tr>
<td>drvx</td>
<td>drvx</td>
<td>database driver exception file</td>
<td>copy</td>
</tr>
<tr>
<td>pkb</td>
<td>pkb</td>
<td>package body</td>
<td>copy and execute as APPS</td>
</tr>
<tr>
<td>software css</td>
<td>css</td>
<td>used in software patches</td>
<td>copy</td>
</tr>
<tr>
<td>mac</td>
<td>mac</td>
<td></td>
<td>copy</td>
</tr>
<tr>
<td>cfg</td>
<td>cfg</td>
<td>configuration file</td>
<td>copy</td>
</tr>
<tr>
<td>txt</td>
<td>txt</td>
<td>plain text file</td>
<td>copy</td>
</tr>
<tr>
<td>uix</td>
<td>uix</td>
<td>user interface XML</td>
<td>copy</td>
</tr>
<tr>
<td>hct</td>
<td>hct</td>
<td>HRMS fast formula loader control file</td>
<td>copy</td>
</tr>
<tr>
<td>hdt</td>
<td>hdt</td>
<td>HRMS fast formula loader data file</td>
<td>copy</td>
</tr>
<tr>
<td>pdt</td>
<td>pdt</td>
<td>HRMS legislative loader data file</td>
<td>copy</td>
</tr>
<tr>
<td>csv</td>
<td>csv</td>
<td>file from which user-needed data is imported</td>
<td>copy</td>
</tr>
<tr>
<td>ear</td>
<td>ear</td>
<td>an EJB .jar archive with XML contents in the META-INF</td>
<td>copy</td>
</tr>
<tr>
<td>xdf</td>
<td>xdf</td>
<td>XML files containing object definitions</td>
<td>copy and execute using FNDXDFCMP</td>
</tr>
<tr>
<td>JRAD/MDS File</td>
<td>xml</td>
<td>JRAD Files are xml extensions. These extensions should be used for Oracle Application Framework objects under the mds directory.</td>
<td>copy and load using XMLImporter</td>
</tr>
<tr>
<td>File Type Name</td>
<td>Source Extension</td>
<td>Description</td>
<td>Object Action</td>
</tr>
<tr>
<td>----------------</td>
<td>------------------</td>
<td>-------------</td>
<td>---------------</td>
</tr>
<tr>
<td>xlf</td>
<td>xlf</td>
<td>XLF files are generated from xml files</td>
<td>copy</td>
</tr>
<tr>
<td>document gif</td>
<td>gif</td>
<td>used in document patches; image files</td>
<td>copy</td>
</tr>
<tr>
<td>document htm</td>
<td>htm</td>
<td>used in document patches; HTML files</td>
<td>copy</td>
</tr>
<tr>
<td>document ldt</td>
<td>ldt</td>
<td>used in document patches; navigation library files</td>
<td>copy and upload using FNDLOAD</td>
</tr>
<tr>
<td>document css</td>
<td>css</td>
<td>used in document patches; cascading stylesheet file</td>
<td>copy and execute using FNDGFU</td>
</tr>
<tr>
<td>tld</td>
<td>tld</td>
<td>tag library definition file</td>
<td>copy</td>
</tr>
<tr>
<td>xsd</td>
<td>xsd</td>
<td>XML Schema provides a means for defining the structure of XML documents</td>
<td>copy</td>
</tr>
<tr>
<td>XMLP XSL</td>
<td>xsl</td>
<td>XML Publisher (XDO) non-translatable XSL templates</td>
<td>copy</td>
</tr>
<tr>
<td>interface ldt</td>
<td>n</td>
<td>Interface Repository loader file</td>
<td>copy</td>
</tr>
<tr>
<td>XMLP RTF template</td>
<td>rtf</td>
<td>XML Publisher (XDO) translatable templates</td>
<td>copy</td>
</tr>
<tr>
<td>XMLP xlf</td>
<td>xlf</td>
<td>xlf files generated from translatable XMLP templates</td>
<td>copy</td>
</tr>
<tr>
<td>xdf(AW) xlf</td>
<td>xlf</td>
<td>Analytic Workspaces XML files containing object definitions</td>
<td>copy</td>
</tr>
<tr>
<td>pkh (no n)</td>
<td>pkh</td>
<td>package definition</td>
<td>copy</td>
</tr>
<tr>
<td>File Type Name</td>
<td>Source Extension</td>
<td>Description</td>
<td>Object Action</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------</td>
<td>---------------------------------------------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>wsdl</td>
<td>wsdl</td>
<td>Web Services Description Language File</td>
<td>copy</td>
</tr>
<tr>
<td>XMLP RTF</td>
<td>rtf</td>
<td>XML Publisher (XDO) non-translatable RTF</td>
<td>copy</td>
</tr>
<tr>
<td></td>
<td></td>
<td>templates (recommended)</td>
<td></td>
</tr>
<tr>
<td>XMLP PDF</td>
<td>pdf</td>
<td>XML Publisher (XDO) PDF non-translatable</td>
<td>copy</td>
</tr>
<tr>
<td></td>
<td></td>
<td>XML templates (recommended)</td>
<td></td>
</tr>
<tr>
<td>XMLP XML</td>
<td>xml</td>
<td>XML Publisher (XDO) non-translatable XML</td>
<td>copy</td>
</tr>
<tr>
<td></td>
<td></td>
<td>templates</td>
<td></td>
</tr>
<tr>
<td>XMLP XSD</td>
<td>xsd</td>
<td>XML Publisher (XDO) non-translatable XML</td>
<td>copy</td>
</tr>
<tr>
<td></td>
<td></td>
<td>templates</td>
<td></td>
</tr>
<tr>
<td>jspx</td>
<td>jspx</td>
<td>JSP document</td>
<td>copy</td>
</tr>
<tr>
<td>java_lib</td>
<td>jar</td>
<td>Java library (for compilation only)</td>
<td>Use jar only for compiling; jar is not included into the patch</td>
</tr>
<tr>
<td>package_spec</td>
<td>sql</td>
<td>package specification</td>
<td>copy and execute as APPS</td>
</tr>
<tr>
<td>package_body</td>
<td>sql</td>
<td>package body</td>
<td>copy and execute as APPS</td>
</tr>
<tr>
<td>create_table</td>
<td>sql</td>
<td>Create Table Script</td>
<td>copy and execute as APPS</td>
</tr>
<tr>
<td>alter_table</td>
<td>sql</td>
<td>Alter Table Script</td>
<td>copy and execute as APPS</td>
</tr>
<tr>
<td>create_sequence</td>
<td>sql</td>
<td>Create Sequence Script</td>
<td>copy and execute as APPS</td>
</tr>
<tr>
<td>alter_sequence</td>
<td>sql</td>
<td>Alter Sequence Script</td>
<td>copy and execute as APPS</td>
</tr>
<tr>
<td>create_table_owner</td>
<td>sql</td>
<td>Create Table Schema Owner Script</td>
<td>copy and execute as schema owner</td>
</tr>
<tr>
<td>alter_table_owner</td>
<td>sql</td>
<td>Alter Table Owner Script (run as schema owner)</td>
<td>copy and execute as schema owner</td>
</tr>
<tr>
<td>File Type Name</td>
<td>Source Extension</td>
<td>Description</td>
<td>Object Action</td>
</tr>
<tr>
<td>------------------------</td>
<td>------------------</td>
<td>--------------------------------------------------</td>
<td>--------------------------------</td>
</tr>
<tr>
<td>create_index_owner</td>
<td>sql</td>
<td>Create Index Owner Script</td>
<td>copy and execute as schema owner</td>
</tr>
<tr>
<td>sql_owner</td>
<td>sql</td>
<td>Generic SQL Owner Script (copy only)</td>
<td>copy and execute as schema owner</td>
</tr>
<tr>
<td>create_view_owner</td>
<td>sql</td>
<td>Create View Owner Script</td>
<td>copy and execute as schema owner</td>
</tr>
<tr>
<td>create_synonym_owner</td>
<td>sql</td>
<td>Create Synonym Owner Script</td>
<td>copy and execute as schema owner</td>
</tr>
<tr>
<td>plx</td>
<td>plx</td>
<td>Oracle Forms library file executable</td>
<td>copy</td>
</tr>
<tr>
<td>dat</td>
<td>dat</td>
<td></td>
<td>copy</td>
</tr>
<tr>
<td>ico</td>
<td>ico</td>
<td>icon file</td>
<td>copy</td>
</tr>
<tr>
<td>dmp</td>
<td>dmp</td>
<td></td>
<td>copy</td>
</tr>
<tr>
<td>exp</td>
<td>exp</td>
<td></td>
<td>copy</td>
</tr>
<tr>
<td>fdo</td>
<td>fdo</td>
<td></td>
<td>copy</td>
</tr>
<tr>
<td>frm</td>
<td>frm</td>
<td></td>
<td>copy</td>
</tr>
<tr>
<td>hlp</td>
<td>hlp</td>
<td>help file</td>
<td>copy</td>
</tr>
<tr>
<td>inc</td>
<td>inc</td>
<td></td>
<td>copy</td>
</tr>
<tr>
<td>inp</td>
<td>inp</td>
<td></td>
<td>copy</td>
</tr>
<tr>
<td>msb</td>
<td>msb</td>
<td>Message Dictionary file</td>
<td>copy</td>
</tr>
<tr>
<td>obd</td>
<td>obd</td>
<td>online help file</td>
<td>copy</td>
</tr>
<tr>
<td>cmd</td>
<td>cmd</td>
<td>NT Command File</td>
<td>copy</td>
</tr>
<tr>
<td>csh</td>
<td>csh</td>
<td>shell script file</td>
<td>copy</td>
</tr>
<tr>
<td>File Type Name</td>
<td>Source Extension</td>
<td>Description</td>
<td>Object Action</td>
</tr>
<tr>
<td>----------------</td>
<td>------------------</td>
<td>-------------</td>
<td>---------------</td>
</tr>
<tr>
<td>dbt</td>
<td>dbt</td>
<td>database text file</td>
<td>copy</td>
</tr>
<tr>
<td>def</td>
<td>def</td>
<td></td>
<td>copy</td>
</tr>
<tr>
<td>flt</td>
<td>flt</td>
<td></td>
<td>copy</td>
</tr>
<tr>
<td>fmt</td>
<td>fmt</td>
<td>Oracle Forms form source text file</td>
<td>copy</td>
</tr>
<tr>
<td>fpp</td>
<td>fpp</td>
<td></td>
<td>copy</td>
</tr>
<tr>
<td>fxp</td>
<td>fxp</td>
<td></td>
<td>copy</td>
</tr>
<tr>
<td>imp</td>
<td>imp</td>
<td></td>
<td>copy</td>
</tr>
<tr>
<td>mk</td>
<td>mk</td>
<td>make file</td>
<td>copy</td>
</tr>
<tr>
<td>mmt</td>
<td>mmt</td>
<td>menu text file</td>
<td>copy</td>
</tr>
<tr>
<td>prog</td>
<td>.prog</td>
<td>Host concurrent program</td>
<td>copy</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>create a symbolic link using $FND_TOP/patch/115/bin</td>
</tr>
<tr>
<td>pc</td>
<td>pc</td>
<td>Pro*C program</td>
<td>copy</td>
</tr>
<tr>
<td>Scr</td>
<td>scr</td>
<td>script file generated by the Oracle Scripting Script Builder tool&quot;</td>
<td>copy</td>
</tr>
<tr>
<td>MSI</td>
<td>xml</td>
<td>Manual Step File</td>
<td>copy</td>
</tr>
<tr>
<td>ttf</td>
<td>ttf</td>
<td>TrueType font definition file</td>
<td>copy</td>
</tr>
<tr>
<td>conf</td>
<td>conf</td>
<td>configuration file to be released along the product</td>
<td>copy</td>
</tr>
<tr>
<td>mdl</td>
<td>mdl</td>
<td>text file created by Oracle Warehouse Builder (OWB) metadata loader file for data import</td>
<td>copy</td>
</tr>
<tr>
<td>File Type Name</td>
<td>Source Extension</td>
<td>Description</td>
<td>Object Action</td>
</tr>
<tr>
<td>----------------</td>
<td>------------------</td>
<td>-------------</td>
<td>---------------</td>
</tr>
<tr>
<td>thtml</td>
<td>thtml</td>
<td>template toolkit for ISD</td>
<td>copy</td>
</tr>
<tr>
<td>uit</td>
<td>uit</td>
<td>custom renderer for the FWK header component</td>
<td>copy</td>
</tr>
<tr>
<td>mif</td>
<td>mif</td>
<td>XML file that contains schematic information about graphical representation of the structure (RMIM)</td>
<td>copy</td>
</tr>
<tr>
<td>coremif</td>
<td>coremif</td>
<td>XML file that contains schematic information about graphical representation of the structure (RMIM)</td>
<td>copy</td>
</tr>
<tr>
<td>xcfg</td>
<td>xcfg</td>
<td>ADF XML configuration file</td>
<td>copy</td>
</tr>
<tr>
<td>rts</td>
<td>rts</td>
<td>resource bundle file for java related tool is Tecate</td>
<td>copy</td>
</tr>
<tr>
<td>x2h</td>
<td>x2h</td>
<td>X2h format file for ISD</td>
<td>copy</td>
</tr>
<tr>
<td>ppp</td>
<td>ppp</td>
<td></td>
<td>copy</td>
</tr>
<tr>
<td>tag</td>
<td>tag</td>
<td></td>
<td>copy</td>
</tr>
<tr>
<td>ora</td>
<td>ora</td>
<td>Net8 configuration files (listener.ora, tnsnames.ora)</td>
<td>copy</td>
</tr>
<tr>
<td>inf</td>
<td>inf</td>
<td>used for applying updates to windows registry</td>
<td>copy</td>
</tr>
<tr>
<td>app</td>
<td>app</td>
<td>used to configure the apache single listener (modplsql)</td>
<td>copy</td>
</tr>
<tr>
<td>tcl</td>
<td>tcl</td>
<td>TCL scripts called by Oracle Enterprise Manager’s Intelligent Agent for hosted Exchange products</td>
<td>copy</td>
</tr>
<tr>
<td>fdi</td>
<td>fdi</td>
<td></td>
<td>copy</td>
</tr>
<tr>
<td>File Type Name</td>
<td>Source Extension</td>
<td>Description</td>
<td>Object Action</td>
</tr>
<tr>
<td>----------------</td>
<td>------------------</td>
<td>-------------</td>
<td>---------------</td>
</tr>
<tr>
<td>clx</td>
<td>clx</td>
<td>spell-checking dictionary file in compressed lexicon format</td>
<td>copy</td>
</tr>
<tr>
<td>tlx</td>
<td>tlx</td>
<td>spell-checking dictionary file in text lexicon format</td>
<td>copy</td>
</tr>
<tr>
<td>Z</td>
<td>Z</td>
<td>Adaptive Lempel-Ziv compressed file</td>
<td>copy</td>
</tr>
<tr>
<td>tpl</td>
<td>tpl</td>
<td>template files</td>
<td>copy</td>
</tr>
<tr>
<td>amx</td>
<td>amx</td>
<td>standard XML file</td>
<td>copy</td>
</tr>
<tr>
<td>ftg</td>
<td>ftg</td>
<td></td>
<td>copy</td>
</tr>
<tr>
<td>rlt</td>
<td>rlt</td>
<td></td>
<td>copy</td>
</tr>
<tr>
<td>ctl</td>
<td>ctl</td>
<td>SQL*Loader file</td>
<td>copy</td>
</tr>
<tr>
<td>rsp</td>
<td>rsp</td>
<td>Rapid Install response file</td>
<td>copy</td>
</tr>
<tr>
<td>prc</td>
<td>prc</td>
<td>Palm Pilot application file</td>
<td>copy</td>
</tr>
<tr>
<td>odb</td>
<td>odb</td>
<td>Oracle Lite database file required from Mobile Applications</td>
<td>copy</td>
</tr>
<tr>
<td>llt</td>
<td>llt</td>
<td></td>
<td>copy</td>
</tr>
<tr>
<td>software gif</td>
<td>gif</td>
<td>image file (Graphics Interchange Format)</td>
<td>copy</td>
</tr>
<tr>
<td>msg</td>
<td>msg</td>
<td>FND Message Loader Text</td>
<td>copy</td>
</tr>
<tr>
<td>OAF Component</td>
<td>java</td>
<td>Oracle Application Framework customizations</td>
<td>compile and deploy under $JAVA_TOP</td>
</tr>
</tbody>
</table>

**Recommended Locations for Common File Types**

The following table lists recommended locations for some commonly-used file types.
<table>
<thead>
<tr>
<th>File Types</th>
<th>Description</th>
<th>Recommended destination path (relative to product top)</th>
</tr>
</thead>
<tbody>
<tr>
<td>sql, package_spec, package_body,</td>
<td>SQL, PL/SQL files</td>
<td>patch/115/sql</td>
</tr>
<tr>
<td>create_table, alter_table,</td>
<td></td>
<td></td>
</tr>
<tr>
<td>create_sequence, alter_sequence,</td>
<td></td>
<td></td>
</tr>
<tr>
<td>create_view, create_trigger,</td>
<td></td>
<td></td>
</tr>
<tr>
<td>create_type, create_index,</td>
<td></td>
<td></td>
</tr>
<tr>
<td>seed_data, create_synonym, pkh,</td>
<td></td>
<td></td>
</tr>
<tr>
<td>plb, pls, pkb, create_table_owner,</td>
<td></td>
<td></td>
</tr>
<tr>
<td>alter_table_owner, create_index_owner,</td>
<td></td>
<td></td>
</tr>
<tr>
<td>sql_owner, create_view_owner,</td>
<td></td>
<td></td>
</tr>
<tr>
<td>create_synonym_owner</td>
<td></td>
<td></td>
</tr>
<tr>
<td>software ldt</td>
<td>All Generic Loader (FNDLOAD)</td>
<td>patch/115/import/&lt;LANG&gt;; for example, 'patch/115/import/US'</td>
</tr>
<tr>
<td>sh</td>
<td>Shell script</td>
<td>bin</td>
</tr>
<tr>
<td>pl</td>
<td>Perl script</td>
<td>bin</td>
</tr>
<tr>
<td>prog</td>
<td>Host concurrent program</td>
<td>bin</td>
</tr>
<tr>
<td>xdf</td>
<td>XDF file</td>
<td>patch/115/xfd</td>
</tr>
<tr>
<td>fmb</td>
<td>Forms</td>
<td>forms/&lt;LANG&gt;; for example, forms/US</td>
</tr>
<tr>
<td>rdf</td>
<td>Report</td>
<td>reports/&lt;LANG&gt;; for example, reports/US</td>
</tr>
<tr>
<td>html, xsl, xss, css</td>
<td>HTML and style sheets</td>
<td>html</td>
</tr>
<tr>
<td>jsp</td>
<td>JSP</td>
<td>html</td>
</tr>
<tr>
<td>XML Publisher templates</td>
<td>XML Publisher templates</td>
<td>patch/115/publisher/templates</td>
</tr>
<tr>
<td>java</td>
<td>Java files</td>
<td>java/&lt;package path&gt;; for example, java/test for the file oracle/apps/newprod/test/hello.java</td>
</tr>
<tr>
<td>File Types</td>
<td>Description</td>
<td>Recommended destination path (relative to product top)</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------------------------------</td>
<td>--------------------------------------------------------</td>
</tr>
<tr>
<td>JRAD/MDS file</td>
<td>Oracle Application Framework-related XML files</td>
<td>mds/&lt;path&gt;</td>
</tr>
<tr>
<td>gif</td>
<td>Image files</td>
<td>media</td>
</tr>
<tr>
<td>pm</td>
<td>Perl module</td>
<td>perl/&lt;path&gt;</td>
</tr>
<tr>
<td>wfx</td>
<td>wfx file</td>
<td>patch/115/xml</td>
</tr>
</tbody>
</table>

### Execution Sequence of SQL File Types

The following table lists the execution sequence of SQL file types.

<table>
<thead>
<tr>
<th>File Type</th>
<th>Description</th>
<th>Order Of Execution</th>
</tr>
</thead>
<tbody>
<tr>
<td>create_sequence</td>
<td>Create sequence script</td>
<td>1</td>
</tr>
<tr>
<td>create_table</td>
<td>Create table script</td>
<td>2</td>
</tr>
<tr>
<td>create_table_owner</td>
<td>Create table in custom schema</td>
<td>2</td>
</tr>
<tr>
<td>alter_table</td>
<td>Alter table script</td>
<td>3</td>
</tr>
<tr>
<td>alter_sequence</td>
<td>Alter sequence script</td>
<td>3</td>
</tr>
<tr>
<td>alter_table_owner</td>
<td>Alter table in custom schema</td>
<td>3</td>
</tr>
<tr>
<td>create_type</td>
<td>Create or replace type script</td>
<td>4</td>
</tr>
<tr>
<td>package_spec</td>
<td>Package specification</td>
<td>5</td>
</tr>
<tr>
<td>create_view</td>
<td>Create or replace view script</td>
<td>6</td>
</tr>
<tr>
<td>create_synonym</td>
<td>Create view synonym script</td>
<td>6</td>
</tr>
<tr>
<td>create_view_owner</td>
<td>Create view in custom schema</td>
<td>6</td>
</tr>
<tr>
<td>File Type</td>
<td>Description</td>
<td>Order Of Execution</td>
</tr>
<tr>
<td>----------------------</td>
<td>--------------------------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>create_synonym_owner</td>
<td>Create synonym in custom schema</td>
<td>6</td>
</tr>
<tr>
<td>package_body</td>
<td>Package body</td>
<td>7</td>
</tr>
<tr>
<td>seed_data</td>
<td>Custom seeded data SQL script</td>
<td>8</td>
</tr>
<tr>
<td>create_index</td>
<td>Create index script</td>
<td>9</td>
</tr>
<tr>
<td>create_index_owner</td>
<td>Create index in custom schema</td>
<td>9</td>
</tr>
<tr>
<td>create_trigger</td>
<td>Create or replace trigger script</td>
<td>10</td>
</tr>
<tr>
<td>sql</td>
<td>Generic</td>
<td>11</td>
</tr>
<tr>
<td>sql_owner</td>
<td>Run SQL in custom schema</td>
<td>11</td>
</tr>
</tbody>
</table>

For example, the type create_sequence will execute before the type create_table or create_table_owner. The types create_table/create_table_owner will execute in parallel before the types alter_table/alter_sequence/alter_table_owner.
This appendix covers the following topics:
- Customization Manager Coding Standards for Files
- Customization Manager Coding Standards for Database Objects

Customization Manager Coding Standards for Files

Customization Manager has a standards checker to check that the files included in a custom package meet certain coding standards. This checker tests all code for standards compliance.

Some standards are mandatory and will result in failure when Customization Manager attempts to build the package. Other standards are recommended, and the standards checker will give a warning but the package will be built.

Mandatory File Standards

The standards in the following table must be met. If a file does not meet these standards then Customization Manager will not build the package containing it.

<table>
<thead>
<tr>
<th>Standard Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header Check</td>
<td>Each file must have an Oracle-compliant source header present.</td>
</tr>
<tr>
<td>PLD File Location Standard</td>
<td>PLD files must be located somewhere under one of following directories: resource, plsql, graphs.</td>
</tr>
</tbody>
</table>
## Standard Name Description

<table>
<thead>
<tr>
<th>Standard Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SQL using CONNECT Standard</td>
<td>SQL files using a &quot;connect&quot; statement must have a valid dbdrv hint provided within the file.</td>
</tr>
<tr>
<td>Java Destination Path Standard</td>
<td>For Java files within a package, the destination path must start with &quot;java&quot;.</td>
</tr>
<tr>
<td>Java Package Path Standard</td>
<td>For Java files within a package, the destination path for the Java file must match its package structure.</td>
</tr>
</tbody>
</table>

## Other File Standards

The following table lists standards that if not met, will result in a Warning but the package will still be built.

<table>
<thead>
<tr>
<th>Standard Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Java SOP Check</td>
<td>Java files must not use System.out.print</td>
</tr>
<tr>
<td>Java System.gc() Check</td>
<td>Java files must not use System.gc</td>
</tr>
<tr>
<td>SQL dual reference check</td>
<td>SQL files must not use System.dual, instead use dual</td>
</tr>
<tr>
<td>PERL module location</td>
<td>Perl module must be located anywhere under perl directory</td>
</tr>
<tr>
<td>PERL file location</td>
<td>Perl files must be located under one of following directories: bin, patch/[release]/bin,admin/template/admin/template/*</td>
</tr>
<tr>
<td>SQL comment standard</td>
<td>SQL file should not have -- as comment</td>
</tr>
<tr>
<td>SQL file (!) check</td>
<td>SQL file should not have ! character</td>
</tr>
<tr>
<td>PLS (!) check</td>
<td>PLS file should not have ! character</td>
</tr>
<tr>
<td>JRAD halign check</td>
<td>JRAD XML files should not contain hAlign</td>
</tr>
<tr>
<td>Java package name check</td>
<td>All Java classes must be in packages beginning with: oracle.apps.[prod_name]</td>
</tr>
<tr>
<td>Standard Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Java System.err Check Standard</td>
<td>Java files must not use System.err</td>
</tr>
<tr>
<td>SQL file location check</td>
<td>SQL files must be located under one of following directories: admin/sql,admin/template,admin/template/*,patch/ [some dir]/sql,sql</td>
</tr>
<tr>
<td>Drvx file location check</td>
<td>Drvx files must be located under one of following directories: patch/[some dir]/driver, admin/template,admin/template/*</td>
</tr>
<tr>
<td>Driver File Location Standard</td>
<td>Driver files must be located under one of following directories: admin/driver,patch/[some dir]/driver, admin/template,admin/template/*</td>
</tr>
<tr>
<td>LCT File Location Standard</td>
<td>LCT files must be located under one of following directories: admin/import,patch/[some dir]/import,upgrade/[some dir]/import,admin/template,admin/template/*</td>
</tr>
<tr>
<td>LDT File Location Standard</td>
<td>LDT files must be located under one of following directories: admin/import,patch/[some dir]/import,help,,admin/template,admin/template/*</td>
</tr>
<tr>
<td>PKG File Location Standard</td>
<td>Package files must be located under one of following directories: admin/sql,patch/[some dir]/sql,admin/template,admin/template/*</td>
</tr>
<tr>
<td>RTF File Location Standard</td>
<td>RTF files must be located under : patch/115/publisher/templates</td>
</tr>
<tr>
<td>XSS Location Standard</td>
<td>XSS files must be located under one of following directories: html,admin/template,admin/template/*</td>
</tr>
<tr>
<td>HCT Location Standard</td>
<td>HCT files must be located under one of following directories: patch/[some dir]/import,admin/template,admin/template/*</td>
</tr>
<tr>
<td>HDT Location Standard</td>
<td>HDT files must be located under one of following directories: patch/[some dir]/import,admin/template,admin/template/*</td>
</tr>
<tr>
<td>PDT Location Standard</td>
<td>PDT files must be located under one of following directories: patch/[some dir]/import,admin/template,admin/template/*</td>
</tr>
<tr>
<td>Standard Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>JavaScript Location</td>
<td>JavaScript files must be located under one of following directories: html, patch/[some dir]/html, upgrade/[some dir]/html, admin/template, admin/template/*</td>
</tr>
<tr>
<td>PrintStackTrace Check</td>
<td>Using printStackTrace is not recommended</td>
</tr>
<tr>
<td>Workflow Location</td>
<td>Workflow files must be located under one of following directories: admin/import, patch/[some dir]/import, admin/template, admin/template/*</td>
</tr>
<tr>
<td>XDF Location</td>
<td>XDF files must be located under one of following directories: admin/xdf, patch/[some dir]/xdf, patch/[some dir]/xdf/aw/US</td>
</tr>
<tr>
<td>Absolute URL Check</td>
<td>Check for absolute URLs</td>
</tr>
<tr>
<td>Report Printer Def File</td>
<td>Report printer files must be located under one of following directories: reports, admin/template, admin/template/*</td>
</tr>
<tr>
<td>Form Location</td>
<td>Form files must be located under one of following directories: forms, admin/template, admin/template/*</td>
</tr>
<tr>
<td>JAR Location</td>
<td>Jar files must be located under one of following directories: java/3rdparty, java/3rdparty/stdalone, admin/template, admin/template/, patch/115/jar/bpel</td>
</tr>
<tr>
<td>JSP Location</td>
<td>JSP files must be located under one of following directories: html, html/jsp/[PROD], html/jsp/[PROD]/[MOD], html/jsp/[PROD]/[MOD]/[sub MOD], admin/template, admin/template/*</td>
</tr>
<tr>
<td>Dependency Files Location</td>
<td>Dependency files must be located under one of following directories: java/make, admin/template, admin/template/*</td>
</tr>
<tr>
<td>CMD file Location</td>
<td>CMD files must be located under one of following directories: admin/template, admin/template/*, bin</td>
</tr>
<tr>
<td>XML Location</td>
<td>XML files must be located under one of following directories: html, java, mds, patch/115/publisher/defs, admin/template, admin/template/*, patch/115/manualsteps.</td>
</tr>
<tr>
<td>XGM Location</td>
<td>XGM files must be located under one of following directories: patch/[some dir]/xml/US, admin/template, admin/template/*</td>
</tr>
<tr>
<td>Standard Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>XSL Location Standard</td>
<td>XSL files must be located under one of following directories: html, admin/xdf/xsl, patch/[some dir]/xdf/xsl, patch/[some dir]</td>
</tr>
<tr>
<td>ForceViewCheck</td>
<td>One must use FORCE in CREATE statements in view creation scripts</td>
</tr>
<tr>
<td>Show Error Check</td>
<td>SQL scripts must not contain the Show errors command</td>
</tr>
<tr>
<td>Absolute URL Check</td>
<td>Having absolute URLs is not recommended</td>
</tr>
<tr>
<td>Pkg Replace Check</td>
<td>Use CREATE OR REPLACE PACKAGE for package creation. Do not omit OR REPLACE</td>
</tr>
<tr>
<td>Pkg Create IS Check</td>
<td>Package creation must not use IS. Instead should always use AS</td>
</tr>
<tr>
<td>Xml Parse Standard</td>
<td>XML files should be well-formed</td>
</tr>
<tr>
<td>Control M Standard</td>
<td>Text files should not have control M [^M] character</td>
</tr>
<tr>
<td>SQL NoLogging Check</td>
<td>Using NOLogging in SQL scripts is not recommended</td>
</tr>
<tr>
<td>SQL Serveroutput Check</td>
<td>Using set serveroutput on in SQL scripts is not recommended</td>
</tr>
<tr>
<td>Wfx File Naming Standard</td>
<td>WFX filename must end in s, e, or a, i.e. [s</td>
</tr>
<tr>
<td>16.3 File Naming Standard</td>
<td>Filename should adhere to the 16.3 naming standard</td>
</tr>
<tr>
<td>Set Scan Off Standard</td>
<td>Package creation scripts containing ampersand must have SET SCAN OFF</td>
</tr>
<tr>
<td>Drop Table check</td>
<td>Drop table should not be used in SQL/PLSQL files as it can result in loss of data</td>
</tr>
<tr>
<td>SQL Max Line Length</td>
<td>No line in a SQL file should be longer than 255 characters</td>
</tr>
<tr>
<td>FNDSLOAD Check Standard</td>
<td>FNDSLOAD is obsolete. No dbdrv: hints should refer to FNDSLOAD</td>
</tr>
<tr>
<td><strong>Standard Name</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>---------------------------</td>
<td>--------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Drop Column check</td>
<td>Drop Column should not be used in SQL/PLSQL files</td>
</tr>
<tr>
<td>Long Raw check</td>
<td>LONG or LONG RAW columns should not be used</td>
</tr>
<tr>
<td>Insert Column check</td>
<td>INSERT SQL statements, should explicitly list the columns about to insert</td>
</tr>
<tr>
<td>FNDLOAD/FNDLOADSO syntax</td>
<td>FNDLOAD/FNDLOADSO must have correct syntax</td>
</tr>
<tr>
<td>Admin Dbdrv none check</td>
<td>All files under [PROD_TOP]/admin must have only dbdrv: none</td>
</tr>
<tr>
<td>NLADD Sql Check</td>
<td>There should be no [PROD]NLADD.sql files in R12 patches</td>
</tr>
<tr>
<td>FNDLOAD ldtt phase</td>
<td>dbdrv: FNDLOAD ldtt files must have correct phase</td>
</tr>
<tr>
<td>Menu file location</td>
<td>Menu files must be located under one of following directories: resource,admin/template,admin/template/*</td>
</tr>
<tr>
<td>WFX file location check</td>
<td>WFX files must be located under one of following directories: patch/[some dir]/xml,admin/template,admin/template/*</td>
</tr>
<tr>
<td>Create single line check</td>
<td>In SQL files, CREATE command must occur on one line only.</td>
</tr>
<tr>
<td>SQL exit check</td>
<td>SQL files must end with exit</td>
</tr>
<tr>
<td>Package SpecBody Same file</td>
<td>The package specification and body should be in different files</td>
</tr>
<tr>
<td>SQL Absolute path Check</td>
<td>SQL files should not have absolute path in a @ or @@ statements</td>
</tr>
<tr>
<td>Calling SQL script check</td>
<td>Use start or @ when calling a SQL script within a SQL script. Do not use @@.</td>
</tr>
<tr>
<td>Appsyspub Schema Check</td>
<td>Custom scripts are not allowed to modify APPLSYSPPUB schema</td>
</tr>
<tr>
<td>Custom File Naming Standard</td>
<td>All files involved in the package must be for a product prefixed with xx&quot;&quot;</td>
</tr>
<tr>
<td>Standard Name</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Pkg body creation Standard</td>
<td>Package body creation scripts should not be in pkh files</td>
</tr>
<tr>
<td>Pkg spec creation Standard</td>
<td>Package Spec creation scripts should not be in pkb and plb files</td>
</tr>
<tr>
<td>Mview Build deferred Standard</td>
<td>Materialized Views must be created with BUILD DEFERRED option</td>
</tr>
<tr>
<td>Mview Parallel Standard</td>
<td>Materialized Views should not be created with parallel command</td>
</tr>
<tr>
<td>Mview prebuilt Standard</td>
<td>Materialized Views must not be created with ON PREBUILT TABLE option</td>
</tr>
<tr>
<td>Report Location Standard</td>
<td>Report files must be located under one of following directories: reports,admin/template,admin/template/*</td>
</tr>
<tr>
<td>Import stmt Check</td>
<td>Java import statements must reference fully qualified Class names</td>
</tr>
<tr>
<td>Language check in destination path</td>
<td>The destination path for a file entry in the package creation process should not have the language code as a suffix. The language should be specified separately.</td>
</tr>
<tr>
<td>JRAD XML file type</td>
<td>During the package creation process, if an XML file is included with the file type as 'JRAD XML' (File type ID is 1005), then the destination path should start with 'mds'.</td>
</tr>
<tr>
<td>Control-M characters in PLD files</td>
<td>If a PLD file contains a control-M character, then some issues may arise while applying a patch containing this PLD file.</td>
</tr>
<tr>
<td>SQL whenever sqlerror exit failure rollback</td>
<td>A SQL Script should contain &quot;WHENEVER SQLERROR EXIT FAILURE ROLLBACK;&quot;.</td>
</tr>
<tr>
<td>Java file empty catch block</td>
<td>An empty catch Block finds instances where an exception is caught, but nothing is done.</td>
</tr>
<tr>
<td>Avoid returning from a finally block</td>
<td>In Java code, one should avoid returning from a finally block - this can discard exceptions. There should be no return statement from a finally block.</td>
</tr>
<tr>
<td><strong>Standard Name</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>-------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Avoid catching null pointer exception</td>
<td>Java code should never catch a null pointer exception. A catch block may hide the original error, resulting in other more subtle errors.</td>
</tr>
<tr>
<td>Java throwing exception in finally block</td>
<td>In Java, throwing exception in a finally block is confusing. It may mask an exception or a defect in the code, and it can also make code cleanup unstable.</td>
</tr>
<tr>
<td>Java catching throwable</td>
<td>In Java, one should avoid catching throwable. This action is dangerous because such a catch can catch other things like OutOfMemoryError.</td>
</tr>
<tr>
<td>Java class should not extend error</td>
<td>Errors are system exceptions. Classes should not extend them.</td>
</tr>
<tr>
<td>Java files must have rcs_id</td>
<td>All Java files must have the following for source control ID: public static final String RCS_ID = $Header$</td>
</tr>
<tr>
<td>Java class name check</td>
<td>All Java files should have a class with a name that is the same as that of the file name.</td>
</tr>
<tr>
<td>Java empty if check</td>
<td>There should be no empty if statements in Java code. An empty if statement finds instances where a condition is checked but nothing is done about it.</td>
</tr>
<tr>
<td>Java empty while check</td>
<td>There should be no empty while statements in Java code.</td>
</tr>
<tr>
<td>Java empty finally block</td>
<td>There should be no empty finally blocks in Java code. Avoid empty finally blocks; these can be deleted.</td>
</tr>
<tr>
<td>Java if without braces</td>
<td>In Java, if statements must use curly braces. Avoid using if statements without curly braces.</td>
</tr>
<tr>
<td>Java while without braces</td>
<td>In Java, while statements must use curly braces. Avoid using while statements without using curly braces. Formats without curly braces are error-prone.</td>
</tr>
<tr>
<td>Java switch must have default label</td>
<td>In Java files, switch statements should have a default label.</td>
</tr>
<tr>
<td>Java empty synchronized</td>
<td>There should be no empty synchronized blocks.</td>
</tr>
<tr>
<td>Standard Name</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Java empty static initializer</td>
<td>There should be no empty <code>static</code> initializer blocks.</td>
</tr>
<tr>
<td>JRAD files language must be US English</td>
<td>In a JRAD XML file, the language of the XML file should be US English and specified as &quot;xml:lang = 'en-US'&quot;.</td>
</tr>
<tr>
<td>Java Parameter (INI) extension and location standard</td>
<td>Java Parameter files should follow these standards:</td>
</tr>
<tr>
<td></td>
<td>- Identified by file extension: .ini</td>
</tr>
<tr>
<td></td>
<td>- Location standard:</td>
</tr>
<tr>
<td></td>
<td>1. $&lt;PROD_TOP&gt;/admin/template</td>
</tr>
<tr>
<td></td>
<td>2. $&lt;PROD_TOP&gt;/admin/template/*</td>
</tr>
<tr>
<td>JDBC TimeStamp Compliance</td>
<td>The proper column bind type should be used when sending/fetching DATE columns. Do not use <code>Types.TIMESTAMP</code> or <code>OracleTypes.TIMESTAMP</code>.</td>
</tr>
<tr>
<td>Do not use ~FILE or ~PATH in .drvx files</td>
<td>~FILE and ~PATH cannot be used in a dbdrv: command in a .drvx file, even within checkfile. A .drvx file is not loaded into the database.</td>
</tr>
<tr>
<td>dbdrv: fdfcmp should not be called</td>
<td>The database driver should not call fdfcmp.</td>
</tr>
<tr>
<td>Files with .drvx extension must contain 'dbdrv: command'</td>
<td>For each driver exception (.drvx) file the line <code>dbdrv: command</code> must exist. The command must be in all lowercase. The line <code>dbdrv: none commands fail also.</code></td>
</tr>
<tr>
<td>No drvx files should contain XDOLoader</td>
<td>For all new patches containing Oracle XML Publisher files, the dbdrv command should be added to the file directly instead of using a separate drvx file.</td>
</tr>
<tr>
<td>No drvx files should contain dbdrv: PYLOAD</td>
<td><code>PYLOAD</code> should not be in any automatically generated database driver.</td>
</tr>
<tr>
<td>dbdrv: FFXBCP must have correct syntax</td>
<td><code>dbdrv: FFXBCP</code> must have correct syntax:</td>
</tr>
<tr>
<td></td>
<td>`exec ff bin FFXBCP bin &amp;phase=last(+##) &amp;ui_apps 0 Y(-S</td>
</tr>
<tr>
<td>dbdrv: FFXMLC must have correct syntax</td>
<td><code>FFXMLC</code> command must contain the following syntax:</td>
</tr>
<tr>
<td></td>
<td><code>exec ff bin FFXMLC bin (&amp;phase=dat(+##)) &amp;ui_apps 0 [yY]</code></td>
</tr>
</tbody>
</table>
**Standard Name** | **Description**
---|---
dbdrv: FNDLIBR must have correct syntax | FNDLIBR command must contain the following syntax:
`exec find bin FNDLIBR bin <phase> FND FNDCPBWV &ui_apps SYSADMIN 'System Administrator' SYSADMIN`
dbdrv: Java htmlLoad.class must have correct syntax | Java htmlLoad.class command must contain the following syntax:
`exec java oracle/apps/per htmlLoad.class java &un_apps -password &pw_apps -database &jdbc_db_addr -file <.html file>`
dbdrv: Java UnzipFile.class must have correct syntax | Java UnzipFile.class command must contain the following syntax:
`exec java oracle/apps/ad/jri UnzipFile.class java`
The file must also have the .zip extension.
dbdrv: LoadMap.class must have correct syntax | The syntax for LoadMap.class must be as follows:
`exec java oracle/apps/ecx/loader LoadMap.class java &phase=dat &un_apps &pw_apps &jdbc_db_addr &fullpath_prod_path_file`
JRAD XML files must have file-version attribute | JRAD XML files must have a file-version attribute to indicate the version of the file. Following is a sample definition of file-version.
AkTestAttachLinkPG.xml 115.0 2003/02/10 18:18:10
tmak noship $'
xmlns='http://xmlns.oracle.com/jrad'>`
Note that the file-version attribute must have the correct filename and a version.
Translation standard for JRAD files | In JRAD xml files the encoding should be UTF-8 and specified as:
"encoding = "UTF-8""
Do not end comments with the '-' character | Do not end comments with the '-' character, as this is the default Sql*Plus line continuation character. For lines with a series of '-', end the line with a '+' sign.
11i file version standard | File version should start with '11'
R12 file version standard | File version should start with '12'
Customization Manager Coding Standards for Database Objects

The following table lists the standards which are applicable only for Oracle E-Business Suite Release 12.2 Online Patching.

<table>
<thead>
<tr>
<th>Object Type</th>
<th>Description</th>
<th>File Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>A column type should not be ROWID.</td>
<td>.xdf, .odf</td>
</tr>
<tr>
<td>Table</td>
<td>A column type must not be LONG.</td>
<td>.xdf, .odf</td>
</tr>
<tr>
<td>Table</td>
<td>A column type must be a built-in type or a user-defined type owned by a non-editioned user.</td>
<td>.xdf</td>
</tr>
<tr>
<td>Table</td>
<td>A base column name should be unique within the table within the first 27 bytes.</td>
<td>.xdf, .odf</td>
</tr>
<tr>
<td>Table</td>
<td>A base column name may use the # character only to distinguish the column versions; for example, &lt;col_name&gt;#&lt;version&gt;.</td>
<td>.xdf, .odf</td>
</tr>
<tr>
<td>Table</td>
<td>A table must be owned by an Oracle E-Business Suite product schema, not APPS.</td>
<td>.xdf</td>
</tr>
<tr>
<td>Table</td>
<td>A table name must not use the '#' character.</td>
<td>.xdf, .odf</td>
</tr>
<tr>
<td>Materialized View (MV)</td>
<td>Create/alter Materialized View definition using XDF</td>
<td>.sql, .pkb, .pkh</td>
</tr>
<tr>
<td>Constraint</td>
<td>Create/alter constraint definition using XDF or ODF</td>
<td>.sql, .pkb, .pkh, .pls</td>
</tr>
<tr>
<td>Index</td>
<td>Create/alter the index definition using ODF or XDF.</td>
<td>.sql, .pkb, .pkh, .pls</td>
</tr>
<tr>
<td>Table</td>
<td>Create/alter the table definition using ODF or XDF.</td>
<td>.sql, .pkb, .pkh, .pls</td>
</tr>
<tr>
<td>Table</td>
<td>Do not modify application-managed tables in an online patch.</td>
<td>.xdf, .odf</td>
</tr>
<tr>
<td>Constraint</td>
<td>A constraint name must contain an underscore (_).</td>
<td>.xdf</td>
</tr>
<tr>
<td>Index</td>
<td>An index name must contain an underscore (_).</td>
<td>.xdf, .odf</td>
</tr>
<tr>
<td>Object Type</td>
<td>Description</td>
<td>File Types</td>
</tr>
<tr>
<td>------------</td>
<td>------------------------------------------------------------------------------</td>
<td>------------</td>
</tr>
<tr>
<td>Trigger</td>
<td>A table trigger must be created on editioning view, not on the table.</td>
<td>.sql, .pkb, pls</td>
</tr>
<tr>
<td>Table</td>
<td>DML statements must access tables via a table synonym or the editioning view.</td>
<td>All code</td>
</tr>
<tr>
<td>VPD</td>
<td>A VPD policy must be created on the editioning view or table synonym, not on the table.</td>
<td>.sql</td>
</tr>
<tr>
<td>Synonym</td>
<td>A table synonym must point to the editioning view, not to the table.</td>
<td>.sql, .pkb, .pls</td>
</tr>
<tr>
<td>Synonym</td>
<td>Do not install synonyms in non-editioned schemas</td>
<td>.xdf, .odf</td>
</tr>
</tbody>
</table>
Validation of Custom Applications: Examples

This appendix covers the following topics:

- Validation of Custom Applications: Examples

Validation of Custom Applications: Examples

The following table lists examples of issues that might be discovered in validating a custom application. Recommended solutions are also provided. These examples apply only to Oracle E-Business Suite Release 11i.

Because the list of issues and its corresponding recommendations will vary for one instance to another, please run requests to validate existing custom applications to generate release-specific and instance-specific recommendations. See: Managing Custom Applications, page 14-50.

The example custom application ‘xxcust’ used in this table corresponds to a case-sensitive custom application shortname.

The example custom application ID ‘50001’ used in this table corresponds to the custom application ID.
<table>
<thead>
<tr>
<th>Issue</th>
<th>Recommendation for Release 11i</th>
</tr>
</thead>
</table>
| The file $APPL_TOP/admin/xxcustprod.txt does not exist. | Create or replace file $APPL_TOP/admin/xxcustprod.txt. The contents should be:  
```plaintext  
%%% Single-product product data file format  
11.5.A  
xxcust 50001  
END_OF_PRODUCT_ABBREVIATIONS -999  
50001 xxcust XXCUST APP  
No No No No  
Yes Yes  
50001 XXCUST XXCUST  
0  
1.0.0 1.0.0  
none none none none none  
END_OF_PRODUCTS  
Release 11.5.0  
11.5.0  
R115 R115_additional-this-mpl  
XXCUST 11.5.0  
END_OF_RELEASE 0.0.0  
``` |
| The file $APPL_TOP/admin/xxcustterr.txt does not exist. | Create or replace file $APPL_TOP/admin/xxcustterr.txt with file:  
```plaintext  
%%% Single-product territory data file format  
11.5.A  
R115  
0 usaeng US AMERICAN EN US American_English appltape.txt appltape.txt WE8ISO8859P1  
Yes Standard Data_Group  
none none none none none none  
c xxcust xxcust  
END_OF_PRODUCT_NAMES  
END_OF_LANGUAGE_INFO  
``` |
| The entry for xxcust is missing in FND_APPLICATION_TL | Update FND_APPLICATION_TL with the following sql:  
```sql  
INSERT INTO FND_APPLICATION_TL (APPLICATION_ID, LANGUAGE, APPLICATION_NAME, CREATED_BY, CREATION_DATE, LAST_UPDATED_BY, LAST_UPDATE_DATE, LAST_UPDATE_LOGIN, DESCRIPTION, SOURCE_LANG)  
VALUES (50001, 'US', 'xxcust', 1000, sysdate, 1000, sysdate, 1000, 'xxcust', 'US');  
``` |
The entry for product xxxcust is missing from FND_PRODUCT_INSTALLATIONS.

Insert the information about product xxxcust in FND_PRODUCT_INSTALLATIONS with following SQL:

```
INSERT INTO FND_PRODUCT_INSTALLATIONS(APPLICATION_ID, ORACLE_ID, LAST_UPDATE_DATE, LAST_UPDATED_BY, CREATION_DATE, CREATED_BY, LAST_UPDATE_LOGIN, PRODUCT_VERSION, STATUS, INDUSTRY, TABLESPACE, INDEX_TABLESPACE, TEMPORARY_TABLESPACE, SIZING_FACTOR, INSTALL_GROUP_NUM, DB_STATUS, PATCH_LEVEL)
VALUES ( 50001, 50001, sysdate, 1000, sysdate, 1000, 1000, '11.5.0', 'I', 'C', <tablespace>, <index tablespace>, <temporary tablespace>, 100, 0, 'I', NULL );
```

Please replace <tablespace>, <index tablespace>, <temporary tablespace> with appropriate values.
<table>
<thead>
<tr>
<th>Issue</th>
<th>Recommendation for Release 11i</th>
</tr>
</thead>
</table>
| The database is missing user xxcust | Create database user xxcust  
Give appropriate grants to the user by running the necessary SQL statements:  
• grant create session, alter session to xxcust  
• grant create type to xxcust  
• grant create database link to xxcust  
• grant create any outline, alter any outline, drop any outline to xxcust  
• grant analyze any to xxcust  
• grant create sequence, create table to xxcust  
• grant create cluster to xxcust  
• grant CREATE TRIGGER to xxcust  
• grant create materialized view, query rewrite to xxcust  
• grant unlimited quota on all tablespaces with which user xxcust is associated.  
Please use APPS_TS_TX_DATA as the main tablespace for user xxcust  
Please use APPS_TS_TX_IDX as the index tablespace for user xxcust |
| The entry for product xxcust is missing from FND_ORACLE_USERID | Insert entry for the product xxcust in FND_ORACLE_USERID with the SQL:  
```
INSERT INTO FND_ORACLE_USERID  
(ORACLE_ID, ORACLE_USERNAME, LAST_UPDATE_DATE,  
LAST_UPDATED_BY, CREATION_DATE, CREATED_BY, LAST_UPDATE_LOGIN, DESCRIPTION,  
ENABLED_FLAG, READ_ONLY_FLAG, ENCRYPTED_ORACLE_PASSWORD,  
CONCURRENT_BATCH_QUEUE_ID, INSTALL_GROUP_NUM)  
VALUES (50001, 'XXCUST', sysdate,  
1000, sydate, 1000, 1000, 'XXCUST Account',  
'N', 'A', NULL, NULL, 0 );
```
<table>
<thead>
<tr>
<th>Issue</th>
<th>Recommendation for Release 11/</th>
</tr>
</thead>
</table>
| Entry for the product xxcust in $APPL_TOP/admin/topfile.txt does not exist | Edit $APPL_TOP/admin/topfile.txt to insert the given below entry at the end:  
xxcust <XXCUST_TOP>  
Please replace <XXCUST_TOP> with appropriate value. |
<p>| Environment variable XXCUST_TOP not defined | Run AutoConfig to generate the environment variable XXCUST_TOP |
| Directory $APPL_TOP/xxcust/11.5.0 does not exist. | Create directory $APPL_TOP/xxcust/11.5.0 |
| Directory $APPL_TOP/xxcust/11.5.0/log does not exist. | Create directory $APPL_TOP/xxcust/11.5.0/log |
| Directory $APPL_TOP/xxcust/11.5.0/out does not exist. | Create directory $APPL_TOP/xxcust/11.5.0/out |
| Directory $APPL_TOP/xxcust/11.5.0/mesg does not exist. | Create directory $APPL_TOP/xxcust/11.5.0/mesg |
| Directory $APPL_TOP/xxcust/11.5.0/sql does not exist. | Create directory $APPL_TOP/xxcust/11.5.0/sql |
| Directory $APPL_TOP/xxcust/11.5.0/admin does not exist. | Create directory $APPL_TOP/xxcust/11.5.0/admin |
| Directory $APPL_TOP/xxcust/11.5.0/admin/driver does not exist. | Create directory $APPL_TOP/xxcust/11.5.0/admin/driver |
| Directory $APPL_TOP/xxcust/11.5.0/admin/sql does not exist. | Create directory $APPL_TOP/xxcust/11.5.0/admin/sql |</p>
<table>
<thead>
<tr>
<th>Issue</th>
<th>Recommendation for Release 11/</th>
</tr>
</thead>
<tbody>
<tr>
<td>File $APPL_TOP/xxcust/11.5.0/admin/driver/xxcustfile.drv does not exist.</td>
<td>Create file $APPL_TOP/xxcust/11.5.0/admin/driver/xxcustfile.drv with following contents:</td>
</tr>
<tr>
<td></td>
<td># Dummy xxcustfile.drv</td>
</tr>
<tr>
<td>File $APPL_TOP/xxcust/11.5.0/sql/XXCUSTNLINS.sql does not exist.</td>
<td>Create file $APPL_TOP/xxcust/11.5.0/sql/XXCUSTNLINS.sql with following contents:</td>
</tr>
<tr>
<td></td>
<td>commit;exit;</td>
</tr>
<tr>
<td>File $APPL_TOP/xxcust/11.5.0/admin/sql/XXCUSTNLADD.sql does not exist.</td>
<td>Create file $APPL_TOP/xxcust/11.5.0/admin/sql/XXCUSTNLADD.sql with following contents:</td>
</tr>
<tr>
<td></td>
<td>commit;exit;</td>
</tr>
</tbody>
</table>
Known Product Limitations

This appendix covers the following topics:

- Known Product Limitations

**Known Product Limitations**

1. Start and Stop features present in some of the Enterprise Manager console pages should NOT be used against individual Oracle E-Business Suite sub-targets. One example is starting and stopping the Oracle E-Business Suite database. While Oracle Enterprise Manager has no problems starting and stopping individual standalone product services, doing the same with Oracle E-Business Suite components will produce unexpected and inconsistent results. The one exception to this rule is that the Oracle Application Management Pack for Oracle E-Business Suite's administration feature can be used to start and stop the application tier service from the Enterprise Manager console.

2. The only mechanisms for cloning an Oracle E-Business Suite system from within the Oracle Enterprise Manager Cloud Control console are those provided in the cloning chapter of this guide. Alternatively, for more information on cloning, refer to the following Oracle E-Business Suite documents on My Oracle Support: Knowledge Document 230672.1, "Cloning Oracle Applications Release 11i with Rapid Clone", and Knowledge Document 406982.1, "Cloning Oracle Applications Release 12 with Rapid Clone".

3. Creating copies of the out-of-box cloning procedures is not supported. The "Create Like" feature is provided for customers to extend the cloning functionalities based on their own specific business needs.

4. In discovery and monitoring, Oracle Application Management Pack for Oracle E-Business Suite does not support multiple Oracle E-Business Suite instances with the same name across different hosts on a given Oracle Management Server; that is, instances are differentiated only by the Oracle System Identifier (SID) and not the...
5. Metric collection errors will be reported for the target type oracle_apps_jvm if the setup needed to monitor Applications JVM Usage is not done after discovery. To fix the issue, you can either set up the metric collection or disable the metric collection; see: Monitoring JVM Usage, page 8-25.

6. If you have changed your APPS password, you should change it for the plug-in in two places: for the named credentials and target monitoring properties (if the Monitoring Configuration has the password). After changing the password, wait at least 15 minutes for it to propagate to the targets.
A
Administration groups, 8-95
Administration of Oracle E-Business Suite, 8-92
AD Patch Log, 13-30
Aliased host
  mapping, 4-11
amp.properties
  replaced by Preferences, 2-5
APPS password
  changing, F-2
AutoConfig, 4-2
Availability Status charts, 8-6

B
Blocked concurrent requests
  monitoring, 8-73

C
Change approval framework, 7-5, 12-2
Changing the APPS password, F-2
Cloning, 11-1
  custom steps in deployment, 11-48
diagnostic tests, 10-3
  for Oracle E-Business Suite Release 12.2, 11-33,
  11-41
  multi node to single node, 11-9
  scale-down and scale-up, 11-21
  single node to single node, 11-9
  upgrade considerations, 2-4
Coding standards, D-1
Command line discovery, 4-12
  Comparison templates, 8-16
  Compliance
    summary, 3-3
  Compliance standards, 8-18
  Concurrent managers
    monitoring capacity utilization, 8-73
  Concurrent processing
    dashboard, 8-49
    metrics, 8-59
  Concurrent requests
    blocked, 8-73
  Configuration, 8-14
    comparing configurations, 8-15
    of all members, 8-14
  Configuration Topology Viewer, 8-2
  Creating a package, 14-23
  Creating a report (Customization Manager), 14-42
  Credentials
    named, 5-2
    preferred, 5-1, 12-3
  Custom applications
    managing, 14-50
    validation, E-1
  Custom compliance rules, 8-92
  Customization Manager
    coding standards, D-1, D-11
    creating a package, 14-23
    creating a report, 14-42
    custom applications
      validating, E-1
    diagnostic tests, 10-12
    E-Business Suite Mapping, 14-21
features, 14-2, 14-3
File Metadata Repository, 14-48
File Source Mapping, 14-15
file types
  recommended locations, C-12
  supported, C-1
file validation, 14-4
obsoleting a package, 14-40
package details, 14-34
package reports, 14-41, 14-45, 14-47
registering source control, 14-15
releasing a package, 14-40, 14-47
saving a package, 14-33
sharing a package, 14-47
standards checker, 14-4, D-1
updating a package, 14-31
updating package metadata, 14-40
user-defined customization standards, 14-5, 14-6
Custom metrics, 8-91
Cutover
  in online patching, 8-20
D
Deleting an Oracle E-Business Suite instance, 4-18
Deploying the plug-in, 2-2
Deployment Procedure Manager (Oracle Enterprise Manager), 13-29
Diagnostic tests, 10-1, 12-4
cloning, 10-3
  Customization Manager, 10-12
  Patch Manager, 10-10
  user monitoring, 10-15
Discovery, 4-7
customizing, 4-8
Discovery Wizard, 4-2
log for troubleshooting, 4-7
multiple Oracle E-Business Suite targets, 4-7
preparatory steps, 4-1
prevalidation, B-1
rediscovery, 4-17
restrictions, 4-8
Discovery Wizard, 4-2
Downloading the plug-in, 2-2
E
E-Business Suite Mapping, 14-21
Exalogic dashboard, 8-76
F
File Metadata Repository, 14-48
File Source Mapping, 14-15
  parameters, 14-19
H
HTTPS/SSL targets
  monitoring, 8-44
I
Incidents, 8-17
J
JVM usage
  monitoring, 8-25
K
Known product limitations, F-1
M
Management Agent
  installing, 2-3
Map Aliased Host, 4-11
Metrics, 2-3, 8-3
  concurrent processing, 8-59
  current activity, 8-21
  custom, 8-91
  incidents, 8-11, 8-17
  performance, 8-8
  thresholds, 8-4
  usage, 8-9
Monitoring, 8-2
  current activity, 8-21
  HTTPS/SSL targets
    configuration, 8-44
  JVM usage, 8-25
  metrics, 8-3
  online patching, 8-20
  settings, 9-1
topology, 8-2
user sessions, 8-22
Monitoring templates, 8-27

N
Named credentials, 5-2
Notifications
setup, 12-3

O
Obsoleting a package, 14-40
Online Patching
cutover, 8-20
Oracle Application Management Pack for Oracle E-Business Suite
overview, 1-1
Oracle Applications Manager, 8-48
Oracle E-Business Suite Management page, 3-2
Oracle E-Business Suite Release 12.2
coding standards, D-11
Patch Manager deployment procedure, 13-21
Oracle E-Business Suite system home page, 8-5

P
Package details, 14-34
Package reports, 14-41, 14-45, 14-47
Patch Manager, 13-2
deployment procedure, 13-21
diagnostic tests, 10-10
extending deployment, 13-29
features, 13-1
patch run, 13-14
promotion policy, 13-3
restarting failed workers, 13-30
troubleshooting, 13-31
upgrade considerations, 2-4
Patch promotion policy, 13-3
Patch run, 13-14
copying, 13-20
Preferences, 2-5, 6-1
Preferred credentials, 5-1, 12-3
Prerequisites, 2-2
Prevalidation in discovery, B-1
Privilege propagation, 8-95
Privileges, 7-1, 7-6

Change Management, 7-5, 12-2
Provisioning Manager (Oracle Enterprise Manager), 13-29

R
Real User Experience Insight, 8-81
Releasing a package, 14-40, 14-47
Roles, 7-1, 7-6

S
Saving a package, 14-33
Services, 8-12
starting and stopping, 8-92
Sharing a package, 14-47
Smart Clone, 11-1
custom steps in deployment, 11-48
multi node to single node, 11-9
scale-down and scale-up cloning, 11-21
single node to single node, 11-9
SQL file types
execution sequence, C-14
Standards checker, 14-4, D-1
Supported versions, 2-2
System requirements, 2-2

T
Target types, A-1
Topology, 8-2

U
Undeploying the plug-in, 2-6
Updating a package, 14-31
Updating package metadata, 14-40
Upgrading
cloning considerations, 2-4
Patch Manager considerations, 2-4
Upgrading the plug-in, 2-3
User-defined customization standards, 14-5, 14-6
User monitoring, 8-22
diagnostic tests, 10-15
User session monitoring, 8-22